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Introduction 
Warrior software Release 7.0 is a second-generation 32-bit program. The Warrior software is a 
mature logging environment that stresses ease of use, wide versatility, with a true multi-tasking 
environment. This software can also be used from a desktop to replay, recalculate and print logs from 
the raw data or imported data from other systems such as LAS or LIS data. The Warrior software 
runs on Windows Operating Systems (Windows 2000 and Windows XP). Operators need to be 
familiar with Windows and logging.  
 
The Warrior Tool Interface and Power Supply Panel is a new generation logging system. This system 
utilizes the USB Bus (Universal Serial Bus) along with DSP (Digital Signal Processor) technology 
providing the latest signal recovery technology available. This allows the PC to be upgraded 
independently as newer and faster PC's become available. Systems can be configured based on the 
services required at each site. The operator interface remains the same for each configuration, 
allowing the same look and feel for the operators. 
 
The Warrior Well Logging System consists of a Tool Interface and Power Supply Panel, a computer, 
a printer and optional depth, line speed, line weight panel, and perforating power supply. The tool 
interface panel contains the necessary circuits to interface to most cased hole tools, both analog and 
digital. The depth encoder and line weight interfaces are built into the panel, as is the down hole tool 
power supply. All functions are digitally controlled from the software, with the power supply having a 
manual control mode. The panel incorporates data acquisition functions primary DSP based, that 
interface to the host computer through the industry standard Universal Serial Bus (USB). A seven 
port USB hub is also incorporated inside the panel allowing a single cable connection to the host 
computer. A second monitor may usually be attached to provide a Hoistman's or client's display.  
 
The system supports most thermal well log plotters and a selection of color printers. An optional 
depth, line speed and line weight panel is available. This panel provides 12 Vdc. powered, 
independent depth measurement. It connects to the host computer through the USB and can be 
synchronized from the host depth or the host depth may be read from the depth panel. The Warrior 
logging system currently consists of the following components: 
 
CPU – Laptop/Desktop 
Monitor  
Shooting Panel 
Tool Interface and Power Supply (CP/PA/OP/SLAB) 
Keyboard 
Plotter 
Depth, Line Speed and Line Tension Panel (optional) 
UPS (optional) 
 
It is strongly suggested that the CPU and monitor (and optionally, the interface panel) be run from an 
UPS with a capacity of approximately 1000 VA. Do not attempt to use an on-line type UPS with 
diesel generators unless the manufacturer specifically states that the product is suitable for this 
application. The (cheaper) switching type UPS seem to work well. Loss of data is guarded against by 
periodic update of the data base files, however, the use of a UPS allows the system to be shut down 
in an orderly manner and may also condition the line power to the system, thus eliminating problems 
due to a noisy power source. 
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Release Notes Warrior CasedHole 
 
Release notes for Warrior Casedhole 060825 
Log formats Add Image 3D and Potato plot types for multi arm caliper array data. 

Plotting 
Can start XYPlot when service starts like Iplot.  Extra parameters entered in 
Services Editor. 

All logging Generic Borehole Imaging tool module 
All Bugfix recalculation of depth-shifted data 
CH Logging Titan telemetry 24 bit raw data channel support 
All Logging Temp. Compensated XY Caliper tool; ported to Win-32. 
Printing Add calibration for Windows printers 
CH Logging Added spinner calculation program - Flowvelocity 
All logging Compatibility fix for FX1 based hardware with VIA USB host controller 
All logging Average Caliper output added to XYCal; slight clean-up. 

Perforating 
Use service dump for more accurate sensor offset calculations.  Bug fix - 
Closing all from Acquisition while wizard was open could delete joplan entries. 

Tool string drawing Use service dump for more accurate sensor offset calculations. 
Alarms Alarms now can be canceled in groups - depth, depthpnl using new alarms. 
All logging Multiple gain/filter board support, new I2C system addressing enhancements 
All logging Multiple DSP board support 
All logging New I2C system addressing enhancements, support for USB44R6 
All logging New I2C system addressing enhancements 

TVD Calculations 

Uses new tvd library - DS points will be saved in a database instead of external 
file.  TVD plots won't need to be saved to database, can be added to plot job 
later. 

All logging CNTP-313-B Probe Tool Added - New Algorithm. 
Headings Headings can have watermarks 
CH Logging Panex Spinner Flow support 

Tool string drawing 

User can create their own list of sensors to hide in the tool string drawing.  File 
logsys.ini, section [ToolDiagramSkipSensors], then list sensor names 
1=SENS1, 2=SENS2, etc. 

Plotting 
Can enter a decimal value for line thickness to fine tune curve thickness on 
printers with resolution >= 300 

Well Objects Casing, plugs, packers can have colors. 
All logging New device for surface acquisition 
All Logging Bug fix for data transfer 

Tool Power Monitor 
Bugfix tool power monitor config, inhibit. Can now declare  “NoMonitor=yes” in 
specific services (or globally via Warrior.ini) 

  
 
Release notes for Warrior Casedhole 060407 

CH Logging 
Hotwell PNN downlink timing improvement and biased output returns to max. pos. rail 
for larger neg. deflections 

All logging Nominal gains and offsets for Tvolt and Tcurr by panel type 

CH Logging 
Sondex PL telemetry has new channel type "flowdir2" for modified XMW using two 
channels for flow rate and direction 

CH Logging Fix for PIP panel PLL multipliers 
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Release notes for Warrior Casedhole 060321 
All logging Bug fix - Could cause "Unable to create curve" errors at log up time. 

Windows printing 

Can adjust resolution of Windows Printing source data via Warrior Control 
Panel.  Lower resolution speeds up printing but can lower print quality.  This 
setting is used in addition to the printer resolution set in the Windows printer 
settings. 

XY Plot 
Legend for curve names, Editable legend items, Uses banner for heading, 
Can plot constant values for reference. 

Plotting 
Add entry to warrior.ini in [Heading] section for "defaultbanner".  If entry not 
there then will use title.wlb 

Sondex Support Sondex PL supports flow detection on all lines including H2S. QPS bug fix 
Plotting Can show legend for shading in log inserts 
All Logging Prohibit Panel Type change (flag setting to enable in Warrior.ini) 
All Logging Logging releases use new style device drivers 
All Logging Sondex name fix, gauge overflow fix, smoother output filename handling 

All Logging 
Fix resource leak - was causing misc. device record and storage errors 
when recording multiple passes of logs with many outputs 

Perforating New Perf Job Planner 
Panex Support Panex GR support, other updates per Panex 
Cal reports Cal reports now have a heading with database and dataset source for cals. 
Printrex printing For 820RM printers, add 820RM=1 to printrex printer section in warrior.ini. 

Heading 
Added 'U' for underline edit type in .hdg file.  "editHSLTU", "editVSLTU", 
etc. 

Services Editor 

Tools will be exported with service into wcf file by same name as wsv file.  
Tools can be imported with service by same method.  When editing tools for 
service, can see list of current tool/serial numbers to pick from. 

Panex Support Bug fix to coefficients file read in 
Panex Support Enhanced Panex monitor and control 

Creating Alias 
Dialog will not close after alias created, but user will see status message if 
alias created successfully. 

Backup Was not checking set aside space for backups properly. 

LIS export 
Added option "OneFramePerRecord" to [LIS Export] section.  Required for 
WellCad software to read sonic data. 

Cal reports 

Can draw rectangles around entries by prepending underscore before text.  
[Columns] entry can have start,stop values ( 1=0,20 ), and stop value for 
columns is required for rectangles to come out correct. 

SCBL Can manually adjust gates after automatic moves 

Waveform Display 
When multiple waveforms are in window, double click to fill window with that 
waveform and double click again to go back to multiple display. 

Plotting to Fax 

Move plot options to config dialog like other printers.  Add option for Normal 
( 100dpi ) and Fine ( 200dpi ). Default is Fine - which is what it was hard 
coded to before.  Requires new entry in warrior.ini for [Fax] - 
"custom=faxfile32.dll". 

Well Objects 
Well object Highlight type can have different colors.  Perfs with single depth 
will show up now. 

Plotting 

Added 'repeat' mode for correlation curves.  Correlation curves will only be 
plotted if that curve is shown.  So you can show curves from main pass on 
top of repeat pass to easily see repeatability 

All Logging 
Default software power controls to be off, override via new control word in 
service or global enable via warrior.ini 



16 Warrior Software Version 7.0 Standard Cased Hole 

All Logging New safety feature: Tool Power will be disabled if line current drops out 

Merge 
Warn user if depth correction is entered and no curves have depth 
correction to be applied 

Tracer Interp Can use caliper reading as casing ID value for calculations 
CH Support for Geofizika PL string 
Tool string drawing Was not always showing proper offsets for tracer tools 

All Logging 
Open line monitor temporarily inhibited during tool power voltage/current 
calibration 

Perforating 
Update CYShpl support to monitor AC/DC and Pos/Neg switch positions 
when available 

All logging 
Modifications to Sondex/CSS Compensated Neutron calibration and 
verification routines 

Config restore Run latest warrior convert option when restoring config files 
Tool string drawing Fix for multiple instances of the same tool 
Direct printing First plot from Job Editor will be spooled so printer won't start/stop 
LAS Export Fix CNTY=COUNTY 

XY Plot 
Can turn off curve labels.  Added more curve styles.  Print directly to 
Windows printer for better quality. 

Hot var editor Was not working properly on numeric values. 
Waveform plotting Fix for low vdl levels - before were coming out all white. 

Interactive plot 
Bug fix hang-up of Iplot if you have it minimized and save a well object to 
the same database. 

All logging 
Big fix for probe telemetry channel offset and Titan "combined" channel 
types 

Services, Tools editor 
Saving a service will also create a file with tools for that service, then Import 
will look for both files 

Format editor Speed up reading/writing of log formats 
All logging CYAuxF1 - new device support 
DSP logging Ability to specify pmon for "Probe" command 
All logging Tool Power monitor settings can be specified per service 
All logging Robertson Geologging 6 Channel and 12 Channel Telemetry support 
All logging CYShPnlF1 - new device support 
CH Logging Includes Hotwell PNN 
 
 Release notes for previous release, Warrior Casedhole 051110 
LAS Export User can add their own heading information via [Heading] section in las.ini 
All logging Bug fix - Could cause "Unable to create curve" errors at log up time. 

Windows printing 

Can adjust resolution of Windows Printing source data via Warrior Control 
Panel.  Lower resolution speeds up printing but can lower print quality.  This 
setting is used in addition to the printer resolution set in the Windows printer 
settings. 

All logging 
Legend for curve names, Editable legend items, Uses banner for heading, 
Can plot constant values for reference. 

Plotting 
Add entry to warrior.ini in [Heading] section for "default banner".  If entry not 
there then will use title.wlb 

Sondex Support Sondex PL supports flow detection on all lines including H2S. QPS bug fix 
Plotting Can show legend for shading in log inserts 
All Logging Prohibit Panel Type change (flag setting to enable in Warrior.ini) 
All Logging Logging releases use new style device drivers 
All Logging Sondex name fix, gauge overflow fix, smoother output filename handling 
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All Logging 
Fix resource leak - was causing misc. device record and storage errors 
when recording multiple passes of logs with many outputs 

Perforating New Perf Job Planner 
CTS Telemetry CTS Telemetry monitor showing Caliper commands 
Sondex Support Sondex MIT supported 
Panex Support Panex GR support, other updates per Panex 
Cal reports Cal reports now have a heading with database and dataset source for cals. 
Printrex printing For 820RM printers, add 820RM=1 to printrex printer section in warrior.ini. 

Heading 
Added 'U' for underline edit type in .hdg file.  "editHSLTU", "editVSLTU", 
etc. 

Services Editor 

Tools will be exported with service into wcf file by same name as wsv file.  
Tools can be imported with service by same method.  When editing tools for 
service, can see list of current tool/serial numbers to pick from. 

Panex Support Bug fix to coefficients file read in 
Panex Support Enhanced Panex monitor and control 

Creating Alias 
Dialog will not close after alias created, but user will see status message if 
alias created successfully. 

Backup Was not checking set aside space for backups properly. 

LIS export 
Added option "OneFramePerRecord" to [LIS Export] section.  Required for 
WellCad software to read sonic data. 

Cal reports 

Can draw rectangles around entries by prepending underscore before text.  
[Columns] entry can have start,stop values ( 1=0,20 ), and stop value for 
columns is required for rectangles to come out correct. 

Memory Logging Major enhancements for LGAT,  Lonkar Gamma Analysis Tool 
SCBL Can manually adjust gates after automatic moves 

Waveform Display 
When multiple waveforms are in window, double click to fill window with that 
waveform and double click again to go back to multiple display. 

Plotting to Fax 

Move plot options to config dialog like other printers.  Add option for Normal 
( 100dpi ) and Fine ( 200dpi ). Default is Fine - which is what it was hard 
coded to before.  Requires new entry in warrior.ini for [Fax] - 
"custom=faxfile32.dll". 

Well Objects 
Well object Highlight type can have different colors.  Perfs with single depth 
will show up now. 

Plotting 

Added 'repeat' mode for correlation curves.  Correlation curves will only be 
plotted if that curve is shown.  So you can show curves from main pass on 
top of repeat pass to easily see repeatability 

All Logging 
Default software power controls to be off, override via new control word in 
service or global enable via warrior.ini 

All Logging New safety feature: Tool Power will be disabled if line current drops out 

Merge 
Warn user if depth correction is entered and no curves have depth 
correction to be applied 

Tracer Interp Can use caliper reading as casing ID value for calculations 
CH Support for Geofizika PL string 
Tool string drawing Was not always showing proper offsets for tracer tools 

All Logging 
Open line monitor temporarily inhibited during tool power voltage/current 
calibration 
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1 Windows XP Set Up 
The Warrior well logging system runs in the Microsoft Windows software (2000,or XP) environment. 
This gives the user many powerful tools and facilities not previously available in an inexpensive 
logging system. One of the principle advantages is that the system is multitasking, meaning that 
several programs (or tasks) may be running on one computer at the same time. Within the Warrior 
system, for example, several different log plots may be displayed independently on the screen and 
other logs may be directed to plotters. Headings may be prepared, and final log presentations set up, 
all whilst continuing to acquire data. 
 
Another advantage of the Windows environment is the graphical user interface, which presents the 
functions available in the system in an easy to understand manner (well, fairly easy). Whilst the 
simple interface makes the Warrior easy and fast to operate, the full power of the system can only be 
realized when an understanding of MS Windows itself has been acquired. It is therefore strongly 
recommended that, after some initial experimentation with the system, the Windows User Guide is 
studied and the Windows Tutorials run. Courses are also available on videotape, and other media, 
from many sources. 
We recommend customize the windows XP with the following presentations: (Fig: 1.1, Fig: 1.2, and 
Video1.1). 

 

 
FIG: 1.1 Start Menu Presentation 

Section
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FIG: 1.2 Taskbar Presentations 
 

 

 

VIDEO: 1.1 MS_XP-Setup Presentation 
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2 Warrior Software Installation 

2.1 Distribution Media 
The Warrior Data Acquisition Software version 7.0 (051114) or latest is distributed on one CDROM. 
Or the software is downloadable in the form of a single executable file WAR7CH05114.exe from the 
web site http://www.warriorsystem.com/under DOWNLOADS Warrior Software 32 Bit Version 
Warrior 7.0 STD Casedhole 051114  This file should be copied to a temporary directory and run to 
expand itself.  To install the Warrior software runs the SETUP.EXE. 
 
It is a fact of life that every computer system will, sooner or later; suffer a failure, such as a disk 
crash, where there is the potential for loss of programs and/or data. This will generally happen at the 
most inconvenient time. The importance of keeping current backups cannot be overemphasized. It is 
vital that the time be taken to keep current backups of all essential programs and data. 
 
All Warrior systems from Scientific Data Systems are shipped with some type of mass storage 
device, (usually a CD-R/W drive) which can be used for backing up programs and data. The 
procedure for using CD drives varies with the software supplied. Become familiar with the specific 
software by reading the manual, or select 'Help' after starting the program. It may be useful to 
purchase an off the self-CD program to standardize all systems.  
 

All files copied from a CD to a hardrive are written as read only. Some files used 
by the Warrior software will not function properly as read only. To change the 
attribute, use Windows Explorer select the copied files, right click on the files and 
select properties, uncheck the 'Read Only' Attribute and click the apply button.  

 
The warrior system is usually configured for the selection of services to be run by a given client. This 
information is primarily contained in three files, Warrior.ini, Services.ini, and Tools.ini. (A copy of all 
files a client can changed and back up to floppy by using Backup/Restore utility 'Configuration Files'). 
A complete backup of the Warrior program (excluding data base files) can be done using the 
Backup/Restore Utility. 
 
 
 
 
 
 
 
 
 

Section

2 

http://www.warriorsystem.com/
http://www.warriorsystem.com/ftp/public/WAR7CH051114.exe
http://www.warriorsystem.com/ftp/public/WAR7CH051114.exe
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2.2 New Installation Warrior Software.  
Previous to the installation of the Warrior software we recommend to update the Windows operating 
system through the Internet connection. When performing a new installation all Warrior program files, 
default configuration and Data files are copied to hard disk. Configurations are subsequently modified 
to suit customer requirements. 

Restart the computer and turn OFF the Interface Panel Power supply  
Place the new version of Warrior CD in CD Drive. It should auto run if not run 
setup from CD causes the installation. An interactive menu appears as shown in 

    The Fig: 2.1  
 

 

FIG: 2.1 Interactive Menu. 

Click on Install Warrior 7.0 Software 
 

 

FIG: 2.2 Warrior 7.0 Version 051114 

Click Next to continue with the Setup program. 



22 Warrior Software Version 7.0 Standard Cased Hole 

 

FIG: 2.3  Warrior Software Setup 

At this screen a choice can be made to install the software in Demonstration/Training Mode. 
In this mode, no software USB key is required and most functions can be accessed in a limited way 
for training. However, all acquisition and import capabilities are disabled. 
Approximately 300 feet of log can be plotted when in this mode. Services and Tools can be entered, 
checked and installed on a full system. The software may be switched between Normal and Demo 
modes by the Demo Mode parameter in the [GLOBAL] section of the Warrior.ini file. Normal Mode 
has "Demo-Mode=0"; Demonstration and Training Mode has "Demo-Mode=1". Note that a reboot is 
required after changing this parameter. 
 
Click Next to continue with the Setup program, if the software would be run in demo Mode check 
Install for Demonstration/Training.  
 

 

FIG: 2.4 Setup directories 

Install to default directory C:\Warrior, Click Next 
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FIG: 2.5 Setup Options 

Fig: 2.5 Shows the choice of setup types available. Typical installs all the available items, Compact 
installs the minimum set of items and Custom allows you to choose which items to install. For a new 
installation, select the Typical option. If you wish to install to a directory other than the default 
(\Warrior), change the Install to entry now (However, this is not recommended). Click on Install to 
copy the programs, data and other files. Select the Typical option, and then click Next. 
 
 

 

FIG: 2.6 Setup Ready to install 

Click Next to continue. 
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FIG: 2.7 Setup has finished. 

 

Remove any disk from their drives, and click Finish to complete setup. 
 

 
VIDEO: 2.1 Install the Warrior Software for the First Time  

 

2.3 Warrior Software Upgrade or Perform new versions. 
Upgrades are released from time to time to distribute new or improved components of the software. 
These are different from upgrades, which are full releases in their own right. 
Upgrades Warrior Data Acquisition Software version 7.0 (051114) or latest is distributed on one 
CDROM. Or the software is downloadable in the form of a single executable file WAR7CH05114.exe 
from the web site http://www.warriorsystem.com/ under DOWNLOADS Warrior Software 32 Bit 
Version Warrior 7.0 STD Casedhole 051114  This file should be copied to a temporary directory and 
run to expand itself.  To install the Warrior software runs the SETUP.EXE.  
 

Restart the computer and turn OFF the Interface Panel Power supply 
Place the new version of Warrior CD in CD Drive. It should auto run if not run 
setup from CD causes the installation. An interactive menu appears as shown in 

    The Fig: 2.8  
 
To install the update from CD, Place the new version of Warrior CD in CD Drive. It should auto run if 
not run setup from CD. When upgrading from an existing installation, the current Warrior system 
program files and configuration files are saved to a backup directory. If problems occur with the new 
installation, the previous installation can be restored entirely. Select Upgrade from Version X.x to 
Version Y.y, the program files will be updated and existing configuration files will be then retained. 
 

http://www.warriorsystem.com/
http://www.warriorsystem.com/ftp/public/WAR7CH051114.exe
http://www.warriorsystem.com/ftp/public/WAR7CH051114.exe
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FIG: 2.8 Warrior 7.0 Version 051114 

Click Next to continue with the Setup program. 
 

 

FIG: 2.9 Upgrade and Perform new version. 

The Upgrade option of the software will keep the Services, Tools configurations, your customized 
presentations, and the tools string. 
The option perform a new version the system will install new software, but it will perform a backup 
before of installing the new version, the system performs a backup and saves in the following path 
C:\warroldbin\ 
If either upgrade or new version is selected and a previous version of Warrior exists, the current 
installation is saved to a backup directory. 
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FIG: 2.10 Start the installation 

The following dialog box (FIG: 2.11) will be shown while the information is being backed up. No 
action is required. 
 
If you wish to backup to a directory other than the default (c:\warroldbin), click the Browse button and 
select the directory that you wish to use. 
 

 

FIG: 2.11 Backup files 
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FIG: 2.12 Setup directory 

 

 

 

VIDEO: 2.2 Warrior Upgrade or Perform a new version 
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2.4 Warrior Software Structure 
The Warrior system has been designed to run a large number of downhole tools from a variety of 
manufacturers. For this, and other reasons, the system is highly configurable. The configuration of a 
particular installation is controlled by a number of configuration files. These files reside in the active 
warrior directory. At the time of commissioning of a system the configuration files are always modified 
from the SDS general release to meet a clients particular requirements. SDS does not keep copies of 
every installation, and while it is always possible to regenerate a particular configuration it is much 
simpler if copies of the configuration files are made and stored safely. 
 
Under warrior the system has the following folders: 
BIN 32: are all the Applications  (.exe), Dynamical link libraries (.dll), Digital Acquisition Script   (.DAS, 
and .WAS), Simulator files (.sim), System file (sys), and Help files (.hlp). Control Files (.cnt), CBL 
Acquisition Script (.cas) 
 
CONFIG: are all configuration setting (.ini), Company logo (.lgo), Warrior Calibration File (.wcf), 
Warrior Service File (.wsf), Warrior Import Filter (.wif), Warrior Convert File (.wcu). 
 
DATA: the database from the logs. 
 
FAX: The structure system to received and sends faxes. 
 
DRVERS: The system drivers (.sys), Dynamical link libraries (.dll), and setup information (,inf) 
 
FORMAT: Heading (.hug) , List Export Template (.let), Presentation Script (.prs), Warrior Calibration 
Plot (wcp), Warrior Tool Diagram (.wtd), and Warrior Well Diagram (.wwd). 
 
MANUAL:  Warrior Manual. PDF 
 
TEMP: Temporal files. 
 
 

 

FIG: 2.13 Warrior Structure. 
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2.4.1 Program Files 
EXE  (Executable files). Software programs start from an executable file. 
DLL  (Dynamical Link Library files). EXE files will call these to execute certain functions. 
 
2.4.2 INI Files 
There are several files with suffix .ini. They are generally used to store information concerning the 
overall setup of the system, and also information concerning tools and services. The files are 
generally updated from Warrior programs, but it may sometimes be desirable or necessary for the 
advanced user to update them directly using a text editor.  

 
Before changing any *.ini file make a copy of the original under another name so 
that if anything goes wrong you can recover by reverting to the original. 
 

Warrior.ini – Controls the system settings for a particular system. The warrior.ini file contains 
information concerning the global configuration of the logging system, both hardware and software. It 
is divided into sections delineated by keywords inside square brackets. Many parameters are set 
from Warrior system menus; however, some may only be modified from the warrior.ini file. 
It defines such things as where and how data is obtained. Default headings, default log scales, 
screen and plotter setups, and certain logging service parameters are setup in this file. (It is what 
makes a system different from other systems). The primary edit programs for this are the Warrior 
Control Panel and the Depth control panel. 
 
Services.ini – Defines what services are available from acquisition and how each individual service is 
setup. The primary edit program for this is the Edit Logging Service Details button from Warrior 
Utilities. 

The warrior system is highly configurable in order to support a wide variety of 
downhole tools. SDS sets up the services.ini file for a particular service set 
according to client and hardware requirements. Do not modify it without first 
creating a backup. 

 
The first series of entries define the content of the Services menu in the Acquisition module. The 
following entries define the setup of those services. Services are composed of one or more tools.  
 
Tools.ini – Defines the tools that are available for the system. Information includes physical model 
description (length, weight, type software, default filters, etc.) and calibration information for each 
particular serial number. 
 
Annotate.ini-Defines the annotation text which appears in the annotation window.  
Items under Always appear in the selection box of the annotate window and may be added or deleted 
and may be translated into another language. 
Items under translations define the extended curve names produced when a mnemonic is chosen 
from the list in the annotate window. The `translation' may change to whatever the user requires. 
Text file used to setup default annotation selections. May be edited using WordPad or notepad. 
 
Gates.ini – Text file used to save the PMON discriminators and WAVEFORM gates setups. 
LAS.ini – Text file used to setup default settings for writing LAS files, may be edited using WordPad 
or Notepad. 
LISTOWAR.ini – Text file used for conversion of warrior mnemonics to standard LIS mnemonics. 
VARS.ini – Default variables when acquisition starts. May be edited using WordPad or Notepad. 
Printers.ini – Default printer setups for adding printers through the warrior control panel. 
CGBTEL.ini, Servedit.ini, Tooledit.ini, Trcintrp.ini, Units.ini, and Wobjedit.ini are miscellaneous text 
files used to initialize certain services or programs. 
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2.4.3 LST Files 
Layouts.LST – Text file to describe default grid layouts for log formats in the Format Editor. May be 
edited using WordPad or Notepad. 
Data.LST – Text file used for default DB item List when defining a curve in the Format Editor. May be 
edited using WordPad or notepad. 
 
2.4.4 Miscellaneous  Warrior File 
DAS – DSP Data Acquisition Script. Text file used to control how the Digital Signal Processor looks at 
signals and acquires data. 
HDG – Heading File. Text files that describe what is in a heading. May be edited using WordPad or 
notepad. 
WLB – Well Log Banner. Text files that describe what is in a banner. May be edited using WordPad 
or notepad. 
HLP – Help files for particular programs. 
LET – LIS Export Template. Text file used to describe how Warrior Data is exported to an LIS file. 
May be edited using WordPad or Notepad. 
BIN – Binary files used by certain processes (Mainly DSP). 
CNT – Control files used by certain processes. 
LGO – Warrior Logo Files. Created by use of MFGRAB.exe. 
PRS – Warrior presentation file. Text file used to describe log format presentations. Edited with the 
Log Format Editor. 
WCF – Warrior Calibration file. Exported file used by the Tool editor for exporting/importing tool 
calibrations. 
WCP – Warrior Calibration Plot. Text file that describes how a calibration is printed out during a plot 
job. May be edited using WordPad or Notepad. 
WSV – Warrior Service file. Used by the service editor for exporting and importing services. 
WTD – Warrior Tool Diagram. Created by use of MFGRAB.exe. 
 
 
2.4.5 Data Base  Files 
Files, which terminate in the suffix .db are Warrior database files. They contain the well log data 
stored in a hierarchy by field, well, run and pass. The Warrior database file is physically a DOS file. 
Within the DOS file data from multiple wells or jobs may be stored, although generally one job is 
stored in a database file. The database files also contain various embedded files which themselves 
contain important information. These include: 
 

• Service data, e.g. tool string, depth offsets, filters etc. which relate to the log data within the 
*.db file. 

 
• Headings, the completed heading information and formats generated by the Heading Editor.  

 
 
• Plot job, the information generated by the Plot Job Editor for one or more plot jobs. 
 
• Annotations or curve labels. 

 
 
• Well sketches.  
 
 
 

2.4.6 Warrior\ Bin32  
DAS and WAS – DSP Data Acquisition Script. Text file used to control how the Digital Signal Processor 
looks at signals and acquires data. 
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2.4.7 Warrior\ Config 
 
Layouts.LST – Text file to describe default grid layouts for log formats in the Format Editor. May be edited 
from the Format Editor by choosing Layout – Edit Layout 
Data.LST – Text file used for default DB item Quick Pick List when defining a curve in the Format Editor.  
CNT – Control files used by Help file processes. 
HLP – Help files for particular programs. 
LGO – Warrior Logo Files used in Headings and Log Banners.  
WCF – Warrior Calibration file. Exported text file used by the Tool editor for exporting/importing tool 
calibrations.  
WMP – Warrior MATH PACK file. Text file for saving Math Pack calculations.  
WSV – Warrior Service file. Text file created by the Service editor for exporting and importing services.  
SIM – Binary file used for playback of recorded signals by the Warrior Simulator Box. 
 
 
2.4.8 Warrior\ Data  
DB – Warrior Database Files.  
LAS – ASCII data files that are produced from an LAS Export.  
PDF – Adobe Acrobat Portable Data File produced from a Warrior Print to PDF Action.  
TIF – Graphical image Tiff file produced from a Warrior Print to TIFF action. 
 
 
2.4.9 Warrior\ Format 
HDG – Heading File. Text files that describe how a heading is constructed and what information can be 
shown in a heading.  
LET – LIS Export Template. Text file used to describe how Warrior Data is exported to an LIS file.  
PRS – Warrior presentation file. Text file used to describe log format presentations. Edited with the Log 
Format Editor.  
WCP – Warrior Calibration Plot. Text file that describes how a calibration is printed out during a plot job.  
WLB – Well Log Banner. Text files that describe how a Log Banner is constructed and what information 
can be shown in the banner.  
WRF – Casing Joint Table. Text files that describe how a Casing Joint Table is constructed and what 
information can be shown in the table.  
WTD – Warrior Tool Diagram. Normally created through the Logging Tool Editor.  
WWD – Graphical file for user defined well object in the Well Object Editor. 
 

2.5 Create Device Manager on Desktop  
In Windows XP. Open Windows Explorer, navigate to C:\Windows\system32 find devmgmt.msc 
Right-click on the file select Send to Desktop (create shortcut). Rename this shortcut to Device 
Manager. 

 

VIDEO: 2.3 Device Manager 
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2.6 Warrior Shortcut Icon  

 

FIG: 2.14  Explore All Users 

On Start Right Click and select Explore All Users 

 

 

FIG: 2.15 Select Start Menu\Programs\Warrior 7.0 
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FIG: 2.16 Send the Shortcut Icon to Desktop 

 

 

FIG: 2.17 Copy the Shortcut Warrior 7.0 and Paste to Start Menu 
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FIG: 2.18 Open the shortcut warrior 7.0 and Select Tools\Folder option 

 

 

FIG: 2.19 Folder Options 

Check Use Windows classic Folders open each folder in the same window, and Double click to open 
an item (single click to select) select Apply and OK. 
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FIG: 2.20 Select View\Toolbars uncheck Standard Buttons, Address Bar, Link, and check Tiles 

 

 

FIG: 2.21 Resize the Window and move to right bottom side 

 

 

VIDEO: 2.4 Warrior Shortcuts 
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2.7 Key Software Authorization Setup  
There are two types of keys commonly supplied with systems: 
 
2.7.1 Full key 
Allow complete and unrestricted operation of the Cased Hole and/or Open Hole Software. 
 
2.7.2 Companion key 
Allow full operation of all the software, except for logging data against depth from an encoder. 
Companion keys are generally supplied on their own for stand-alone desktop processing systems. 
A Warrior USB key must be attached to a USB port on the computer for the software to operate 
(unless it has been installed in Demonstration mode). In addition, the key code and the panel type for 
the key being used (which is written on the tag attached to right side of the panel) must be entered 
into the Warrior Control Panel for the key to be recognized. 
Connect the Computer to the Warrior Panel (CP/CD/PA/OP/SLA) with USB Cable and let the panel 
OFF. 
 

 

FIG: 2.22 Select Control Panel  

 

 

FIG: 2.23 Panel type  

The software read automatically the Panel Type from the USB key inside the panel 
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FIG: 2.24 Click on Add Code 

 

 

FIG: 2.25 Type the Key Authorization Code (16 Hex Digits). 

In Demo Mode the software does not need the Key authorization. 

 

FIG: 2.26 Type the notes about the Key Number, Panel Type, Software version, and Logging Unit. 

 

VIDEO: 2.5 Key Authorization setup 
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2.8 Warrior USB Drivers Setup  
USB Warrior Drivers are copy under C:\Warrior\Drivers the first time you installed the Warrior 
Software. 
Since your computer comes with more than one USB port to connect your Warrior Panel, the 
Following procedure should be repeated for each USB port in the computer: 
• Connect the USB from Warrior Tool Interface Power Supply Panel cable to the new USB port 

Computer. 
• Turn ON the Warrior Tool Interface Power Supply Panel. 
 

 

FIG: 2.26 Windows XP Found New Hardware 

Select:  No, not this time and click on Next to continue 
 

 

FIG: 2.27 Cypress Driver STD interface Installation 
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FIG: 2.28 Preload Driver CYSTD 

 

 

FIG: 2.29 Start LOGFX Interface Preload. 

Click on Select Next to Continue 
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FIG: 2.30 Continuing your Installation 

Click on Continue Anyway 
 
 

 

FIG: 2.31 End the LOGFX Interface Preload 
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FIG: 2.32 Install driver CYSTD 

Click on Select Next to Continue 
 

 

FIG: 2.33 CYSTD Driver Installation 

Click on Continue Anyway 
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FIG: 2.34 End CYSTD Installation 

Click on Select Next to Continue 
 

 

FIG: 2.35 Install driver LOGFX-DSP 

Click on Select Next to Continue 
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FIG: 2.36 Install LOGFX-DSP Device 

Click on Continue Anyway 
  

 

FIG: 2.37 End LOGFX-DSP Installation 

Click on Continue Anyway 
Turn OFF the Warrior panel, Connect the USB Cable to next USB port, Turn ON the Warrior Panel 
and repeat all the process until pass for all the USB ports in the Computer. 

 

VIDEO: 2.6 Drivers Installation. 
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2.9 Device Manager 
The device manager checks the connectivity between the Devices (Warrior Panel), USB Connection, 
and the computer. Double click over Icon 

 

FIG: 2.38 Device Manager Icon  

 

FIG: 2.39 Device Manager Path 
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The new Warrior software version install in XP windows Control panel the new Devices: 
 
CYSTD:  Replace the old DAMUPCI (USB44 Board) 
CYAUX:  Replace the old USBAUX (Slab, Sondex Panels) 
CYDEP:  For a new Acquisition/Depth Panel 
CYUSB:  Generic Replace the HID  (Human Interface Devices drivers for USB44 board)  
EZUSB:  Generic used by DSP 
SDSLOGFX:  DSP Driver 
 
DEVICE MANAGER: 
Scientific Data Systems CYSTD (USB44 Board) 
Scientific Data Systems LOGFX-DSP (DSP Board) 
Scientific Data Systems CYSIM (Simulator Box) 
Scientific Data Systems CYSHPNL USB Shooting Panel) 

 
The new software version installs the Icon Scientific data Systems under Control Panel 
Aladdin USB Key is inside the panel, Simulator is connecting to USB HUB, SDS LOGFX-DSP, and 
USB44 are inside the panel. 

 

 

FIG: 2.40 SDS Control Panel 
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FIG: 2.41 SDS Device Properties 

 

2.10 Creating Logo  
 
The following will explain how to create a Warrior Logo file (*.LGO files) for use on headings and log 
banners. The primary Warrior program for creating LGO files is called MFGRAB.EXE and is located 
in the Warrior\Bin32 folder. MFGRAB “captures” any graphic image that is on the Windows Clipboard 
and allows the user to save the file as an image that can be used by the Warrior Software. This is the 
last part of the process and is relatively easy. The hard part is to get an appropriate logo copied to 
the Windows Clipboard. 
For a logo to work correctly in the Warrior Standard heading, it should be twice as wide as it is high 
and be outlined with a heavy dark line. The actual dimensions used are not critical, it is the two to 
one relationship that is important so that the logo will appear in correct proportion when placed in the 
heading. If the logo is not outlined, it will cover the Border area of the heading around the logo and 
make it look unusual. 
If you do not have any existing graphical image for a logo, such as a JPG, TIF, or BMP, you can use 
most drawing program such as Windows Paint to create your LOGO image. If you meet the above 
criteria, you should be able to copy the image directly to the Windows Clipboard. In Paint, this is done 
by clicking on Edit ->Select All, to select the image. Then clicking on Edit -> Copy, to copy the image 
to the clipboard. 
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FIG: 2.42 Windows Paint 

 

 
FIG: 2.43 Copy 

At this point, you could use the MFGRAB program to save your logo. We will look at this later. What 
we want to look at now is if you already have an existing graphical image, how do you use this image 
to create a logo. 
The problem is to get your existing graphical image to match the criteria of being twice as wide as 
high and having a border around it. You could put it into a drawing program and try to get it to fit. I 
like to us Microsoft WORD. 
The first step is to insert the image into the WORD document. To do this, open a new WORD 
Document. On the Menu Bar, click on Insert -> Picture -> From File …  An Insert picture dialog box 
will come up. 
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FIG: 2.44 Insert File 

 
You can use the Look in: dropdown list to choose the drive or folder that the file is located in. Click on 
the image file that you wish to make into a logo. Then click on the Insert Button. Your selected image 
should now be in your word document. 
 

 
FIG: 2.45 Insert in Word document 

Next we need to create a box to put the logo into. If the Drawing Toolbar is not at the bottom of the 
WORD window, click on View -> Toolbars and click on Drawing to activate the drawing toolbar. 
Look on the drawing toolbar and click on the rectangle. Now use the cross hairs of your mouse to 
draw a rectangle on the WORD document. When you have the rectangle drawn, right click inside the 
rectangle and choose the Format Autoshape choice.  
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FIG: 2.46 Select Frame 
 
There are several things that we need to do to format the rectangle. First select the Colors and Lines 
Tab. Set the Color to No Fill. The line defaults are Color - black, Dashed – solid, and Style – single 
line. Change the line weight to 2. 
 

 
FIG: 2.47 Select me color and line 
 

 
FIG: 2.48 Set Frame Size (3x6) 
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Next, click on the Size tab and set the Height and Width to your desired dimensions. Three inches 
by six inches work well form most logos. Your WORD document should now have your logo image 
and the box on it. 
 

 
FIG: 2.49 Setup Frame 

 

 
FIG: 2.50 Layout Picture 
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FIG: 2.51 Set picture into the Frame 

Next we need to move the image and size it to fit into the box. Right click on the image and choose 
Format Picture. Then click on the Layout tab. Choose the right most icon, In front of text, and click 
OK. Your image should not be surrounded by squares. If you position the mouse on the image and 
click and hold the left mouse, you should be able to reposition the image. If you move the mouse to 
one of the squares and click and hold the left mouse, you should be able to resize the image. Move 
and resize the image as needed so that it fits into the logo box. 

 
 

 
FIG: 2.52 Resize Logo picture 
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Now the image is in the box but we still have a bit more to do. On the drawing toolbar, click on the 
select objects arrow. Then use your mouse to make a rectangle around both the image and the logo 
box. Both the image and the logo box should have the resize rectangles on them now. On the 
drawing toolbar, click on Draw and select Group. The resize rectangles should only appear on the 
logo box. 
 
At this point, you can right click on the logo and select Copy. Or you can select Edit on the Menu Bar 
 

 
FIG: 2.53 Copy Logo 

and select Copy. This copy action has copied the logo that you have created to the Windows 
Clipboard. 
You will find MFGRAB.EXE in the Warrior\Bin32 folder. You can use Windows Explore to find the 
program and execute it or you can use the Start Button – Run option to find the program and execute 
it. It should show the logo that you have created. 
 

 
FIG: 2.54 Execute MFGRAB 
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FIG: 2.55 Save file in warrior 

To save the logo, Click on File -> Save As . . . You will get a dialog box in which to enter the logo file 
name. The path must be C:\warrior\config\. The file name must be an 8 character or less DOS 
compliant file name with the .LGO extension. In the example below, NAME would be the DOS file 
name. 
 

 
FIG: 2.53 Create a path to save the file 

 

 
FIG: 2.54 File Logo Path  
 
Double Click over your Warrior.ini 
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FIG: 2.55 Warrior.ini  

Finally, in order to use the logo, we must declare it in the Warrior\Config\Warrior.INI folder under the 
heading section as shown: 

  
[Heading] 
default=StdCased.hdg 
Logo=NAME.lgo 

  
StdCased heading uses the picture name Logo, which is defined here. Different headings may use 
different picture names, but that will not be discussed at this time. 
Copy your logo under Warrior\Config 
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FIG: 2.56 Warrior.ini  

Save the File 

 

 

FIG: 2.57 Save  
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2.11 Warrior Convert for OLD version 7.0  
Convert files from previous versions 7.0 - 051114 to the new ones 7.0  
 
2.11.1 If you Upgrade your old version  
Go to Warrior\Bin32\WarConv.exe 

 
FIG: 2.58 Select WarConv 

 
Double click over WarConv 
 
 

 
FIG: 2.59 Run Warrior Configuration File Convert  

 
Select 2005.07 Update 
Click on Run 
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2.11.2 If you perform a new version and you have the old configuration, Files  
Restore the Old Configuration files version 7.0 
Go to Warrior\Bin32\WarConv.exe 

 
FIG: 2.60 Select WarConv 
 
Double click over WarConv 
 

 
FIG: 2.61 Run Warrior Configuration File Convert  

 
Select 2005.07 Update 
Click on Run 
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3 Warrior Control Panel  
The Control Panel sets certain global characteristics of the Warrior system. The Warrior Control 
Panel is started from its icon in the Warrior program group or via the Windows Start button. 
 

 

FIG: 3.1 Warrior Control Panel 

 

Section

3 
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3.1 Show Depth as 
These option buttons in the upper left set the default depth units for the system. 
The choices are Feet or Meters. 
 

 
FIG: 3.2 Depth units 

3.2 Use Language 
These option buttons set the language of the user interface for the system. Several choices are 
expected to be available shortly. 
 

 
FIG: 3.3 Languages 

 
 

3.3 Refresh Monitors every 
These text boxes allow control over the rate of screen refresh for numerical and graphical data 
monitor displays (waveforms). Waveform is set to 500 msec. and numeric is set to 1000 msec. by 
default. The minimum value currently accepted is 100 msec. Updating at a high rate tends to make 
the monitors difficult to read and the 1000 msec. refresh rate is a good compromise. 
 
 

 
FIG: 3.4 Refresh Monitors every 

3.4 Show Data Units as 
These buttons allow selection of the default units system. The system allows three sets of data units, 
namely English, Metric and User Defined. The actual units for each selection may be edited by 
clicking the Edit command button making selections in the options box shown below. 
The units for the various types of data and parameters may then be selected for a particular units 
map, accommodating occasions where a mix of English and Metric units may be required. 
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FIG: 3.5 Select Unit Maps 

 
FIG: 3.6 Horizontal Gridline Setup 

Set up compression ratios for gridlines. 
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3.5 New Authorization Code 
This box is used for entering a sixteen digit Hex code for systems that have been installed with a 
software full time key. Some panels are release with Software time key it is valid for a specific 
duration of time (60 days). When the Key expires please Contact Scientific Data Systems for valid 
extension codes. 
The second line we recommend type all the information about the Key number, Panel number, 
software version, and Unit number.  
 
 

 

FIG: 3.7 Add a New Key Authorization Code 

 

3.6 See Key Authorization Codes 

 

FIG: 3.8 See Codes 

Click on See Codes, you can see all the codes in your Warrior Software 

 

FIG: 3.9 Key Authorization Codes 
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3.7 Printer Installation. 

3.7.1 Windows XP Printer Installation  
To Facilitate this operation a USB Port has been assign on the Interface Panel (rear Plate) and 
marker “Plotter”. It is recommended to use this USB port for your printer connection. 
Install the printer in windows XP first . The warrior software CD must be in the CD Device. 
Plug in Belkin USB Printer Adapter cable into any available USB port. 
Do not remove the Belkin USB printer from the chose USB port 
Do not plug in the USB printer adapter to different USB port 
Turn Printer On. 
 
Select setting/Printers and Faxes 
 

 

 

FIG: 3.10 Windows XP Control Panel 

Select Printers and Faxes 
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FIG: 3.11 Printers and Faxes Window 

Add Printer 

 

FIG: 3.12 Add Printer Wizard 

Select Next 

 

FIG: 3.13 Local Printer 
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Uncheck (Automatically detect and install my Plug and Play printer) and Select Local printer attached 
to this computer 
Select Next 
  

 

FIG: 3.14 Select a Printer Port 

Select USB Port USB0001 to start. 

 

FIG: 3.15 Install Driver. 

Select Manufacturer Printrex and Model Printrex 840DL/G the driver is in the CD select “Have Disk” 
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FIG: 3.16 Install from Disk 

Select the CD Driver in this case is D: and “Browse” 

 

 

FIG: 3.17 Printrex Drives options. 

Select the Driver PRINTREX WIN2K, this driver is to install in WIN2K and windows XP. 
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FIG: 3.18 Select the drive 

Run the Drive 

 

 

FIG: 3.19 Install the Printer Drive 

Select 840DL/G or the model is connecting to the PC. 
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FIG: 3.20 Set the driver 

Select replace existing driver 

 

 

FIG: 3.21 Printer Name 

Type the name or let the default Printer. 
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FIG: 3.22 Printer sharing 

Select do not Share this printer 

 

 

FIG: 3.23 Test Printout 

Select Yes  
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FIG: 3.24 Continuing Installation. 

 

 

FIG: 3.25 Completing the Add Printer 

Select Finish. 
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FIG: 3.26 Test Page 

The Printer Test Page must appear. At this point the Printer is installed in windows 
XP and then select OK. 
  

 

 

FIG: 3.27 Printers and Faxes 

Check if the Printrex 840DL/G is set as default 

 

 

VIDEO: 3.1 Printer Windows installation 
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3.7.2 Warrior Printer Installation 
There are two different methods that Warrior uses to print.  If you want a hardcopy of your log while 
you are logging, then you must print to a Direct printer.    For good quality color prints, or to print to a 
printer that is not in the list of Direct printers, select the option Enable printing through Windows 
printer.  If you have that button checked, then when you print from Warrior, you will see either (Direct) 
or (Windows) label for each printer in the list of printers to print to. 
Selecting Help will bring up useful information about the settings for various printers, supported by 
Warrior. 
 
3.7.2.1 Direct to Printer 
Most printers, supported for Direct printing by Warrior, also have Windows drivers, so when a Direct 
Printer is installed; the Windows driver should be installed as well if there is one. Select a printer 
name, as would be done during a printer selection in Windows programs. Warrior can use the port 
properties you set up for that printer through the standard Windows printer setup, so the port name 
doesn't have to be specified in two different places. When a Windows name is specified, then the 
Port Name doesn't need to be changed in Warrior, as it will use the same port that is set up through 
your standard Windows printer setup. 
The Port Driver should be set to port32 for all printers except the Gulton 250 and 275, which use the 
cenpoll32 driver, as they don't have any corresponding Windows drivers. When using Direct printing, 
settings, such as media type, plot speed, etc., are all controlled by Warrior directly, not by the 
Windows printer driver. 
Recommended printers for color printing Direct: 
Epson Stylus Color 900 
Epson Stylus Color 1520 
Epson Stylus Color 3000 
Epson Stylus Color C60, C80, C82, C84 
HP DesignJet 750C, 1050C 
 
Recommended printers for monochrome printing Direct: 
Printrex 840 DL/G ( www.printrex.com ) 
ISys V8.5e ( www.isys-group.com ) 
 
 
3.7.2.2 Printing through Windows Printing 
Whilst logging, it is possible to print to a Windows printer. However, printing hardcopy of your log is 
not possible. SDS cannot guarantee that all printers will work properly for making prints from 
Warrior, therefore a list of tested printers, that are able to make continuous prints, is available. The 
Windows printing options are settings that may change from one printer to the next. However, most 
of the settings are set by SDS, so they should not be changed. Some printers place a large gap at 
the start of a print, so a print gap is added during start of print, so the first fan fold can be skipped and 
a distance can be added to get the <fold here> to come out in the right place. 
When using Windows printing, settings, such as media type, plot speed, etc., are all controlled by the 
Windows printer driver. 
Recommended printers for color printing through Windows: 
Epson Stylus Photo 825 
Epson Stylus Photo 890 
Epson Stylus Photo 1280 
HP designjet 5500 
HP deskjet 5550 
HP deskjet 6540 
Isys Iterra Elite color LED * 
Isys Iterra Lite color thermal inkjet * 
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Recommended printers for monochrome printing through Windows: 
Printrex 820DL/G, 840DL/G 
ISys V8.5e 
 
(* Denotes printer can do multiple copies) 

 

 

FIG: 3.28 Control Panel Printer Setup 

Select Printer Setup 

 

FIG: 3.29 Installed Printers 
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Some of the Windows printers may require a value to be entered for the “Gap to start of print”.  
Having a non-zero value will cause the printer to advance the paper that distance, so the first fan fold 
page may be blank in order to position the print head to the proper place. 

Select the Install button for a list of printers, supported by Warrior, 
for printing whilst logging. When this box is checked, either a (Direct) or (Windows) label for each available 
printer is shown when printing from Warrior. For fan fold printing, set the printer page size to twice the size 
of one fan fold page. 

 

FIG: 3.30 Install Printer 

Open the  Drop- down box 
 

 

FIG: 3.31 Install Printer 

Select Printrex 

 

FIG: 3.32 Install Printer 

Click over Install 
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FIG: 3.33 Printrex 820/840 Plotter Configuration 

For fan fold printing, set the printer page size to twice the size of one fan fold page 

Select Save 

 

FIG: 3.34 Installed Printers 

Select on the Drop-down the Printer Model Printrex 840DL/G 
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FIG: 3.35 Installed Printers 

Select Save Changes 

 

 

 

VIDEO: 3.2 Warrior Printrex Install 

 

3.7.2.3 New Printers List 
Printing help and Printers32.ini contain details of printers tested with Warrior. However, printers are 
constantly changing, so check the following link http://www.warriorsystem.com/Support_Printers_List.htm 
 
COLOR PRINTING NOTICE:  You will always get better color prints printing through a Windows color 
printer.  None of the direct color printers were designed for printing continuous log prints.  Unless you 
require color printing while logging, we recommend you use one of the Windows printers and not use 
Direct printing to a color printer. 

Source Resolution: If it takes a long time to print to your Windows printer, try setting this to a lower 
value.  The default is 1.  A lower value may degrade the print quality, so test with your printer to find 
the optimal setting.  You may be able to use a higher Windows printer resolution ( 600 or 720 dpi ) 
and use a Source Resolution of 1/2 or 1/3 and still get a quality print.  

http://www.warriorsystem.com/Support_Printers_List.htm
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3.7.3 Finding Printer  
We recommend connect the Printer/Plotter in the same USB port but if you do not know which port is , you 
can find the USB port where the printer is connected .  

 

FIG: 3.36 Installed Printers 

Check Enable printing through windows printer. 

 

FIG: 3.37 Installed Printers 

Select on the Drop-down the Printer Model Printrex 840DL/G 



 

77 Warrior Software Version 7.0 Standard Cased Hole

 

FIG: 3.38 Installed Printers 

Select find this Printer on USB port. 

 

FIG: 3.39 Find Printer 

Select Yes 

 

FIG: 3.40 Testing Printer 

If the test print comet out select Yes It means the printer is connect to USB002 

 

FIG: 3.41 Printer Found 

Select OK 
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FIG: 3.42 Installed Printers 

Select on the Drop-down the Printer Model Printrex 840DL/G 

 

FIG: 3.43 Installed Printers 

Select on the Drop-down Printrex 
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FIG: 3.44 Installed Printers 

Uncheck Enable printing through Windows printer and select Save Changes 

 

VIDEO: 3.3 Find Printers 

3.7.4 Printing to PDF 
Warrior supports direct printing to PDF files through its own driver. Before creating a PDF output, 
determine what the customer intends to do with the file and configure the PDF options accordingly. 
If it is intended only to view the PDF on the screen, then the driver should be set to Continuous 
Viewable Image and Color. If the customer intends to print the PDF, then it should be set to 
Continuous Printable Image and Color or Monochrome, depending on the printer being used. In 
addition, it may be important to set the page size to match the page size of the customer's printer; 
otherwise gaps between pages can appear. 
Furthermore, there is a trade off between file size and quality. The higher the dpi setting, the better 
the quality normally, but the file size is larger. Some experimentation may be required with the 
customer to produce optimal results. This is also true for the selected compression mode. For most 
situations, FLATE compression works well. 
 
3.7.5 Printing to TIFF 
Warrior also supports direct printing to TIFF files through its own driver. Again, determine what the 
file is intended for and configure the driver accordingly. 
Note that the driver supports TIFF single continuous pages of longer than 90 inches. However, many 
TIFF applications (including Warrior fax) do not support this, so before increasing the maximum page 
length be sure that the customer can read such files. 
 
3.7.6 Cable Type 
Select the cable type according with logging unit cable if the cable it is not available select the close one, if 
help to select the values to equalized the signal on the cable. 
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FIG: 3.45 Cable Type 

3.7.7 Set Up Real Time Backup 
The software has the options to storage the backup data in other directory or hard disk at the same time it 
storages the data in the Warrior\Data. 

The software has three options: 

3.7.7.1 No Real Time Backup  
It just storage the data under Warrior directory or the path directory you select, this option is select by 
default. 

3.7.7.2 Offer to Make Copy after each Pass. 
At the end of each pass offer to make copy and storage in the Real Time Backup directory path you select. 

3.7.7.3 Automatically make copy after each pass 
Each pass will be automatically storage in the Real Time Backup directory path select by you.  
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FIG: 3.46 Setup Real time Backup 
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FIG: 3.47 Set Real time Backup Directory 
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4 Acquisition 
Acquisition is the main logging or data acquisition subset of the Warrior system. It acquires data from 
the hardware I/O devices, stores the raw data in the Warrior database and provides all the normal 
well logging functionality. When necessary, it also automatically starts other Warrior programs to 
perform additional functions in an integrated manner. In the Warrior System group, choose the 
Acquisition icon. (Double-click the icon,).  Note SDS sets up the software to display a Warrior System 
group on the desktop. However the program group is also available via the Start button. 
 

 
FIG: 4.1 Acquisition  

 
Never switch off or disconnect a panel if Acquisition is running; always exit 
Acquisition first. Unpredictable results may occur if communication is lost with a 
panel during an Acquisition session.  

 
Warrior is sensitive to USB devices being disconnected whilst it is running. USB devices can 
disconnect automatically when a computer goes into standby, so it is recommended that all 
standby/sleep/hibernate functions on the computer are disabled when using Warrior, not forgetting 
that closing the lid on laptop computers often puts them into standby as well. 

Section

4 
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4.1 Depth Control 
The Warrior Logging System menu box will appear, along with the depth display. The depth box 
displays the current depth and the line speed and has a Control button that causes the Depth 
Control window to be displayed. 

 

FIG: 4.2 Depth Display 

Click on the Control button of the Depth window or hit Enter when the Depth window is active. 
The Depth Control window appears as shown in Fig: 4.2. Enter the current depth in the New Depth 
field and click on Apply (or hit Enter). To configure the Depth Control, click on the Config button to 
access the Parameters and Alarms menu Fig: 4.5. The Depth Panel setting should normally be left 
at None; it is only used when there is a stand-alone depth system. 

 

FIG: 4.3 Depth Control 

 

FIG: 4.4 Depth Control Configurations. 
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The Depth Configuration window enables selection of the depth source from an encoder input or a 
simulated depth input generated from within the software. The measuring wheel correction, the 
encoder characteristics, nominal wheel size, and encoder direction are entered from this dialog box. 
The simulated encoder speed and direction are adjusted using the slider bar and radio buttons.  
Parameters in green Hi-Liter for the Scientific Data Systems Depth, Tension, and Line Speed panel 
(if it installed) may also be entered or read. 
The depth control box may be displayed at any time by clicking the Control button of the depth 
display; however the New Depth, Correction, Encoder Resolution and the Wheel Size parameters 
may not be changed while logging.  
The system maintains the encoder depth and the simulated depth separately, and keeps them 
updated. It is therefore possible to switch to simulated depth while the encoder is turning, perform 
some operation, and then return to the encoder depth, which will be updated and accurate. The 
Alarms set the values and tolerance to active the alarm, if the box is check. Reverse set the encoder 
direction (Up/Down) in the computer. 
 

 

FIG: 4.5 Depth Configuration 

Scientific Data Systems Depth, Tension, and Line Speed panel is connecting in the USB port select 
USB, if there is not panel available select None option. 

 

FIG: 4.6 Depth Panel Type 
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FIG: 4.7 Select Depth Panel. 

Click on the Control button of the Depth window or hit Enter when the Depth window is active. The 
Depth Control window appears as shown below. Enter the current depth in the New Depth field, and 
clicks on Apply (or hit Enter). 
 

 

FIG: 4.8 Apply to Set Depth 

 

FIG: 4.9 Set Depth 
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4.2 File 
The following options can be selected in File: 
Select Dataset, Load variables, About, Exit, Close All. 

 
FIG: 4.10 File Options. 

4.2.1 Select Dataset 
The Warrior well log database can (optionally) contain data from many wells, and within each well, 
data from many log passes. Each log pass is stored in a dataset. The dataset contains not only log 
data, but also other information about the logs, e.g. calibration and tool data. 

 
FIG: 4.11 Select Dataset.  

The system requires a DOS filename to be defined for the database file within which the data is to be 
stored. The structure of the Warrior log database allows datasets to be defined by field, well, run and 
pass. The user may optionally choose to insert in the various fields of the Select Dataset window, 
abbreviations of the actual field and well names. The run number and pass may also be entered, or 
they may be used to identify some other features of the dataset. 
As an example, when running production logging, multiple passes are normally made, and can be 
difficult to identify later, if the dataset definition is left with the default entries. Another approach is to 
use the run field to identify the tool being run, e.g. field/well/temperature/pass1. The pass number will 
automatically increment every time a log is started. 
If desired, modify the remaining fields to reflect the actual well and log information. 
Click on OK or hit ENTER. 

 
FIG: 4.12 Select Dataset  

Enter a compliant file name in the Select Database field 
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If desired, modify the remaining fields to reflect the actual well and log information. 
Click on OK or hit ENTER. 

 

FIG: 4.13 Dataset Values  
 

The file names may contain only the following characters: 
        Numbers (0,1-9)  
        Letters (A-Z, a-z)  
        Blank (Theoretically you can have spaces)  
        ASCII characters greater than 127  

Special characters: $ % ' - _ @ ~ ` ! ( ) ^ # &  + , ; = [ ]  
Lengths of the file names are limited to 255 characters (260 for full paths). 
  

The user may choose to store all data from a particular field in one file, or only the data from one log 
pass, or any intermediate level depending on the requirements. The usual procedure is to store all 
the data from one job in one file. In this way it is simple to backup the data to tape before leaving the 
wellsite.  
Data may be merged into a single log file, or split into several files using the Merge program, to be 
described elsewhere. 
 
4.2.2 Load variables 
 
This option allows you to load Zoned Variables from previous database passes. This is particularly 
useful when repeating runs, but creating a new database every time. Load Variables the other 
Dataset, enabling depth dependent parameters associated with the selected service to be zoned and 
values to be set. 
 
 
 

 
FIG: 4.14 Load Variables  
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FIG: 4.15 Load Dataset Values 

 

 
FIG: 4.16 Dataset Values run1/pass1 
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4.2.3 About 
Shows the Software version installed in your computer 

 
FIG: 4.17 Select About 

 

 
FIG: 4.13 Show the Version Warrior Software 

 
4.2.4 Exit 
Closes the program in the standard Windows manner. Exit the acquisition window. 
 
4.2.5 Close All 
Closes all windows that have been opened in a Warrior Acquisition session. 
 
 

 
VIDEO: 4.1 File 

4.3 Service 
In the Warrior acquisition window click on Service and select the desired service from the drop down 
box.  The services can be customized using 'Edit Logging Service Details', in Warrior Utilities. 
None is the service that is loaded by default when the Acquisition module starts and must always be 
present. As delivered, it contains no tools (except the tool STD that is a dummy tool that must be 
included in every service). It will display depth, and you can monitor line tension and speed. 
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FIG: 4.14 Select Service 

The tool string editor will appear.  The correct serial number and placement for each tool should be 
verified. Length, offsets will be calculated and calibrations for the selected tool serial numbers will be 
loaded. Select Properties to go Tools Editor. 

 
FIG: 4.15 Tool String  
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FIG: 4.16 Tools Editor 

 

FIG: 4.17 GR Sensor Offset 

In the Fig: 4-18, 4-19,4-20, 4-21,and 4-22 show the way to take the tool measure for Length and 
Offsets  
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FIG: 4.18 CCL Tool Length and Offset 
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FIG: 4.19 Gamma Ray /CCL Tool Length and Offset 
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FIG: 4.20 Gamma Ray /Neutron/CCL Tool Length and Offset  
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FIG: 4.21 Single Receiver Bond Tool Length and Offset 
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FIG: 4.22 Dual Receiver Bond Tool Length and Offset 
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FIG: 4.23 Dual Receiver Bond/Gamma Ray/CCL Tool Length and Offset 
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After the service has been loaded the selected service will be listed on the service line in the 
acquisition window. 
 

 
FIG: 4.24 Warrior Logging System 

Set the service 
Select Action 
 

4.4 Action 
 

 
FIG: 4.25 Power Control 

4.4.1 Power Control 
Select Power Control from the Action menu. The Power Control window appears as shown below. 
Select the Enable box. 
Note: Tool voltage a current must be calibrated. 
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FIG: 4.26 Power Control 

 
FIG: 4.27 TCURR Outputs 

When the Tool Current (TCURR) is less of 10 mA for a Time period more than 10 seconds, the tool 
power supply relay is set to the power disabled position. 
The Tool Current point value (10mA) is set in warrior.ini 

 
FIG: 4.28 Open Line Warning 
 
Boolean switches  (which can be entered as 'true', 'yes' or '1', or, 'false', 'no' or '0'): 
  
NoMonitor= True to completely disable power monitoring) 
External= rue will allow monitoring (if TVOLT and/or TCURR are measured), but only pop-up 
message; no cutoff 
 
Numeric entries: 
OverCurrent= Maximum allowable TCURR milliamps, 0 = disable current monitoring. 
OverVoltage= Maximum allowable TVOLT volts, 0 = disable voltage monitoring.) 
OverDissipation= Maximum allowable TVOLT/TCURR watts, 0 = disable dissipation monitoring.) 
ShortVoltage= Minimum TVOLT volts AND 
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ShortCurrent= Maximum TCURR milliamps for short-circuit detection, either 0 = disable short 
monitoring) 
OpenCurrent= Minimum TCURR milliamps AND 
OpenTime= Maximum time interval for open-line detection, either 0 = disable open monitoring) 
N.B if supply in NOT external, missing entries will be defaulted to 10 milliamp and/or 15 seconds. 
 
Text entries: 
ActionOnTrip= 'Cut' anywhere in the entry causes supply to be turned off, if possible;  
'warn' anywhere will cause a message box to pop up.) 
 
 

 
 
FIG: 4.29 Add Controls 
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FIG: 4.30 Power Control 

When the Warrior system is invoked or the service is changed, the tool power supply relay is set to 
the power disabled position. Clicking the Enable button sets the relay to the enabled position and 
allows tool power to be applied to the wireline. Clicking Disable disconnects the power supply from 
the line and connects the line to ground. 
The user may choose to have the Power Control box disappear whenever an action is taken by 
deselecting Keep this box. Otherwise the box will remain until closed by the user in the normal 
manner. 
In order to Enable the  software Power Control  go to Services Editor, select the service,  ADD 
control, select SoftPowerControl , and Save . 
 

 
FIG: 4.31 Services Editor 
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FIG: 4.32 Controls 

The Acquisition software module monitors the output current and voltage, and the power dissipation 
within the tool power supply. It checks for over voltage, over current, excessive power dissipation and 
short circuit conditions. If any fault condition is detected the power supply will be disconnected from 
the line and a warning message displayed. 

 
FIG: 4.33 Line Enable  

The Polarity section of the window controls the polarity of the line voltage with respect to ground. 
The default is Positive. Clicking the appropriate button, causing the polarity relay to switch, may 
change the polarity. In order to switch the polarity of the power supply from the Power Control 
window the Interface Panel Polarity Switch must be in the Auto position. 
The line power can also be controlled from Power Control window. Entering a percentage of the line 
power into the relevant textbox and clicking on the Apply button can adjust the level. 
You can also use the scroll bars as an alternative. 
For a number of tools, the line power needs to be ramped up gradually before reaching its maximum. 
You can enter a Ramp Rate in Volts per second in the textbox, provided, to protect these tools. 
Turn On the switch Tool Power and adjust the tool voltage according to the Tool specification. 
If the base line is clean adjust the threshold at 50% of the signal. 
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FIG: 4.34 PMON Threshold 
Adjust the amplitude of the pulse signal with the Sync Gain Slide bar, and adjust the CCL signal with 
the CCL Gain Slide bar. 

 

FIG: 4.35 Slide bars Control 

4.4.2 Caliper Control 
This function is for Open Hole tools to Open and Close the Caliper. 
 
4.4.3 Relay Control 
The relay control is for opened Hole tools to switch the down tool from de log mode to Calibration 
Mode or reference Mode. 
 
4.4.4 Calibrate 
Invokes calibration procedures for particular services. 
Note that in order to record a post survey calibration a log pass must be generated after performing 
the calibration. In order to include the post survey calibration in the Plot Job this log pass must be 
selected when selecting the post survey calibration. 
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4.4.5 Verify 
Invokes verification procedures for various services. 
Note that in order to record post survey verification a log pass must be generated after performing 
the verification. In order to include the post survey verification in the Plot Job this log pass must be 
selected when selecting the post survey verification. 
 
4.4.6 Plot Cal Report 
Allow you to print out all the calibrations information for all the tools in the current string. 
Print out the calibration report at the end of the Log. 
 
4.4.7 Record Up 
The plot may be paused by using the Pause button and terminated by reselecting Unpause. The plot 
may be paused at any time and the scroll bar, used to move back through the log to any zone of 
interest. When moving the scroll bar, the actual log depth, corresponding to the scroll bar position, is 
indicated in a box in the centre of the log plot window. A popup window opens by right clicking on the 
plot, displaying all the curve's values (Log readings) at the mouse position. 

 
FIG: 4.36 Record Up GR/CCL/TEMP 
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FIG: 4.37 Options 

 
FIG: 4.38 Tool Position 

This option show the tool position 
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FIG: 4.39 Tool Position ON/OFF 

4.4.8 Record Down 
Starts logging down. 
 
4.4.9 Record on Time 
Sets record on time reference mode. You will be prompted for the sampling rate in samples per 
second for fast sampling; or seconds per sample for slow sampling. 
 
4.4.10 Replay 
Replays data from current database. 
 
4.4.11 Independent Replay 
Replays data from any database. 
 
4.4.12 Depth Shift 
Makes a linear shift to the depth reference on a data file. 
This feature is intended to provide a rapid tie-in capability by applying a linear depth shift to a 
dataset. Once a section of log has been made and is displayed on the screen, select Depth Shift 
from the Action menu. The window shown in Fig:4.30 below appears. Or Apply Linear Depth Shift 
function is also available from the Utilities program in the Warrior shortcut folder. 

 
FIG: 4.40 Depth Shift 
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FIG: 4.41 Down Hole Depth Shift 100 ft.  

The database and pass are defaulted to those of the last logged section. The Feet or Meters 
selection is defaulted to that set in the Control Panel. 
Enter the required depth shift for the file and click Apply. Note that a positive number, entered here, 
increases the overall depth of the file. The screen plot of the file is now automatically redrawn, 
reflecting the applied depth shift 

 

FIG: 4.42 Set Depth Shift 100 ft. 

Add 100 Ft. 

 

FIG: 4.43 Up Hole Depth Shift -100 ft  

Subtract 100 Ft. 
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FIG: 4.44 Set Depth Shift -100 ft  

The current encoder depth will be automatically updated when the Shift current Encoder Depth 
also box is selected. This is the default when the depth shift is run from Acquisition. 
Note also that the shift may be made whilst logging; and that the encoder depth and log display will 
update accordingly. This facility may be used to apply a linear depth shift to log data, other than the 
current database. This can be achieved by using the Select Data button to bring up a file selection 
box. Ensure that the Shift current Encoder Depth also box is not selected, unless it is required to 
update the system depth. 

 

VIDEO: 4.2 Depth Shift 
4.4.13 Preview Up 
Allows viewing of the log on screen (Interactive Plot) or hardcopy without permanently recording data 
to disk. 
 
4.4.14 Preview Down 
Allows viewing of the log on screen (Interactive Plot) or hardcopy without permanently recording data 
to disk. 
 
4.4.15 Preview on Time 
Allows viewing of the log on screen (Interactive Plot) or hardcopy without permanently recording data 
to disk. 
 

In Preview mode, data is actually being recorded in a special database called 
Preview.db. When the last program attached to Preview.db is closed this 
database is automatically deleted. 
There is no way to recover Preview.db once it has deleted. 

 
 

 
VIDEO: 4.3 Log Up GR/CCL/TEMP 
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4.5 Edit 
4.5.1 Tool String 
The tool string editor will appear.  The correct serial number and placement for each tool should be 
verified.  Select save, depth offsets will be calculated and calibrations for the selected tool serial 
numbers will be loaded. 
Allows a tool string to be built from within the constraints of the selected service.  Tools of the correct 
model may be selected by serial number and placed in the required physical position in the tool 
string. A tool string diagram is presented and the screen and may also be included in the hardcopy 
output by including in the plot job. Once the tool string has been assembled, the sensor offsets are 
automatically calculated using information stored in a tools database. 
Note that a service will include one or more tools. The tools, which are included in a service, are 
defined in the services.ini file. Only those tools defined in the services.ini file may be entered into the 
tool string with the tool String Editor. 

 
FIG: 4.45 Select Tool String  

Select the required service and select Tool String from the Edit menu. The Tool String Editor will 
appear with the last saved tool string configuration. 
 
4.5.1.1 Remove Tools in the string 
To remove a tool from the string Mouse Right click on the tool section and select Remove. 

 
FIG: 4.46 Remove Tool  

Other way is with Remove button and select the tool(s) to be removed using the >>> button(s) at the 
left of the tool string diagram. Note that, in the diagram below, the >>> buttons are now positioned at 
the center point of tools rather than at tool joints as in the above diagram. 
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FIG: 4.47 Remove Tool  

4.5.1.2 Add Tools in the string 
To add tools to the string, click on the tool to be added and drag it into position in the tool string. A 
line on the drawing will indicate where the tool will be inserted. You can also click on any tool and 
drag to a new position in the string. To edit the properties of the tool, right click on the tool and select 
Properties to bring up the tool editor for that tool. 
Select the tool drag and drop in the tool string. 

 

FIG: 4.48 Add Tool  

Other option to Add is select the too with the mouse Left click, then Mouse Left Click over Add Button 
Once a tool has been selected the point at which it is to be inserted in the tool string is defined using 
the >>> buttons which appear to the left of the tool diagram. 
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FIG: 4.49 Add Tool  
 

4.5.1.3 Change Tool 
To change to another tool of the same type, right click on the tool and select Change to see a list of 
the serial numbers of available tools that can replace the one in the string. 
  

 

FIG: 4.50 Change Tool  

4.5.1.4 Tool Properties 
Mouse Right Click over the tool and select Properties 
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FIG: 4.51 Tool Properties 

When editing has been completed, the tool string information is saved using the Save button. At this 
point, the service will be reloaded as the current status; and other parameters of the tool string may 
have changed. 
Measure the tool from the Bottom to the Top and type the value  

 

FIG: 4.52 Tool Model Properties  
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FIG: 4.53 Tool Software Properties  

Measure the distance from the bottom of the Tool to the sensor and type the value in inches. 

 

FIG: 4.54 Edit Offset Sensor.  

Gaussian set as Gamma Ray default filter  

 

FIG: 4.55 Edit Sensor Filter.  

Gamma Ray Calibration type set Two point as default 
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FIG: 4.56 Edit Calibration Type. 

For statistical tools 45 second is a default value. 

 

FIG: 4.57 Set Calibration Time  

 

FIG: 4.58 Select Units  

 

FIG: 4.59 Select Verify  

4.5.1.5 Tool Diagram Properties 
The diagram section of the tool editor allows the used to select or create tool diagrams for the tool 
model. If no Name is entered, the tool will be represented in tool string diagrams as a rectangle with 
the length and diameter given in the Model Specific area. The browse button next to the name box 
can be used to select an existing Warrior tool diagram.  
The selected tool diagram will now appear in the diagram window.  
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FIG: 4.60 Select Tool Diagram  

The Zoom button can be toggled to change the display to see the complete width that will be 
displayed in a tool string diagram, although the length may not be to scale. 

 

FIG: 4.61 Select Zoom Tool Diagram  
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In the zoom mode, the red rectangle reflects the appropriate length and diameter specified for the 
tool. The user can now use the controls in the Move Diagram box to resize and configure the drawing 
as needed to shift the drawing left/right or up/down or to widen/narrow or lengthen/shorten the 
drawing. Ideally, the body of the tool should fit the red rectangle, with external components 
(centralizer springs, etc.) allowed to extend outside of the red rectangle.  
Within the red rectangle, there are four quadrants. The mouse can be used in each of these 
quadrants to configure the diagram in the same manner as the Move Diagram controls. By clicking 
the mouse in the top quadrant and dragging it up or down, the diagram will move up or down. 
Clicking and dragging up or down in the bottom quadrant will lengthen and shorten. Clicking and 
dragging to the left or right in the left quadrant will move the diagram left or right. The right quadrant 
will widen or narrow the diagram. 
 
4.1.5.6 Customizing Tool Diagrams 
If you want to create your own tool diagrams using a third party graphics package, the only 
requirement is that the output file format be either Windows Metafile (*.wmf) or Windows Enhanced 
Metafile ( *.emf ).  Once you have created the file, copy it to your warrior\format directory and rename 
it to ( *.wtd ) for Warrior Tool Diagram. 
In order for any diagram to line up when it is placed in a tool string, it needs to be modified by using 
the Tools Editor.  Select the diagram you want to edit from the Tools Editor and the image should 
appear on the right side of the window.  A red box will appear also which indicates the location where 
the image should appear in order for it to line up with another image of the same diameter.  It is 
important that the image be sized using the proper diameter.  If you have two devices that you want 
to use the same image for but they have different diameters, then you need to save two different tool 
diagrams, one for each diameter. 
To size the image, use the buttons to change the width and height as well as shift the image up/down 
and left/right.  You can also use the mouse to drag the image into position.  The mouse moves the 
image by clicking and dragging from the appropriate portion of the screen. 
Mouse click positions: 
Left of center  - drag image left and right 
Right of center  - drag image to change width 
Top 1/4 of image - drag image up and down 
Bottom 1/4 of image - drag image to change height 
It may be easier to use the mouse for coarse adjustments and then use the buttons to make fine 
adjustments. 
Some tools, such as centralizers, may extend outside the red box. 
When you click the save button, the image gets written to disk and then read back and redrawn to 
verify that the save was done properly. 
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FIG: 4.62 Move Left the Tool  

 

FIG: 4.63 Move Right the Tool   
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FIG: 4.64 Shrink the diameter of the Tool 

 
 
FIG: 4.65 Increase the diameter of the Tool  
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FIG: 4.66 Shrink the Length of the Tool 

 

FIG: 4.67 Increase the Length of the Tool 
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FIG: 4.68 Move up the Tool  

 

FIG: 4.69 Move Down the Tool. 
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FIG: 4.70 Browse Tool Diagram  

 

FIG: 4.71 Select Tool Diagram  

Once the diagram has be resized and configured as desired, the Save and Save As buttons can be 
used to save the diagram as a Warrior Tool Diagram. The Save button will replace the existing 
diagram that was called up. Be aware that if any other model of tool uses this diagram, the drawing 
will be changed for that model also. The Save As button will prompt you for a new file name. 
The Undo button, will undo any changes that have been made since the file was opened or since the 
last Save or Save As. 
 
4.5.1.7 Variable Length Items 
To change the length of a variable length item, right click on the item and select Length from the 
pulldown menu. 
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4.5.1.8 Options 
When clicking on the Options button, a number of options appear below the tool tree diagram. 
These include the sensor offsets, where to break diagrams of long tools and the scale factor of the 
diagrams. 
  
For long tools, select the Break item option and then enter a break length. You may have to toggle 
the Break item checkbox to update to a new break length. This will draw any tool that is longer than 
the break length with a break in the middle so you can fit more objects in a smaller area. 
 
Choose a different Scale Factor to display the diagram at a greater resolution. 
The Show offsets checkbox displays all the sensor names in the tool string and their offsets. 
 
4.5.1.9 Print 
Any tool diagram will print to fit on one page. When another scale factor than <auto> is selected, two 
print choices are available. You can print to fit on one page or you can print to scale. If you print to 
scale, the image may span multiple pages. 

 

FIG: 4.72 SAVE and Exit 

 

VIDEO: 4.4 Tool String 
 
4.5.2 Variables 
The Variables Editor is invoked from the Acquisition Edit menu or from Warrior shortcut folder, 
double-click the Utilities icon. The Utilities menu box will appear, Click on the Edit Variables in a 
Dataset button.  It is used to enter and edit zoned Parameters for use by the logging system. When 
first invoked it appears similar to the window shown Below. Displays the Variable (parameter) editor 
window, enabling depth dependent parameters associated with the selected service to be zoned and 
values to be set. 
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FIG: 4.73 Variables  

A file selection dialog box appears. Select the required database, followed by the log pass (dataset). 
The Variable Editor is displayed with the variables that were active during the logging session. 
In this case the well is shown as one zone from top to bottom. To define a new zone press the Zones 
Button and a window will appear as shown below. 

 

FIG: 4.74 Add Zones 
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FIG: 4.75 Set a New Zone 

Here boundaries may be inserted and their positions changed, e.g. inserting a new change at 
1000ft results in two zones, one from the top to 1000, and one from 1000 to the bottom. 
Note: if the variable editor is started from the acquisition module when logging, then by selecting the 
Pick from Log checkbox, the depth of zone changes can be selected by clicking on the appropriate 
depth on the interactive plot. 
 Here boundaries may be inserted and their positions changed, e.g. inserting a new change at 1000 ft 
Results in two zones, one from the top to 1000, and one from 1000 to the bottom. 

 

FIG: 4.76 Edit values and accept 

To change the value of the variable in a particular zone, TAB to or click on the variable and enter the 
New value. When all entries have been made Accept the changes and Close the editor. 
 

 

FIG: 4.77 Insert New Zone  
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FIG: 4.78 Undo Zone 

 

FIG: 4.79 Accept and Close 

 

 
VIDEO: 4.5 Variables 
 
 
4.5.3 Create a Variable in a Dataset 
In the Warrior shortcut folder, double-click the Utilities icon. The Utilities menu box will appear. Click on the 
Create Variables in a Dataset button. 
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FIG: 4.80  Create Variables in a Dataset 

 
 
A file selection dialog box appears. Select the required database, followed by the log pass (dataset). 
At this point a selection box is displayed allowing selection of the variable to be created in the log 
pass. Fig: Create Variables in a Dataset Double-click on the required variable name to create it in the 
pass variables. 
 

 
FIG: 4.81 New Variables  
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FIG: 4.82 Choice the Variable 
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FIG: 4.83 Current Pass List 
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4.5.4 Create waveform gate curves 
 

 
FIG: 4.84 Create waveform Gate Curves 

Select the Database 

 
FIG: 4.85 Gate Curves 

This option is used to generate the high and low gate curves for sonic tools (e.g. CBL and RBT). 
You are prompted to select a database and pass containing a sonic tool with waveform data. The 
high and low gate curves are then automatically generated and added to the pass. 
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When a CBL tool is in the database Warrior looks for the CBL3 and CBL5 waveform curves in the 
pass and generates CBL3LG (3ft low gate) and CBL3HG (3ft high gate) if the CBL3 curve is present, 
and the CBL5LG and CBL5HG if the CBL5 curve is in the database. 
These curves can be added to the Signature track as shown below in Fig:4.86 , and the low and high 
gate curves should straddle the first peak in the waveform. 
 

 
FIG: 4.86 Current pass List 
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FIG: 4.87 Plot Curves 
 

4.5.6 Sensors 
Brings up the Edit Sensor window. Once a service has been selected, the Edit Sensors window may 
be displayed and information concerning the individual sensors, associated with the particular 
service, may be edited. This information normally consists of the hardware source of the sensor 
(Device and Channel number), the depth offset of the sensor from tool zero reference, and the 
sampling rate. 
The information contained in Edit Sensors is defaulted to the current service and current tool string 
information. For example, sensor depth offsets are derived from the selected tool string and the 
information is contained in the tools database. The default sample rates and device channel 
assignments are derived from the services file. 
The default device and channel settings, and the default sample rates are contained in the 
services.ini file. The default depth offsets are derived from tool information contained in the tools.ini 
file. 
Although the information in Edit Sensors is normally derived automatically from the information 
contained within the system, it may sometimes be necessary to modify a setting. 



134 Warrior Software Version 7.0 Standard Cased Hole 

 
FIG: 4.88 Edit Sensors 

Select Sensors from the Edit menu. The Edit Sensors window appears as shown below. 
 

 

FIG: 4.89 Edit 

Highlight one or more sensors and select Edit, or double-click on a sensor item. The Edit Sensors 
dialog box will be displayed for editing as shown in Fig: 4.7.1. The acquisition device may be selected 
with the Device box. There are several acquisition devices supported within the Warrior system. Do 
not change this entry unless you know what you are doing. The channel of the device, from which the 



 

135 Warrior Software Version 7.0 Standard Cased Hole

sensor is to be read, is selected by editing the Channel box. Do not change this entry unless you 
know what you are doing. 
The number of samples per foot to be recorded is entered in the Rate box. The maximum sample 
rate for a sensor is generally limited to the maximum rate set for the particular acquisition device 
acquiring the data. This maximum rate is set in the services.ini file.  
The physical depth offset of the sensor from tool zero is entered in the Offset box. Note that the 
value to be entered in Offset is the physical depth offset, as the system automatically compensates 
for any lags introduced by filtering. 

 
The change made in Edit Sensors will remain in effect until the service is 
reloaded; when the sensor parameters are returned to their default values. 
Sensors should not be edited during logging. 

 

4.5.7 Calibrations 
Warrior allows editing of sensor calibrations. The Warrior system supports many types of calibrated 
tool response. The calibration parameters may be derived from manual entries, or from calibration 
procedures, performed by the system itself. Some calibration parameters can be edited from Edit/ 
Calibrations. 

 
FIG: 4.90 Calibrations 

Select Calibrations from the Edit menu, and double-click on the sensor to be edited. Alternatively, 
click once and select and Edit/Edit Selections. 
The tool type, serial number, calibration name and calibration type are displayed, but cannot be 
edited. The various calibration parameters can be edited and saved either permanently (with the 
Perm button) or temporarily (with the Temp button). See Fig: 4.91. 
 

Warrior stores calibrations internally in English units. When editing calibrations in 
this dialog, the reference values must always be entered in English units. 
Changes made and saved temporarily stay in effect until the service is reloaded, 

so when the calibration parameters are returned to their normal permanent values. 
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FIG: 4.91 Edit Calibrations 

4.5.8 Filters 
The Filters option displays filter settings and allows them to be edited. Four types of filter options are 
currently available in the Warrior system. 
 

 
FIG: 4.92 Filters 



 

137 Warrior Software Version 7.0 Standard Cased Hole

These are: 
SQUARE is a simple average of the sensor value over the filter interval selected. 
GAUSSIAN is a weighted average, where the weights, applied to each sample over the interval, take 
the form of a Gaussian distribution. The filter interval is in feet, when recording in depth, and in 
seconds, when recording in time. 
TRIANGLE is another weighted average that accentuates peaks similar to the Gaussian filter. The 
Triangle filter is more extreme than the Gaussian. 
USER is a user-defined filter, but is currently not implemented. 
Select Filters from the Edit menu, and double-click (or single-click and Edit/Edit Selections) on the 
sensor, whose filter is to be edited. 
 

 

FIG: 4.93 Edit Filters 

The tool type and current filter parameters are displayed for the sensor selected. Typing over the 
parameter, shown in the Interval box, may change the interval. The filter type can be changed by 
means of the radio buttons. 
Note that changes, made here, stay in effect until the service is reloaded, so when the filter 
parameters are returned to their default values. Default filter settings are contained in the tools file as 
part of the tool model information. Filters should not be edited whilst logging. 
 
4.5.9 Tool Configuration 
 

 
FIG: 4.94 Tool Configuration 
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4.5.9.1 STD Tool Configuration 
 

 

FIG: 4.95 Set Line Resistance 

4.5.9.2 CCL Control 
The CCL software produces 2 outputs: 
 
CCL Casing Collar Locator 
CCLRT Real Time Casing Collar Locator 
 
The real time output bypasses the normal sampling queues so that changes can be seen 
immediately. The CCL software incorporates a facility to effect a shift of the CCL curve, as is 
sometimes required when running perforating services. The collar log may also be filtered in such a 
way as to remove noise from the baseline of the curve while still allowing collar signals above a 
certain threshold to be displayed. 
When in Acquisition mode, and with a collar tool in the string, the CCL Control box may be displayed 
with Edit/Tool Configuration/CCL. 

 

FIG: 4.96 CCL Control 

4.5.9.3 Shift the CCL 
Bring up the CCL Control box as described above. 
Set the amount of shift required in the Step Size dialog. The value entered here should reflect the 
actual scale set for the log. For example, if the log is scaled at 1 volt per track and it is required to 
shift the curve 10 (small) divisions, enter a value of 0.1. 
Clicking the Left or Right buttons produces the shift and the cumulative amount of shift applied 
appears in the Current Total box. 
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4.5.9.4 Threshold (Filter the CCL) 
Invoke the CCL Control box and set the Threshold Enabled. Click on Setup and adjust the threshold 
settings as required. 
The Positive and Negative Thresholds are set in the same units as the collar log output curve. Any 
collar curve signal smaller in amplitude than the threshold settings will be suppressed to a value of 
zero. Any signal greater than the threshold levels will be recorded as its true value. 
 

 
FIG: 4.97 CCL Thresholds 

4.5.9.5 Clamp 
The Positive and Negative Clamps cut the signal at the set point value. Any collar curve signal bigger 
in amplitude than the clamp settings will be set to clamp value. 
 

 
FIG: 4.98 CCL Clamp Limits 
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4.5.9.6 Normalize the CCL Baseline 
Invoke the CCL Control box and set the Baseline Normalization Enabled. Click on Setup and adjust 
the cycle length (must be greater than 0) and the offset settings as required. 
The system will attempt to correct a baseline that is changing with time. 
 

 

FIG: 4.99 CCL Baseline Zeroing Setup 

Select Setup, and type in Cycle Length  2  left in Zero Current/Starting Offset. 
Click over OK 
Check on the Enable box, and Click on Setup, you find the new value in Current/Starting Offset 
 

 

FIG: 4.100 CCL Baseline Zeroing Setup 
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4.5.10 Device Configuration 
 

 
FIG: 4.101 Device Configuration 
 

4.5.10.1 DAMUPCI Configuration 

 

FIG: 4.84 DAMUPCI Setup 

 
Do not change any settings here, unless you know what you are doing. 
 

 
4.5.10.2 DSP Configuration 

 

FIG: 4.102 DSP Configuration  

4.5.10.3 SDSTIP and CBL1D Programmable Filters and Gain Controls 
Most line signals, other than low frequency CCL signals, are filtered and amplified through the 
CBL1D board of the Scientific Data Systems, Inc. Tool Interface Panel. There is a single input to the 
CBL1D Board from the ANASW board but it has three separate outputs, commonly referred to as 
Sync, Sonic, and AUX. Each of these outputs has separate gain controls and programmable variable 
filter controls. 
Each of the Sync, Sonic, and AUX output channels has a programmable attenuator that is controlled 
through the software by a slider bar in the panel controls. This is necessary to keep the signals from 
saturating during later stages of filtering and amplification. During normal operation, these are all that 
is necessary in a service to control the signal gains. 
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FIG: 4.103 Panel Controls 

Each of the three channels also has a variable filter that can be set or adjusted. It is not normally 
necessary to adjust these filters once a service has initially been set up on a logging unit. Access for  
adjustment of these filters is obtained through the Acquisition Software by selecting Edit -> Device 
Configuration -> SDSTIP. 
 

 

FIG: 4.104 Device Configuration 

 

FIG: 4.105 SDSTIP 
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Each of the output channels has it's own Gain, Q, Corner  or Center Frequency, and whether it has a 
Band Pass or High Pass output. In addition to this, the Sonic channel has a pre-filter to keep the 
initial input attenuator from saturating. This pre-filter is turned off with a 0 value and is normally 
turned on with a value of 8. 
The Sonic and Aux channels will normally be set to filter a pulse signal, so they will usually have a 
High Pass filter with as low a corner frequency as possible. The gain for these channels should be 
set so that the slider bar gain control has a good setting for the service at near mid-range. 
The Sonic channel will normally be looking at acoustic signals in the 20000 hertz range and should 
be selected as a Band Pass filter. 
The Q of the filters is related to the how much frequency change is needed to attenuate the signal by 
3DB. The larger the number, the less change from the Fc is needed to attenuate the signal. 
 
The following Internet link gives simple explanations of filters and their characteristics. 
http://en.wikipedia.org/wiki/Electronic_filter#Multipole_types 
 

The different hardware revisions of the CBL1D board require that the correct panel 
type be set in the Warrior Control Panel for the CBL1D board to respond to slider 
bar and filter settings. Revisions R1 through R4 will normally have a panel type   
that ends with the letter a (CPFA). As of this date, Revisions R5 and higher will 
have panel types that end with a B or C (CPFB – CPFC). 
 

 

VIDEO: 4.6 Edit 

4.6 Monitor 
Once a service has been selected, various data monitors are available to the operator as shown 
Below. 
 
 

 
FIG: 4.106 Monitor Sensors 

4.6.1 Sensors 
The sensors for the selected service are displayed along with the values of their current readings. 
The sensor monitor is used to monitor `raw' data. Select Monitor Sensors from the Edit menu. The 
Sensor Monitor will be displayed. The sensor monitor is updated at the refresh rate set in the Control 
module. 

http://en.wikipedia.org/wiki/Electronic_filter#Multipole_types
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FIG: 4.107 Sensors 

4.6.2 Outputs 
The outputs for the selected service are displayed along with the value of their current readings in 
engineering units.  
Select Monitor /Outputs from the menu. The Outputs monitor is displayed as shown in Fig: 4.108. 
When in a logging mode, e.g. Record Up, the readings are updated at each depth sample. When not 
in logging mode, the outputs are updated at the frequency set in the Control module. 
Sampler Queues 
Monitors the status of the internal Warrior sampler queues. 
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FIG: 4.108 Outputs 

4.6.3 Tools 
 

 
FIG: 4.109 Monitor Tools 
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FIG: 4.110 Monitor CS8SCBL 

4.6.4 Devices 
Displays the raw data readings of the selected device, channels, irrespective of whether particular 
channels are being used for the current service. 
 

 
FIG: 4.111 Monitor Devices 
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4.4.1 CYSTD  
 

 

FIG: 4.112 CYSTD Values 

4.6.5.1 DSP Monitor 

 

FIG: 4.113 SDSDSP 

The ErrCnt should have a constant value or Zero to get a good sync. 
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4.6.6 Hoistman’s Display 
 
The Hoistman's display can be loaded by clicking on Monitor / Hostman’s Display or the Hoist button 
in the Depth Control window. Activating the popup menu can configure the view and scales. Do this 
by right clicking on the display and selecting the required menu option. Sound alerts for various 
conditions can also be configured here if a suitable sound card and speaker are available. 
Note that in multi-monitor systems, the Hoistman's display can be positioned on a second monitor 
close to the winchman. 
 

 
FIG: 4.114 Monitor Hoistman’s Display  

 

FIG: 4.115 Hoistman’s Display 

Click Config. 
 

 

FIG: 4.116 Set up Depth Configuration 
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Right click over the gauge to select Gauge Properties 
 

 

FIG: 4.117 Set Gauge Properties 

 
 

VIDEO: 4.7 Monitor 
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5 Service Editor 
The purpose of the Services Editor is to aid in modifying current services, creating new services, and 
importing and exporting services from similar types of Warrior systems. To start the Service Editor, 
go to Warrior Utilities and click on the Edit Logging Service Details. 
 

We suggest that a backup of the Services.ini file be made before any service 
editing, so that existing service information may be recovered if mistakes are 
made while editing. Probably the easiest way to do this is to use the Configuration 
Backup/Restore utility and do a backup. 

 

5.1Edit logging services Details 

 
FIG: 5.1 Edit Logging Services Details 

Section

5 



 

151 Warrior Software Version 7.0 Standard Cased Hole

When the Service Editor window comes up, on the left side of the window are two service lists, 
labeled Active and Disabled. The active list of services will be displayed when a service is selected 
from Warrior Acquisition. The disabled list of services are included in the service.ini file but are not 
displayed in the acquisition service list. Normally there will be no services in the disabled list. 
When an active service is selected by clicking on it in the list, all of the service details are displayed in 
the Service Details panel on the right side of the window.  This information includes the default 
interactive plot for that service, the selected zero point (encoder depth reference for zero offset) for 
the service, a service title, if a title other than the service name is desired, and a choice whether the 
service should always use the master copy of the presentation or open the master and use it for 
editing as a private copy of the presentation in the database. There are also four lists that are labeled 
Devices, Controls, Sensors, and Tools. Each list contains specific details about the service.  
 

 
FIG: 5.2 Services Editor 

The Tools list contains all of the tool types that are available in the service. If a tool type is not listed 
in a particular service, than it is not possible to use that tool in that service. Tools may be listed but 
excluded. (Tools are normally excluded by removing them from the tool string using the tools string 
editor in Acquisition.) The STD tool type will normally be listed in every service since this includes 
sensors for depth, tension, line speed, tool voltage and current, etc. 
The Devices list contains acquisition devices that the system uses to acquire information. Depending 
upon the panel type, it may include a DAMU, DAMUPCI, DSP, SDSTIP, ASCTEL, and others. Each 
device is set with a default sample rate of the maximum number of samples per foot. Some of the 
devices also require additional information such as the DSP Script file, the type of ASCII telemetry, 
and what hardware gain controls that the service will provide.  
The Controls list contains settings for hardware devices within the interface panel. This includes 
items such as filter settings for various signal paths, I2C Initialization codes for setting various initial 
relays states, and software controlled tool voltage setting for that service. 
The Sensor list contains the sensors for the tool types that are available. Each sensor definition must 
have the device that it uses to acquire its information. The definition also should contain a device 
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channel number or a device channel name. If the device channel name is the same as the sensor, 
then that name is not required. The definition could also have a sample rate. If the rate is less than 
the device default sample rate, then the sensor data will be saved at the slower rate. If the rate is 
greater than the device default rate, then the sensor data will be saved the default rate of the device. 
If omitted, the sample rate will be at the device default sample rate. The sample rate can only be 
used if the channel is listed. (Sensor=Device, channel, rate). 
 

5.2 Editing an Existing Service 
The Service Editor can be used to modify settings in an existing service. To view the settings for a 
service, click on the service in the Active service list. The right side of the window will display the 
service information and settings for that service. 
The default presentation for a service can be selected from the Presentation drop down list. The list 
will include all PRS files that are in the Warrior\Format folder. The interactive plot presentation will 
display outputs from the sensor information at that are included in the presentation. 
If the box labeled Use private copy of presentation for all logs from this service is checked, then when 
the first pass of the service is started in a database, the default presentation is copied into the 
database as a private presentation. If any changes are made to the log format presentation, then 
those changes are made in the private copy of the presentation in the database. The changes are not 
made to the original presentation that is in the Warrior\Format folder.  
If the box is not checked, then the presentation is not copied into the database. Any changes that are 
made to the presentation from interactive plot are made to the original presentation file. If at a later 
date in time the file is viewed using interactive plot, then since the presentation is not part of the 
database, the current copy of the presentation (if it exists on the system) in the Warrior\ Format folder 
is used to display the presentation. If the presentation is not located in the Format folder, then no 
presentation will be displayed. Interactive Plot options would have to be used to select a presentation 
format for display. 
The Zero Point drop down list has a list of sensors in the service. Any of the sensors or the bottom of 
the tool string may be selected as the zero point. The zero point of a tool string has zero offset to the 
encoder depth reading. Scientific Data recommends that the bottom of the tool string be used as the 
zero point in most logging services. In perforating services, the CCL is set as the encoder depth. In 
services that a normally run in a time drive mode at a set depth, such as a Noise Log or Freepoint 
Log, the particular sensor of interest should be set as the zero point to be able to position the sensor 
as desired. 
In acquisition, when a service has been selected, that service name will normally be displayed. By 
typing in the Title field of the Service Editor, the service displayed may be different than the service 
name. 
 

 
FIG: 5.3 Service 
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FIG: 5.4 Service different Name 
 

 

5.3 Adding and Removing Tool Types 
Tool types can be added or deleted from a service. To delete a tool type from a service, click on the 
tool type in the Tools drop down list. Then either push the <Delete> key on the keyboard or on the 
Services Editor menu bar, click on Delete. A window will come up to confirm that you wish to delete 
the selected tool type. 

 
Tool names, Model names, and Serial names can contain a maximum of 39 
characters and cannot have any spaces. 
 

 

 
FIG: 5.5 Tool Delete 

 It is recommended that the sensors that the tool type produced be deleted in a similar manner at the 
same time, although if the sensors are left in, the service should still work. 
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To add a tool type to a service, on the Menu Bar click on Add -> Tool. An Add tool dialog box will 
come up with the next available tool number. Enter the tool type in the dialog box. Only the tool type 
needs to be entered, a specific serial number for that tool type is not required at this time (i.e. 
Tool6=GR not Tool6=GR; Serial=1234). When the service is next used, it will call up the first 
available serial number of that tool type that it can find. It is necessary for the tool type to exist in the 
tools.ini file. If the tool type does not exist, then when the service is called up from acquisition, you 
will get an error message and it will not work. 

 
 

 
FIG: 5.6 Add Tool 
 

 

FIG: 5.7 Edit Tool 

 
When a tool is added to a service, sensor(s) will normally have to be added also. The software 
modules that the tool type uses will have specific sensors, as shown in the Tool Editor. Each of these 
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sensors will have to be added to the service or when the service is called up from acquisition you will 
get an error message and the service will not work. 
To add a sensor to a service, click on Add -> Sensor on the Service Editor menu bar. The Add 
Sensor dialog window will come up. Enter the sensor mnemonic, followed by an equals sign “=”, then 
the Device that the sensor acquires data from, then the channel of that device, and the sample rate 
for storing the sensor data (Sensor=Device,Channel,Rate). The Device must be listed in the Devices 
drop down list. The device and channel that a sensor will use is hardware dependent, and in the case 
of the DSP also script dependent. It is beyond the scope of this document to explain further. For 
more help contact Scientific Data Systems, Inc. 
 
 

 
FIG: 5.8 Add Sensor 

 

 

FIG: 5.9 Type New sensor 

Devices and Controls may be added and removed in a similar manner. Again they are hardware 
dependent and beyond the scope of this document. For more information contact Scientific Data 
Systems, Inc. 
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Any line in the Devices, Controls, Sensors, and Tools list may be edited. To edit a line, click on the 
desired line, then on the menu bar click Edit. Double clicking on a line will also invoke the edit 
command. 
 

5.4 Add Surface Sensors 
 
ADD Wellhead Pressure Sensor on AUX4 
 
Select Utilities 

 
 
FIG: 5.10 Utilities 

Select Edit Logging tools Details 
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FIG: 5.11 EDIT Logging services Details 

 

Select the service to add the new WHP sensor 
 

 
FIG: 5.12 Select the Service 

Add new Sensor 
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FIG: 5.13 Sensors 
 
Type WHP1 = BASE, 11 
 
 
 

 
FIG: 5.14 Add sensors  
 
Select OK and Save the service 
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FIG: 5.15 Set sensors  
 
Open the service 
 

 
 
FIG: 5.16 Monitor sensors  
Select Monitor/Sensors 
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FIG: 5.17 Sensors Value 
Sensor Value in Volts 
 
Select Monitor/Outputs 
 

 
 

FIG: 5.18 Output Value 
 
WHP1  (psi.)  
 
Select Action/Calibration Wellhead Pressure 1 
 



 

161 Warrior Software Version 7.0 Standard Cased Hole

 
FIG: 5.19 Action/Calibrate 
 
Set the low and high value to calibrate the WHP1 Sensor. 
 

 
 

FIG: 5.20 Set Calibrations Points 
 
On side DB25 Add 250 Ohms 

AUX4 - 
Auxiliary 
Inputs 

 DB25 
Pin 
OUT 

 USB44
 

SOFTWARE
CHANNEL 
 

 4-20 mA AUX4-2 CC13-2 BASE,15 
 4-20 mA AUX4-3 CC13-3 BASE,14 
 4-20 mA AUX4-4 CC13-4 BASE,13 
 4-20 mA AUX4-5 CC13-5 BASE,12 
 4-20 mA AUX4-6 CC13-6 BASE,11 
 Frequency AUX4-9 CC13-34 CTR3 
 Frequency AUX4-10 CC13-35 CTR2 
  AUX4-21 CC1-19 +5V 
  AUX4-22 CC1-20 GND 
  AUX4-23 CC1-21 -15V 
  AUX4-24 CC1-22 +15V 
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Add Resistors (250 ohms) to convert the current loop 4-20mA to Voltage 1 -5 volts 
 

 
FIG: 5.21 AUX 4 Hardware Connections 
 
WPH1 and WPH2 Connectors for ASW-Board version 11 or latest 
 
 

CONNECTORS 
INPUTS 

ANSW 
 

SOFTWARE
CHANNEL 
 

SIGNALS 
 

WHP1-A CC7-11 BASE,9 -(4-20MA) Input Negative 
WHP1-B CC7-10  +(4-20MA) Input Positive 
WHP1-C      
WHP1-D CC7-8  WHP1 +15V Excitation 
WHP1-E CC7-20  Ground 
       
WHP2-A CC7-14 BASE,10 -(4-20MA) Input Negative 
WHP2-B CC7-13  +(4-20MA) Input Positive 
WHP2-C      
WHP2-D CC7-18  WHP2 +15V Excitation 
WHP2-E CC7-42  Ground 
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5.5 Modifying the Service List 
 
The Service Editor can be used to modify the appearance of the service list in a variety of ways. 
Services can be renamed, have where they appear in the list changed, be temporarily disabled so 
that the do not appear as a selection in Acquisition, or can be completely removed from the 
services.ini file. 
To change the name of a Service in the active service list, click on the service. (Only services that are 
in the active service list can be renamed.) Then on the menu bar, click on Service -> Rename. A 
dialog box will come up with a place to type in the new name for the service. When the OK button is 
pressed, the service name will be changed.  
 

 
FIG: 5.22 Rename 

 

 

FIG: 5.23 Enter new Service Name 
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Moving a service can change the order of the services in the active service list. To move a service, 
click on the service in the list. Then on the menu bar, click on Service -> Move.  A dialog box will ask 
you to choose a location in the current list to move the service to. The service will then be moved to 
the selected location in the list with other services between the original location and the new location 
moving up or down in the list as needed. 
 

 
FIG: 5.24 Move Service 
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FIG: 5.25 Move service to 

A service can be disabled so that it does not appear in the Acquisition service selection list. It will  
remain in the services.ini file so that it can be reactivated or enabled at some later date. To disable a 
service, click on the service in the Active list. Then on the menu bar, click on Service -> Disable.  
The service will immediately be moved to the disabled list. Any service that is in the Disabled list can 
be put back into the Active list. Click on the service in the Disabled list. Then on the menu bar, click 
on Service -> Enable. The service will immediately be moved from the Disabled service list to the 
bottom of the Active service list. 
A service from either the Active service list or the Disabled service list may be removed. Once 
removed it will no longer be available. When the service has been selected and Service -> Remove 
clicked on from the menu bar, a confirmation window will come up. If you click No, the removal 
process will be terminated. If you click Yes, the service will be removed from the list. 
 

 
FIG: 5.26 Service Delete 
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5.6 Adding Services 
The two most common ways to add new services are to copy an existing service that you have or to 
import a service from an exported service list or a different services.ini file. Copying a service is 
normally used if you have an existing service that works, but you need an additional service that is 
very similar, such as having a Gamma Ray service that detects positive pulses and needing a 
Gamma Ray service that detects negative pulses. Importing a service is normally used to add a 
service that has tool types that the present service list does not support. 
 
 
5.6.1 Copying a Service 
To copy an existing service, click on the service that you wish to copy that is in the active service list. 
Then on the menu bar, click on Service -> Copy. A dialog box will come up requesting you to enter a 
name for the new service that you are about to create. The name cannot be the same as any name 
that currently appears in either the existing active or disabled service list. When you click on the OK 
button, the new service will be added to the bottom of the active service list. Be aware that the 
service information that is displayed on the right side of the Service Editor window is the information 
for the original service that was selected. If changes are to be made to the new service that was 
created, you must first click on that service in the active service list.  
 
 

 
FIG: 5.27 Copy service 
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FIG: 5.28 Type new Service name 
 

5.7 Importing Services 
Services can be imported from a variety of sources. They can come from the Warrior cased hole (CH 
USB 70.WSV) service list or from services that have been exported from other warrior systems. With 
a little effort, they can be imported from service.ini files. Be aware that for an imported service to 
work, the tool types that the service calls out must exist in the tools.ini file. The Tool Editor can be 
used for restoring calibrations for tool types to the tools.ini file. 
 
 

 
FIG: 5.29 Import service 
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FIG: 5.30 Select warrior service file 

To import a service, on the menu bar, click on Service -> Import. A browse window will come up 
looking for a WSV file in the Warrior\Config folder. If you select the CH USB 70.WSV file, it contains 
nearly 90 logging and utility test services that support most types of cased hole equipment.  Click on 
one or more of the services that are listed. Each of the services chosen will be added to the bottom of 
the active service list. 
Services that have been exported from the service editor are normally saved with the WSV extension 
but have been given a file name at the time they are exported. These files may be read in the same 
manner. You may have to use the look in drop down list to locate the correct drive (and folder) to 
read them. 
Services from files other that WSV files may be imported. Use the look in drop down list to change to 
the drive and folder that the file is located in. then type the complete name of the file in the file name 
box. If it is a valid warrior service type file, a list of the services that are available will come up as 
before. 
 
 

5.8 Exporting Service 
The purpose of exporting a service or multiple services is so that they can be imported and used on a 
similar system that uses the same type of devices. To export a service, on the menu bar, click on 
Service -> Export.  A list of the existing active services is then brought up. Click on one or more 
services in the list and each will become highlighted. When the OK button is clicked, a Browse for 
Warrior Service File window will come up. Enter a file name in the file name box. When the Save 
button is clicked, the file will be saved in the folder indicated in the Save in: drop down list. 
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FIG: 5.31 Export 

 

 

FIG: 5.32 Export service 
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FIG: 5.33 Save new service 
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6 Tools Editor 
When tools are ran in a service (by editing the tool string for a particular service), they are chosen by 
type and serial number. Each serial number is assigned to a specific tool model. Each model of tool 
has the information that the Warrior System Software uses to process the data that it receives. This 
includes such general information as type of software, sensor offsets, sensor filtering, and tool length 
(which effects the offsets of other sensors in the tool string). 
By using the tool editor, the pertinent information for each model can be easily changed, new serial 
numbers created, and new models created. The Tool Editor can be accessed from the Utilities 
Program in the Warrior Software Group Menu. 
 

We suggest that a backup of the tools.ini file be made before any editing is done 
so that information may be recovered if mistakes are made.  
Tool names, Model names, and Serial names can contain a maximum of 39 
characters and cannot have any spaces. 

 
 

 
 

FIG: 6.1 Select edit logging Tool Details 
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6.1 Editing an Existing Model or Serial Number 
To edit the information for a particular tool, click the + beside the Tools icon. This will show all of the 
different types of tools that are currently available. Click on the + beside the type of tool that you want 
to edit. This will show all of the serial numbers that are available for that tool type. Next click either a 
Serial Number shown or click on the Model drop down list and choose a model type.  Any information 
that is changed will be changed for all serial numbers that are of that model type. 
The measuring Units used for all dimensions, sensor offsets, and filters can be selected to be 
entered as either English (In, Lbs.) or Metric (Cm, Kg).   
The Change Tool button can be used to convert a tool to a non-serialized item such as a centralizer 
or weight bar. Extreme caution should be used with this button. This is to be used to convert files 
from older versions of Warrior, to Warrior version 7.0. If a tool is converted to a tool with no serial 
number, the software type and all sensor information is removed.  
Tool information is entered by selecting the Model, Software, and Diagram tabs at the top of the 
window. Each tabbed sheet will contain specific information about the tool model. 
 

 
 

FIG: 6.2 Tools Editor 

Under Model Specific information, a brief description of the model can be given (This description will 
appear in the tool string diagram and in some calibration reports). The Length of the tool should be 
measured from tool joint to tool joint. This should be an accurate measurement in that it can effect 
sensor measurements for other tools in the string. The Diameter of the tool can affect services that 
do flowrate calculations. The combined string length, string weight, and maximum tool diameter will 
be presented on any tool string diagrams that are printed. Voltage and Current entries are not used 
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by the Warrior software at this time, but can be used as a reference for the user. A check box is 
supplied for tools that may have a variable length that can be set at run time such as guns or sinker 
bars.  
The Software modules to be used for logging can also be selected. The selection of the software 
modules will determine what sensors and filtered outputs will be available for that model of tool. 
Other model specific parameters may be available depending on the software modules selected. The 
Warrior 7.0 Software now provides for selection of multiple software modules in the same tool model 
although the sensors for each module are configured separately. 
 
 

 
 

FIG: 6.3 Select Tool Model 

Sensor Offsets should be measured from the lower makeup joint of the tool. Note that the sensor 
measurement for a source / detector or transmitter / receiver pair is half way between the two points. 
To change a sensor offset, double click on the sensor to bring up the edit box. Enter the appropriate 
measurements and click save. 
 

 
FIG: 6.4 Set Offset 
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To change a filter setting, double click on the appropriate sensor. There is a drop down list for the 
different filter types. Square filtering should be used with sensors that would change slowly, such as 
Tool Voltage, while Gaussian filters should be used with statistical sensors, such as Gamma Ray. 
The longer the Filter Length, the more pronounced an effect the filtering would have.  
 

 

 
 

FIG: 6.5 Select the Filter Type and Filter Length 

For some software modules, a specific Cal Report (Calibration Presentation) can be selected for the 
tool model. 
The Model area contains information that is again determined by the software type. The Serial 
Number section is used for limited types of tools at this time.  
 
 

6.2 Tool Diagrams 
The diagram section of the tool editor allows the used to select or create tool diagrams for the tool 
model. If no Name is entered, the tool will be represented in tool string diagrams as a rectangle with 
the length and diameter given in the Model Specific area. The browse button next to the name box 
can be used to select an existing Warrior tool diagram. The selected tool diagram will now appear in 
the diagram window. The Zoom button can be toggled to change the display to see the complete 
width that will be displayed in a tool string diagram, although the length may not be to scale.  
 

 

FIG: 6.6 Select Diagram 



176 Warrior Software Version 7.0 Standard Cased Hole 

If you want to create your own tool diagrams using a third party graphics package, the only 
requirement is that the output file format be either Windows Metafile (*.wmf) or Windows Enhanced 
Metafile (*.emf).  Once you have created the file, copy it to your warrior\format directory and rename 
it to (*.wtd) for Warrior Tool Diagram. 
In order for any diagram to line up when it is placed in a tool string, it needs to be modified by using 
the Tools Editor.  Select the diagram you want to edit from the Tools Editor and the image should 
appear on the right side of the window.  A red box will appear also which indicates the location where 
the image should appear in order for it to line up with another image of the same diameter.  It is 
important that the image be sized using the proper diameter.  If you have two devices that you want 
to use the same image for but they have different diameters, then you need to save two different tool 
diagrams, one for each diameter. 
To size the image, use the buttons to change the width and height as well as shift the image up/down 
and left/right.  You can also use the mouse to drag the image into position.  The mouse moves the 
image by clicking and dragging from the appropriate portion of the screen. 
Some tools, such as centralizers, may extend outside the red box. 
When you click the save button, the image gets written to disk and then read back and redrawn to 
verify that the save was done properly. 
 
 

 

FIG: 6.7 Select Zoom 

In the zoom mode, the red rectangle reflects the appropriate length and diameter specified for the 
tool. The user can now use the controls in the Move Diagram box to resize and configure the drawing 
as needed to shift the drawing left/right or up/down or to widen/narrow or lengthen/shorten the 
drawing. Ideally, the body of the tool should fit the red rectangle, with external components 
(centralizer springs, etc.) allowed to extend outside of the red rectangle.  
Within the red rectangle, there are four quadrants. The mouse can be used in each of these 
quadrants to configure the diagram in the same manner as the Move Diagram controls. By clicking 
the mouse in the top quadrant and dragging it up or down, the diagram will move up or down. 
Clicking and dragging up or down in the bottom quadrant will lengthen and shorten. Clicking and 
dragging to the left or right in the left quadrant will move the diagram left or right. The right quadrant 
will widen or narrow the diagram. 
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Once the diagram has be resized and configured as desired, the Save and Save As buttons can be 
used to save the diagram as a Warrior Tool Diagram. The Save button will replace the existing 
diagram that was called up. Be aware that if any other model of tool uses this diagram, the drawing 
will be changed for that model also. The Save As button will prompt you for a new file name. 
The Undo button, will undo any changes that have been made since the file was opened or since the 
last Save or Save As. 
The user can create his own tool diagrams by pasting from the Windows Clipboard. Using a drawing 
application, you create the initial tool drawing. Then copy it onto the windows clipboard (Edit – Copy, 
right mouse click –Copy, etc). When the paste button in the tool editor is clicked, you are first 
prompted to enter or select a file name for the drawing. When the file name is saved, what ever is on 
the Windows Clipboard is displayed in the diagram window. The drawing should then be reconfigured 
as described above to fit into the red rectangle. Finally it should be saved again after the 
reconfiguration. 
 

6.3 Creating a New Serial number for an existing tool model  
If you have existing tools and wish to create a new serial number, find and select the serial number of 
an existing tool in the tool drop down list. Then on the menu bar, click Create - Tool. The New Tool 
dialog window will then come up and show the selected tool type, model type, the software module 
being used, and a list of existing serial numbers for that tool type. Enter a new serial number in the 
New Serial Number box and click OK. The new tool will use the same physical dimensions, sensor 
offsets, filters, and tool diagram as the model of the selected tool. 
 

 
 

FIG: 6.8 Select Tool  
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FIG: 6.9 Type the new serial number 

 

VIDEO: 6.1 Creating a New Serial number for an existing tool model  

 

6.4 Creating a new tool type or a new model for existing tool 
To create a new tool, click on the Create selection in the Tools Editor menu bar. To create a new tool 
type, click the Tool drop down list and click on the first item in the list, <new tool type>. 
You will then be prompted to enter a new tool type.  - Be aware that any new tool that you have 
created can only be used if a Service in Services.INI lists that tool type as one of its available tools. 
If you are creating a new tool type, the Create New Model Type box will appear.  If you are going to 
create a new model for an existing tool type, once the tool type has been selected from the Tool drop 
down list, from the Model drop down list, select the first item in the list, <new model type>. 
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FIG: 6.10 Select new tool type and create a new tool type  

 

FIG: 6.11 Create new model type 
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FIG: 6.12 Select GR software for GR tool. 

You will then be prompted to enter a new model type. For any new model type, the software 
module(s) to be used must be selected from the software drop down list and then click the ADD>> 
button.  

 
Tool names, Model names, and Serial names can contain a maximum of 39 
characters and cannot have any spaces. 
 

Continue selecting and adding software modules as need to include all of the sensors in the tool.  A 
list of sensor for the different software modules is included At The of this section (Software Module 
Description).  
The last step is to enter a New Serial Number. An Existing Serial Number drop down list is provided 
so that duplicate serial numbers are not entered. 
Certain software modules will allow you to also create a new sensor. Note that all boxes of the 
Sensor Details section must have data entered for the created sensor to work properly. The Sensor 
is the name that you wish to have as an output; it cannot be a duplicate of any sensor that would be 
in the same string of tools. The Units can be chosen and printed on the log insert and calibration 
reports. The Description can be printed on calibration reports that include this sensor.  
Once the basic sensor has be created and saved, reciprocal and/or differential outputs can also be 
created for the same sensor. 
 

 
VIDEO: 6.2 Creating a new tool type or a new model for existing tool type 
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FIG: 6.13 Create a new Sensor 

6.5 Creating a Tool 
As an example, we will go through the steps necessary to create a new tool sting for a Gearhart 
COSMOS GR/N tool. One version of the Gearhart COSMOS Gr/N tool is a single tool that is 
approximately 7 ¼ feet long and 1 11/16” in diameter, has a total weight of 25 pounds, and has three 
sensors, gamma ray, collar locator, and neutron. There are two different ways that we can create this 
tool. We can break it up into three separate tool types, with each type having its own software 
module. Or, we can make one tool type that has three software modules. We will do an example of 
each way. 
 

 
 

FIG: 6.14 Tool string editor 
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First we will do the three separate tool types with each type having its own software module. 
The first tool we will create is the neutron. Open the tool editor and click Create – Tool. Scroll down 
the Tool drop down list to NEU (if not in the list, click <New Tool Type> and enter NEU). Now enter a 
Model name by clicking on the model drop down list and clicking <New Model Type> and entering 
COSMOS (if not already in the list). Use the Software drop down list to pick NEU software, and it to.  
Enter a unique serial number (CMOS001) in the New Serial Number box. You should now have a 
tool created but with no information for it as shown. 
 

 
FIG: 6.14 Select Tools Editor 

 
FIG: 6.15 Select Model 

Now we will have to enter all of the information for our COSMOS model of neutron tool.  The length 
from the bottom of the source to the ccl joint is 48”, the weight we will guess at 15 pounds, the 
diameter is 1 11/16” or 1.68”. 
The neutron detector is 14” from the bottom of the tool, but if we measure from halfway between the 
neutron source and the neutron detector to the bottom of the tool we measure 8”, so our NEU offset 
is 8”. We will set the filter type to use a Gaussian 3 foot filter to start with. 
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FIG: 6.16 Set Sensor, Filter, and Model values 

We will use a two-point calibration, and use 60-second averaging for the calibration time. We will plot 
our output as Neutron API counts (NAPI), and not have a porosity curve. Our completed neutron tool 
should look as shown. 
We will use the length and diameter rectangle for a tool diagram Therefore we will not have to do 
anything on the Diagram page. 
We now need to create our next tool – the CCL.  Click on Create – Tool. Chose CCL from the Tool 
list. Check the Model list for COSMOS. If COSMOS is not in the list, chose new model type and enter 
COSMOS. Software should be set to CCL and a New Serial Number will need to be entered 
(CMOS001).  

 
FIG: 6.17 Set New Tool 
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FIG: 6.18 Set Model values 

The length from the lower case to the upper case is 11 inches, we will guess at a weight of 5 pounds, 
and the diameter is 1.68 inches. The center of the CCL coils is 5 1/2” from the bottom case. We do 
not want to use any filtering with a CCL, so we set the filter to NONE and the length to 0.00 Feet. We 
will not set any of the model specific parameters. 

 

 
FIG: 6.19 Set Sensor, Filter, and Model values  

Finally, we need to create our Gamma Ray tool. Once again click on Create in the menu bar. Then 
choose Tool. Scroll down the Tool drop down list to GR (if not in the list, click on <New Tool 
Type>and enter GR). Now click on the Model drop down list and click on <New Model Type>, and 
enter COSMOS. Click on the Software drop down list and choose GR software. Enter a serial 
number (CMOS001) in the New Serial Number box. 
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FIG: 6.20 Set New Tool  

 

 
FIG: 6.21 Set Model values  

We now need to enter our model specific information. A tool description can be entered if desired. 
The length from where the upper case makes up to the top of the tool is 27 3/8”.  We will guess at a 
weight of 10 pounds. The diameter is 1 11/16”. 
The center of the gamma detector on this particular model is 16.68 inches up from the CCL. We want 
to use a Gaussian filter of 5-foot length, since this is a GM type detector. We will set this up with a 
two-point calibration with a gain and offset and use 60-second averaging. The output will be plotted a 
Gamma Ray API counts (GAPI). We will not do field verification. Our completed Gamma tool should 
look as shown below. 
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FIG: 6.22 Set Sensor, Filter, and Model values . 

This completes all three sections for the tool being set up as separate tool types. To use this tool in a 
service, the service must include each of the separate sections in the list of available tool types (GR, 
CCL, and NEU). When the service is selected from acquisition and the tool string editor comes up, 
the proper configuration must be set up (GR on top, CCL in the middle, and Neutron on bottom), and 
the serial number for each section should be selected. 
Now we will go through the same process of creating the tool, but will use a single tool type with all 
three software modules. 
Click on Create, then Tool.  Click on the tool drop down list and choose new tool type. Enter 
GR_N_CCL for the tool type. For the new model type, enter COSMOS. Choose and add the GR, 
CCL, and NEU software modules. Enter CMOS001 for a serial number. 
 

 
FIG: 6.23 Set New Tool 
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FIG: 6.24 Set Model values  

The overall tool length is 77 3/8”, weighs 35 lbs, and is 1 11/16” OD. This information is entered into 
the Model page. We measure the CCL from the bottom of the tool to the middle of the coils as 44.5 
inches. The Gamma Ray detector is 66 5/8” from the bottom of the tool. And the Neutron measure 
point is 8 inches as in the previous example. For each software type, we will have to set up the 
appropriate sensors using these offsets. We will do the CCL module first. The offset is 44.5 inches.  
The rest is set the same as the previous example. We do not want to use any filtering with a CCL, so 
we set the filter to NONE and the length to 0.00 Feet. We will not set any of the model specific 
parameters. 

 
FIG: 6.25 Set Sensor, Filter, and Model values 

To edit the Gamma Ray sensor, click on the GR software in the list. The sensor offset is 66.68 
inches. The rest of the information is the same as the previous example. Gaussian 5-foot filter, two 
point calibration, 60-second calibration averaging, output as Gamma Ray API counts (GAPI), and no 
field verification. 
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FIG: 6.26 Set Sensor, Filter, and Model values  

 

FIG: 6.27 Set Sensor, Filter, and Model values  

Select NEU software to edit the neutron senor settings. Our NEU offset is 8”, Gaussian 3 foot filter, 
two point calibration, 60-second averaging, and output as Neutron API counts (NAPI), and not have a 
porosity curve.  

6.6 Deleting Tool Entries 
Options are available under the Delete selection of the menu bar. Sensors, Serial Numbers, Models, 
or Tool types can be deleted. Be careful in deleting information. Read the whole confirmation box 
closely. You would not want to lose a whole tool type when you meant to delete only a serial number. 
If a tool model has a user-defined sensor, click on the Sensor listed in the software specific area, 
and then clicking on Delete -> Sensor will remove that sensor from the tool model. 
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FIG: 6.28 Select sensor option to Delete  

If a specific tool serial number has been selected from the tool list, then clicking on Delete -> Serial 
Number will remove that specific tool serial number from the tools.ini file. 
If a tool type has been selected from the tool list, then clicking on Delete -> Model will provide a drop 
down list of models of that type of tool. Selecting a specific model and clicking OK will allow you to 
delete that model only if no serial numbers are currently set to that model type. 
If a tool type has been selected from the tool list, then clicking on Delete -> Tool Type will delete all 
information for that type of tool. This includes all serial numbers and model information for any tools 
that are of that tool type. 

 
FIG: 6.28 Delete model for GR  

6.7 Saving Calibrations 
Calibrations can be saved to disk or restored. This is meant to be an aid in the transfer of calibrations 
between different units or to transfer tool type and model information from one unit to another. 

 
FIG: 6.29 Select Tool 
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FIG: 6.30 Select GR Calibration 

On the menu bar click on Calibrations, then click Save. Only one tool type can be selected, but as 
many serial numbers as desired can be placed into the file. The model information for each selected 
serial number can also be included. The file is given a WCF extension but is a mini tools.ini file if the 
model information has been included. When the Save button is clicked, the save dialog box is 
brought up.  The default is file name is the tool type and it is saved into the Warrior\Config directory. 
You can change the drive, folder, and name of the file. 

 
FIG: 6.31 Save GR calibration 

If you select an existing WCF file, you will be given the option of appending to the file or overwriting 
the file. 

 
FIG: 6.32 Save GR 

To restore calibrations, click on Calibrations on the menu bar, then click Restore. When the dialog 
box appears, select the saved file from the appropriate drive and directory. Then select as many 
serial numbers as desired to be restored. 
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FIG: 6.33 Software Module Descriptions 
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FIG: 6.34 Software Module Descriptions  



 

193 Warrior Software Version 7.0 Standard Cased Hole

 

FIG: 6.35 Software Module Descriptions  
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7 Heading Editor 
The Heading Editor allows the log heading information to be added to a blank heading of pre-existing 
format. Both Cased Hole and Open Hole style headers can be produced using Warrior. 
It may be started from its icon in the Warrior shortcut folder, the Acquisition module under the Edit 
menu, Interactive Plot, or the Presentation Plot module. From the Heading Editor File menu, either a 
new header can be created or a pre-existing heading may be selected for editing. In addition, the 
actual format of the header may be selected from the predefined formats in the system by using 
Select Format.... Once a heading has been selected, particular fields may be chosen for editing by 
using the TAB key, or by pointing with the mouse to move around the heading. When a field has 
been selected, a dialog box appears, and the appropriate information may be entered. 
Headings are saved within, and retrieved from, Warrior well log databases. Headings, generated 
during a logging operation, are normally saved alongside the log data for that job.  
To create a new heading and store it a specific database The Heading allows the log heading 
information to be added to a blank heading of pre-existing format. It may be started from its icon in 
the Warrior program group,  

 

FIG: 7.1 Heading  
Run Heading Editor from Warrior group. A blank heading appears 
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FIG: 7.2 Blank Heading  

From the Heading Editor File menu, either a new or a pre-existing heading may be selected for 
editing. In addition the actual format of the header may be selected from those available within the 
system by using Select Format.  

 

FIG: 7.3 Select Heading from Edit 

Run Heading from the Acquisition or recalculation module under the Edit Heading 
Select Reopen existing database,  
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FIG: 7.4 Select Dataset  
 

Select the database from the file selection box and then select the heading to be changed. 

 

FIG: 7.5 Open Data Base 

 

FIG: 7.6 Set Data Base run/pass 
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FIG: 7.7 Set Heading 

Once a heading has been selected, particular fields may be chosen for editing by using the TAB key, 
or by pointing with the mouse to move around the heading. When a field has been selected, a dialog 
box appears, and the appropriate information may be entered. 
Headings are saved within and retrieved from Warrior well log databases. Headings generated during 
a logging operation are normally saved alongside the log data for that job. 
For fields with only a single line the appearance is as shown above. The description of the field 
appears above the dialog entry (e.g. Field), and the cursor is positioned for immediate text entry. 
When the text entry is complete hit Enter to move to the next field. Alternatively move to the OK 
button by using the TAB key or the mouse, and then hit Enter or click with the mouse. 
 

 

FIG: 7.8 Type Well name 

Fields which have multiple lines are completed using a slightly different dialog box as shown below 

 

FIG: 7.9 Type Log Name 

In this case the box appears with the OK button active. Use the TAB key or the mouse to move to the 
text entry box and enter the required text. 

 
Do not hit Enter within the text entry box unless you wish to move to a new line 
within the current field, as for example, if multiple lines of text were to be entered 
in the Comments field. 

When the text is complete use the TAB or mouse to move to the OK button and exit the dialog box as 
normal. 
To save the modified heading under a different name use Save As from the File menu and enter a 
new name for the heading. The original heading will remain in the system under the original name. 
Use Save to save the modified heading under the original name. 
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FIG: 7.10 Heading  

 

FIG: 7.11 Type the new Heading name File 

7.1 Swap Logo 
The logo accepts formats  * .lgo, .*.wmf, *.emf, *.bmb, *.jpg. The file must be in Warrior\Config. 
It should have the ratio 3 by 6 to keep the proportionality with respect the original one.  
To select, or remove the Logo just Mouse Left click on Logo Box. 
 

 

FIG: 7.12 Edit Logo 
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FIG: 7.13 Select the new Logo 

 

FIG: 7.14 Fill out Heading  

 

VIDEO: 7.1 Heading 
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7.2 Heading File Creation 
Warrior creates headings by reading a text file that has a .hdg extension. There are several different 
heading styles that are supplied with the Warrior software (stdcased, stdopen, and greytest). The 
purpose of this document is to supply the information need for the user to write his own .hdg text 
files. 
--------------------------- 
The first two lines of the file define the physical size of the heading in inches as plotted. The width of 
the heading is the length of the plot from the plotter. The height is the width of the heading, with 8.25 
being the standard API log width. 
Width 10 
Height 8.25 
--------------------------- 
You must define panels to make the separate sections of the heading. Pictures, text, text edit fields, 
and panels may then be placed in the panels. Two pairs of x define the location of a panel and y 
coordinates as a percentage (0 to 100) of the current panel. The contents of the panel are enclosed 
in curly brackets. 
Panel x1, y1, x2, y2 
{ 
Panel Contents 
} 
--------------------------- 
The Border statement defines the thickness of the panel edge. The larger the integer N, the thicker 
the border will become. 
Border N 
--------------------------- 
The Font statement defines the font size of any text that is printed within a panel. The larger the 
integer N, the larger the font size. 
Font N 
Both the Font and the Border statement control the effects of the panel that they are in and all panels 
that are included in that panel, unless the included panel contains Font or Border statements, which 
are then used for that panel and any panels that it might include. 
--------------------------- 
A picture may be placed within a panel. The location of the picture is defined by two sets of x and y 
coordinates as a percentage of the current panel. The name of the picture must be declared under 
the heading section of Warrior.ini and must be a captured Windows metafile (MFGRAB.exe is the 
normal method of acquiring this file). 
Picture x1, y1, x2, y2 {NAME} 
--------------------------- 
Text may be placed within a panel. The location of the text is defined by two sets of x and y 
coordinates as a percentage of the current panel. Previous font statements determine the size of the 
text. The orientation of the text is determined by a four-letter code - OTHV. The O is the orientation of 
the text, the T is the type of text, the H is the horizontal centering, and the V is the vertical centering. 
Text strings that are larger than the area specified may have unpredictable results. The might be 
truncated or extend outside of the defined area. Multiple line text will automatically wrap at a word 
boundary if the text exceeds the area length. 
O H - Horizontal Text 
V - Vertical Text 
T S - Single line of Text 
M - Multiple line of text 
H L - Left justify for horizontal text, Bottom justify for vertical text 
C – Center Text horizontally 
V T - Top justify for horizontal text, Left justify for vertical text 
C – Center Text vertically 
TextOTHV x1, y1, x2, y2 "TEXT" 
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A text edit field may be placed within a panel. The location of the field is defined by two sets of x and 
y coordinates as a percentage of the current panel. Previous font statements determine the size of 
the text. The orientation of the text is determined by the same four-letter code - OTHV that is used 
with text. A hint name for the field is enclosed within curly brackets. A hint line is then added 
(normally at the end of the file) that will give a hint text to the user when he clicks on the field. 
 
EditOTHV 0,0,100,100 {Hint Name} 
hint "Hint Text" {Hint Name} 

7.3 Headings LOG Banners File Creations 
Warrior creates headings by reading a text file that has a .hdg extension. There are several different 
heading styles that are supplied with the Warrior software (stdcased, stdopen, and greytest). The 
purpose of this document is to supply the information need for the user to write or modify his .hdg text 
files. 
In addition to heading files (*.HDG), well log banners (*.WLB) use the same form of text file but when 
printed, the orientation is rotated 90 degrees. Thus a heading has a height of 8.25 inches and a 
banner has a width of 8.25 inches. 
Pipe Tally Tables (*.WRF) also use a similar format with some variance. The mode of entering user 
information is quite different. 
--------------------------- 
The first two lines of the file define the physical size of the heading in inches as plotted. The width of 
the heading is the length of the plot from the plotter. The height is the width of the heading, with 8.25 
being the standard API log width. 
Width 10 
Height 8.25 
--------------------------- 
You must define panels to make the separate sections of the heading. Pictures, text, text edit fields, 
and panels may then be placed in the panels. The location of a panel is defined by two pairs of x and 
y coordinates as a percentage (0 to 100) of the current panel. The contents of the panel are enclosed 
in curly brackets. 
Panel x1, y1, x2, y2 
{ 
Panel Contents 
} 
--------------------------- 
The Border statement defines the thickness of the panel edge. The larger the integer N, the thicker 
the border will become. If N is 0, then there will be no border. The maximum thickness is 10. 
Border N 
--------------------------- 
The Font statement defines the font size of any text that is printed within a panel. 
The larger the integer N, the larger the font size will become. The font range is from 1 to 6. 
Font N 
--------------------------- 
The FontFace statement defines the font style of any text that is printed with that size font on any text 
that is printed after the FontFace statement. The font style can be any True Type font that is included 
in C:\Windows\Fonts. 
FontfaceN “style” 
Both the Font and the Border statement control the effects of the panel that they are in and all panels 
that are included in that panel, unless the included panel contains 
Font or Border statements. These statements are then used for that panel and any panels that it 
might include. 
--------------------------- 
A picture may be placed within a panel. The location of the picture is defined by two sets of x and y 
coordinates as a percentage of the current panel. The name of the picture must be declared under 
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the heading section of Warrior.ini and must be a captured Windows metafile (MFGRAB.exe is the 
normal method of acquiring this file). 
Picture x1, y1, x2, y2 {NAME} 
--------------------------- 
Text may be placed within a panel. The location of the text is defined by two sets of x and y 
coordinates as a percentage of the current panel. Previous font statements determine the size of the 
text. The orientation of the text is determined by a four-letter code - OTHV. The O is the orientation of 
the text, the T is the type of text, the H is the horizontal centering, and the V is the vertical centering. 
Text strings that are larger than the area specified may have unpredictable results. The might be 
truncated or extend outside of the defined area. Multiple line text will automatically wrap at a word 
boundary if the text exceeds the area length. 
 
O H - Horizontal Text 
V - Vertical Text 
T S - Single line of Text 
M - Multiple line of text 
H L - Left justify for horizontal text, Bottom justify for vertical text 
C – Center Text horizontally 
V T - Top justify for horizontal text, Left justify for vertical text 
C – Center Text vertically 
TextOTHV x1, y1, x2, y2 "TEXT" 
--------------------------- 
A text edit field may be placed within a panel. The location of the field is defined by two sets of x and 
y coordinates as a percentage of the current panel. Previous font statements determine the size of 
the text. The orientation of the text is determined by the same four-letter code - OTHV that is used 
with text. A hint name for the field is enclosed within curly brackets. A hint line is then added 
(normally at the end of the file) that will give a hint text to the user when he clicks on the field. 
EditOTHV 0,0,100,100 {Hint Name} 
hint "Hint Text" {Hint Name} 
--------------------------- 
Comments may be placed anywhere in the file. Comments normally have // as the first two printable 
characters on a line. 
--------------------------- 
Width 10 
Height 8.25 
Panel x1, y1, x2, y2 {Panel Contents} 
Border N 
Font N 
FontfaceN “style” 
Picture x1, y1, x2, y2 {NAME} 
TextOTHV x1, y1, x2, y2 "TEXT" 
EditOTHV 0,0,100,100 {Hint Name} 
hint "Hint Text" {Hint Name} 
Comments 
The above examples are the only commands that are in *.HDG and *.WLB files for headings and well 
log banners. 
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7.4 Pipe Tally Tables 
Pipe Tally Tables have a few additional commands and the mode that Edit text commands gets their 
data is different. The edit text fields are pre-defined rather than defined by the Hint Command and 
are filled from editing the heading information of the pipe tally table, editing the grading of the 
settings, and from processing the log. The predefined fields are as follows: 
 
{CONAME} – Company Name from Edit – Heading Information 
{WELLNAME} – Well Name from Edit – Heading Information 
{FLDNAME} – Field Name from Edit – Heading Information 
{COUNTY} – County from Edit – Heading Information 
{STATE} – State from Edit – Heading Information 
{DATE} – Date from Edit – Heading Information 
{COMMENT} – Comments from Edit – Heading Information 
{RANGE1} through {RANGE6} – Maximum of six grading ranges from editing 
Settings - Grading 
{SYMBOL1} through {SYMBOL6} – Maximum of six grading ranges from 
editing Settings – Grading 
{GRADECNT1} through {GRADECNT6} – Count of the number of joints of 
that grading acquired from Scan Minimum Wall Log 
{RWBC_LVAL} – Bar Chart Left Value from RWBC_LEFT of Warrior.ini 
{RWVC_RVAL} – Bar Chart Right Value from RWBC_RIGHT of Warrior.ini 
{RWUNIT} – Units of curve from Scan Minimum Wall Log 
{NOX} – Number of Joint X from Scan Minimum Wall Log 
{DEPX} – Top Depth of Joint X from Scan Minimum Wall Log 
{LENX} – Length of Joint X from Scan Minimum Wall Log 
{RWX} – Remaining Wall of Joint X from Scan Minimum Wall Log 
{PLXX} – Percentage Loss of Joint X from Scan Minimum Wall Log 
{PLFX} – Percentage Left of Joint X (100-PLXX) 
{RWBCX} – Remaining Wall Bar Code of Joint X for Bar Charts 
{GRX} – Grade Symbol of Joint X from Range and Symbols above and scan 
There are three addition command that are used to create *.WRF pipe tally tables. 
 
They are as follows: 
 
Repcount N 
This line must be in the first 512 characters of the WRF file (normally place just after the Width and 
Height commands). It is a count of the number of joints to be shown on each sheet as the file is 
printed. 
 
barchart x1,y1,x2,y2 {RWCBZ} 
Charts bar code for Joint Z on RWBC_left to RWBC_right Scale 
 
editHSCCB 0,0,100,100 {GRZ} 
Prints Grade symbol for Joint Z horizontal centered both vertically and horizontally on a colored 
background. The color of the background is defined in Warrior.ini [Heading] section. 
BkColorMap=grade1,{color1},grade2,{color2}, etc. 
Where grade {x} is the symbol for a grade and color {x} is R, G, B set 
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8 Format Editor 
The Format Editor allows the creation and editing of the log presentation or format files. The output of 
the format editor are files of the type *.prs which are subsequently used to control all aspects of the 
log format. The Format Editor may be started in three different ways: From its icon in the Warrior 
group box, when started from the Warrior program group the Format Editor window appears as 
shown below, i.e. with no presentation available for edit  

 
FIG: 8.1 Select Format Editor 

The Format Editor may be started from its icon in Warrior shortcut folder, from the Edit menu of the 
Acquisition or Recalculation modules, from the File menu of the Presentation Plot module, or from 
the Action menu of Interactive Plot. In addition, double-clicking in the scales area of the Interactive 
Plot window will also start the Format Editor. 
When started from Warrior shortcut folder or from Presentation Plot, the Format Editor window 
appears as shown below, i.e. with no presentation available for edit. If started from the Acquisition, 
Recalculation or Interactive Plot modules, the log format currently being used will be presented. 
Displays a file selection window showing all the presentation files, currently available, within the 
system. The operator can select the presentation file to be edited. Note that all presentation files are 
to be found in the \warrior\format directory and have a prs extension. 

Section

8 
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FIG: 8.2 Select Format 

 

FIG: 8.3 Open Format 

From the Acquisition or Recalculation modules select Edit menu (Master Log Format) the log format 
currently being used will be presented 
 

 
FIG: 8.4 Select Master Log Format 
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FIG: 8.5 Edit Format 

From interactive plot select Action\Screen Plot menu. In addition double-clicking in the scales area of the 
interactive plot window will also start the Format Editor. 

 

FIG: 8.6 Interactive Plot 
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FIG: 8.7 Select Action/Screen Plot 

 

FIG: 8.8 Double Click over the header  

 

FIG: 8.9 Edit Presentation 
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8.1 File 

 

FIG: 8.10 File option 

8.1.1 Select Dataset 
Select Dataset from Database for specifically Log pass 

8.1.2 Import ASCII Files 
See Section 12.3.1 Read ASCII data into Warrior 

8.1.3 Export to LAS 
See section 12.1.1 Export to LAS Format. 

8.2 Options 
Allows selection of various presentation options as shown below. 
 

 

FIG: 8.11 Options 
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Start and Stop depths can be selected or the full range of the database can be selected using the 
Maximize button. 
Alternative presentation files may be selected using the Browse button, which brings up a standard 
file selection box. Warrior log format information is contained in individual files with a prs extension. 
These files are created or edited using the Log Format Editor program. 
Note that a selection can be made to Use a private copy of presentation with this log. This 
embeds the current presentation file in the database so that the database can be archived complete 
with its presentation or sent to other Warrior systems without having to remember to send the 
presentation file along with it. Also, if the presentation is embedded and it is subsequently edited from 
Interactive Plot, the edit will only take place on the embedded copy, not on the original file. English 
or Metric depth units may be selected, or Time can be used as a reference. The log may be plotted 
Up or Down. The log data units may be selected as English or Metric, or you may define a hybrid 
system. The User Defined units setup is done from with the Control Panel. Whenever a parameter 
in the Options window is changed, the current log screen plot(s) will be redrawn with the new option. 
 

When an option is changed, ALL interactive plots are redrawn. This can be a 
heavy load on the computer if a large number of CBL-VDL plots are currently on 
the screen and with a slow machine it may look as though the system has halted. 

 

Select the depth to Start/Stop to Plot the LOG 

Select presentation from the Warrior\Format (directory). 

Select Vertical Scale by default is 1:240 (5” = 100’) or (1’ = 240 ‘) 

8.3 Edit 
8.3.1 Log Format 
Provides rapid access to the Log Format Editor. When the Format Editor is invoked from Interactive 
Plot, changing the log format and saving it causes the active screen plots to be replotted with the new 
format. Note that many screen plots may be overlaid on each other at any one time. If a large number 
a plots are present, a noticeable delay will occur while all are replotted. 
 

 

FIG: 8.12 Log Format 

8.3.1.1 File 
The Format Editor allows the creation and editing of the log presentation or format files. The outputs 
of the format editor are files of the type (*.prs), which are subsequently used to control all aspects of 
the log format. 
The Format Editor may be started from its icon in Warrior shortcut folder, from the Edit menu of the 
Acquisition or Recalculation modules, from the File menu of the Presentation Plot module, or from 
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the Action menu of Interactive Plot. In addition, double-clicking in the scales area of the Interactive 
Plot window will also start the Format Editor. 
When started from Warrior shortcut folder or from Presentation Plot, the Format Editor window 
appears as shown below, i.e. with no presentation available for edit. If started from the Acquisition, 
Recalculation or Interactive Plot modules, the log format currently being used will be presented. 
 

 

FIG: 8.13 File 

8.3.1.1.1 New 
If a log format is currently selected for editing, New clears the editor for a new log format. 
 
8.3.1.1.2 Open 
Displays a file selection window showing all the presentation files, currently available, within the 
system. The operator can select the presentation file to be edited. Note that all presentation files are 
to be found in the \warrior\format directory and have a (*.prs) extension. 
 
8.3.2 Layout 
Allows selection of the log grid layout from a selection, supported within the logging system. 
The Warrior system is delivered with most standard layouts included. If you require a grid layout that 
is not available within layouts select Edit Layout to construct your own. 
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FIG: 8.14 Layout options 
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FIG: 8.15 Layout Editor 

8.3.3.1 OPEN 
Select Database for Format presentations. 

 

FIG: 8.16 Select Presentation 
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Select Object / Add Data or click the Add button. 
 

 

FIG: 8.17 Object 

 

FIG: 8.18 Select Curve 
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8.3.3.2 Data source 
Define the Data Source. Select the DB Item by using the Quick Pick list button or by typing the 
item name directly into the DB Item field. 
 

 
FIG: 8.19 Select Curve 

Not all database item names are available from the Browse button. In a given service, use 
Monitor/Outputs to see all curves, or Edit/Variables to see all variables. 
Define the data item as a Variable or a Data (curves, waveforms, etc.), using the radio buttons so 
marked. 
 
8.3.3.3 Position 
 

 
FIG: 8.20 Set Position 

Define the track, where the curve is to be presented, by typing the track number directly into the 
Track # box or by using the arrow buttons. The track numbers are indicated in the power section of 
the main Format Editor window. 
Define the Left value and Right value of the curve. 
 
8.3.3.4 Presentation Type 
Define the Presentation Type. Depending on the Presentation Type chosen, the right hand side of 
the Define Data Item window, or Style section, will present different options. 
 
8.3.2.4.1 Curve 
Define color (for color graphics devices only). If required, select Wrap. Causes infinite left and right 
backup curves to be presented. 
Selecting wrap causes backup traces to be generated, however the backup scales are not labeled, 
nor is there any control over the trace thickness or coding. Adding another curve with the same 
output name, but with different scales, etc., allows complete control of the attributes of the backup 
curve(s). 
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FIG: 8.21 Set Presentation Type 

If required, select Label. Allows the standard database mnemonic in the log scales header to be 
replaced by a text string. For example, GR may be replaced by Gamma Ray. Enter the text string in 
the Label field. 
If the curve is to be presented on a logarithmic scale, select Logarithmic. 
Select the required curve thickness and curve coding. 
Click the OK button. 
 
8.3.2.4.2 Tabular 
 

 
FIG: 8.22 Tabular Style 

Define the position of the tabular number with the track, previously selected, as Left, Right or 
Middle. Define the required decimal point display. 
Define the depth interval at which the tabular number is to be printed, i.e. every xx ft. 
Note that the numerical depth, displayed in the depth column, is a tabular depth curve, and its 
presentation may therefore be modified in the same manner as any other curve. 
Enter the required label for the log scales header in the Label field. 
Click the OK button. 
 
8.3.2.4.3 Variable Density 
In the Style section, set the VDL Black Level and the VDL White Level parameters. These 
parameters set the level at which the (acoustic) waveform will appear as black or white on the log 
output. The normal range of the digitizer is plus and minus 5 volts. Therefore, with the levels set at 
25% as shown below, any signal above 1.25 volts will appear black, and any below minus 1.25 volts 
will appear as white. The number of levels of gray, defined by the color map, is set evenly between 
these two limits. 
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FIG: 8.23 VDL Style 

Enter the required label for the log scales header in the Label as field. 
Enter the name of the required Color Map in the Color Map field. The color map controls the number 
and appearance of gray shadings or colors used in the VDL presentation. Various color maps may be 
defined the in the Warrior.ini configuration file. 
Click the OK button. 
 
8.3.2.4.4 Signature 
In the Style section, set the Signature Height and Interval parameters. The Signature Height sets the 
vertical (or y-axis) size of the waveform in inches of paper. As mentioned previously, the range of the 
digitizer is 10 volts peak to peak; therefore the Signature Height parameter normally corresponds to this 
range of raw waveform signal. The Interval parameter defines how often the waveform is printed on the 
output in feet or meters 

 
FIG: 8.24 Signature Style 

In the Style section, set the Signature Height and Interval parameters. The Signature Height sets 
the vertical (or y-axis) size of the waveform in inches of paper. As mentioned previously, the range of 
the digitizer is 10 volts peak to peak; therefore the Signature Height parameter normally corresponds 
to this range of raw waveform signal. The Interval parameter defines how often the waveform is 
printed on the output in feet or meters. 
Choose: 
No Shade or Shade Pos. or Shade Neg. 
Select Normalize and/or Logarithmic, if required. Normalize amplifies the maximum peak to peak 
reading of each waveform to the maximum set by the Signature Height parameter. Logarithmic 
displays the waveform on a logarithmic vertical scale. 
Enter the required label for the log scales header in the Label field. 
Click the OK button. 
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8.3.2.4.5 Pattern Strip 
Pattern Strip is a curve presentation, similar in appearance to a VDL, except that it has only one 
value at a given depth. For example, a Gamma Ray curve might be represented as a narrow track, 
where high values of gamma ray were shown as black and low values as white, with intermediate 
values shown as varying shades of gray. 
 

 
FIG: 8.25 Pattern Strip 

Select Label in Scale Type if a user defined Label is to be used. 
Enter the desired curve label in the Label field. 
Define the Color Map in the same way as a VDL presentation. 
Click the OK button. 
 
8.3.3.5 Add Shading 
 

 
FIG: 8.26 Add Shading 
Click on Object/Add Shading. A dialog box appears as shown below. 
In the Left Boundary section, enter the name of the curve, with which the shading is associated. 
If it is desired for the left boundary of the shading to follow the curve, select Follow Curve. If it is 
desired for the left boundary of the shading to follow a constant value, select Constant and enter 
value of the constant in the units of the associated curve. In the Right Boundary section, repeat the 
steps above. Select the required shading pattern by clicking on the pattern itself, and select the color 
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by choosing from the list in Foreground. If you wish the grid to show through the shading, click on 
See Through. 

 
FIG: 8.27 Shading 

To see more patterns, left-click and hold the mouse on a pattern, then move the 
mouse to the right or left. The patterns will then scroll, showing more of them. 
Click the OK button. 

 
8.3.3.5.1 Change & Remove Shading 
Click on Object/Select Data or Shading. A list of the objects is presented. 
 

 
FIG: 8.28 Select Data or Shading 

 
 
FIG: 8.29 Chose an Item 
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Double-click on the object to be changed, the window disappears, and then click on the Change 
button. The shading setup window appears as before, allowing changes to be made. 
A shading object may be similarly removed by clicking the Remove button, once the object has been 
selected. 
 

 
FIG: 8.30 Remove & Change Shading 

Currently, there is no possibility to identify which curve is selected when a curve 
is presented more than once (e.g. multiple curves with different scales). In a 
CBL, for example, if AMP3 is resented twice on the log, then AMP3 will appear 
twice in the list of plot objects. The only way of distinguishing them is by trial and 

error, or that, when curves are added by the format editor, they appear at the bottom of the object list. 
So if AMP3 (scale 0 to 100) was added first, it will appear above AMP3 (scale 0 to 10) in the object 
list. Of course, when looking at an existing log format, this method cannot be used to distinguish 
them. 

 
FIG: 8.31 Show Shading 

Show the shading in the header ON/OFF 
 
8.3.3.6 Enable Curves For Zone Scaling 
Occasionally it is required to alter the plotted scales of a curve in different zones. This can be 
achieved by selecting the Zonable Scales checkbox when defining a data item. 
Select the curve that requires zone scales by highlighting it in the format editor and clicking the 
Change button. 
Select the Zonable Scales option and the ZSC Name textbox appears in the bottom right hand 
corner. The default variable name can be overridden by entering a name in the ZSC Name box; in 
this case "GAMM" has been entered as an example. 
Selecting the Zonable Scales option creates two new special types of variables in the dataset, in this 
case L_GAMM and R_GAMM. These can be zoned during Interactive Plot by selecting the Zoned 
Scale Changes option in the Edit menu: 
Add a new Zone by clicking the Zones button and enter the depth at the change. 
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Multiple curves from the same DB item can have separate ZSC controls, e.g. when a main GR and a 
backup GR curve is available. Leave the ZSC Name blank for the main curve, but enter GRBU for 
the backup curve. This will still show two curves plotting from the DB item GR, but the ZSC editor will 
present L_GR, R_GR, L_GRBU and R_GRBU controls. 
Note: a curve may be turned off over an interval by selecting its right and left scales to be equal over 
the desired zone. 

 

VIDEO: 8.1 Master Log Format 

8.3.3.7 Minute Marks 
 

 

FIG: 8.32 Setup MINMK 

Add MINMK curve and set the presentation. 
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FIG: 8.33 Edit MINMK 

In Utilities select Edit services Details and Edit Sensor 
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FIG: 8.34 Plot MINMK 

 

8.3.4 Color Maps 
In Warrior, there is a section labeled [Color Maps]. Color maps that are to be selected from the format 
editor are sequentially numbered under this heading. 
Under each plotting device (including the SCREEN) the colors or shading for that device will need to 
be defined or that map will not print for that device. 
For monochrome maps, the shading for a device is defined by the number of shades N, followed by 
N numbers with ranges from 0 to 255. 0 will be all black and 255 will be white. Grayscales=5, 0, 
64,128,192,255 
For color maps, the shading for a device is defined by the number of colors N, followed by N groups 
of three numbers. Each group of three numbers {R,G,B} are intensities of red, green, and blue. 
These numbers also must be in the range of 0 to 255. 
Colors01=5,{0,0,255},{1,228,254},{2,253,97},{115,253,2},(255,255,0}. 
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FIG: 8.35 Color Map 

 

VIDEO: 8.2 Color Maps 

8.4Action 
8.4.1 Screen Plot 
See section 9 
 
8.4.2 Hardcopy 
See section 9 

 

FIG: 8.36 Action 
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8.5 Tools 

 

FIG: 8.37 Tools 

8.5.1 Depth Shift a Curve    
  
See section 12.4.2 

8.5.2 Depth Shift Whole Pass 
See section 12.4.1 

8.5.3 Run TVD/Merge Program 
See section 11.3 

8.5.4 Create an Alias 
See section 12.5.1 

8.5.5 Run Auto Merge Utility 
See section 12.5.2 

 

8.6 Pause/ Unpause 

 

FIG: 8.38 Pause/Unpause 
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8.7 Annotations 
Allow you to place annotations, curve labels and graphical objects on the log. 
 

 

FIG: 8.39 Annotations 

Scroll the log to the area where annotations are required and select Annotate from the Action menu. 
Note that annotations may be placed on the log even whilst logging. Simply 'Pause' the scrolling log, 
scroll back to the area where the annotations are to be inserted, place the required annotations and 
'Unpause' to return to the current logging depth. 
 

 

FIG: 8.40 Annotate 
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8.8 Log Banner 
Ensure that the pass, to which the banner is to be attached, is selected in the active plot window. 
Select Edit/Log Banner, and if required a database and dataset. 
Clicking on the File menu and clicking the Select can select the format of the Log Banner Format… 
option. There are a number of Log Banner formats (*.Wlb) to choose from. Select the most 
appropriate format and the edit the details by clicking on relevant areas within the window. 

 

FIG: 8.41 Log Annotations  

 

 

VIDEO: 8.3 Annotations 

 

 

 



 

227 Warrior Software Version 7.0 Standard Cased Hole

 

 

 

8.9 Well Sketch 
 

 

FIG: 8.42 EDIT\Well Sketch 
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Run Interactive Plot and select the dataset to accompany the well sketch. Click Edit/Well Sketch and 
the window, shown below, appears. 
 

 

 

 

FIG: 8.43 EDIT \ Well Sketch 

To add a new well object, select the object you wish to insert from the toolbar. A dialog window 
opens where the selected object’s properties are defined. 
 

 

FIG: 8.44   Tubing Setup 

Attachable' objects should be inserted first. Once these objects are added a list of 'attachable' objects 
is generated. Additional items can be added at this stage. 
To edit or delete a well object, double-click on the object or press <Ctrl> and click to select more than 
one item. Right click opens the popup menu where the edit or delete options are available. 
Selecting the area between the column headings and dragging to resize can change column widths. 
Columns can be sorted by clicking on the column heading. 
Nipples & Packers, etc. can be added at a single depth, however if a well object appears at various 
intervals enter the depths and range in the Depth Interval(s) textbox, e.g. 0.00-200. 
Continue adding objects until all required objects are entered, then save the well sketch by clicking 
File/Save or Save As…. 
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FIG: 8.45   Well Object Editor 

8.9.1 Depth Intervals 
The following are examples of valid depth intervals: 
A semicolon or a space separates each depth interval. Top and bottom depths of one depth interval 
must be separated by a dash. 
 
8.9.2 Annotations 
You can automatically annotate your well object by typing in the annotation here. If the annotation is 
moved to a different position, it becomes a normal log annotation and will no longer show up here. 
 
8.9.3 Vertical Position 
The position of the well object is defined as a offset percentage from the left and right hand sides of 
the track. Values less than 0 and or greater than 100 will draw part of the object outside of its 
assigned track. A scale of -100 to 0 will place the object entirely outside of its assigned track at a 
width equal to the assigned track. 
 
8.9.4 Width 
The objects in the diagram will be drawn proportionally to each other. If a size is entered, then the  
left and right vertical position will be calculated to draw that object centered in the diagram. If the left 
and right scales are changed, the size will reflect the change. 
 
8.9.5 Inflation Factor 
The width * Inflation factor will be the actual size of the object drawn on the diagram. If the width is 
changed, the inflation factor is set back to 1 (100%). 
 
8.9.6 Attaching Objects 
If a bridge plug object is attached to a casing object, then the bridge plug scales and size will be fixed 
to the scales and size of the casing object. If the casing size and/or scales are changed, the bridge 
plug settings will reflect that change. 
 
8.9.7 User Defined Metafiles 
Any metafile can be used as a well object by placing the metafile in the 'Warrior\Format' directory with 
an extension of 'wwd'. The new object will be displayed on the toolbar with the same name as the file 
without the extension. 
 
8.9.8 Metafile Properties 
Metafiles can be displayed as either Fixed or Stretched. The fixed mode can display the graphic in its 
original proportions using three different methods. Center will center the object about the center of 
the interval. Top will start drawing the object at the top of the interval. Bottom will draw the object so 
the bottom of the object will be at the bottom of the interval. The stretched mode will stretch or 
compress the graphic to fit within the depth interval. 
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In order for the well sketch to appear on the log, open the Log Format Editor and Add a database 
item, called wellobj, to the log format. 
Click the Graphic Strip radio button and select the track where the well sketch is to be presented. 
In our example the result is as shown in Fig: 8.44 
 

 

FIG: 8.46 Plot LOG  

 

VIDEO: 8.3 Well Sketch Editor 
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9 Interactive Plot  
The Interactive Plot program is a program module that may be started by other Warrior programs, 
such as Acquisition or Recalculation. It may also be used independently to generate log plots on the 
screen or to the hardcopy device(s). It is also used for adding individual banners (inserts) and 
annotations (e.g. curve labels) to a log pass. Note that multiple copies of Interactive Plot may be 
running at the same time, such that the system may be plotting dataset A to the screen, dataset B to 
one hardcopy device and dataset C to a second hardcopy device. 
Double-click the Interactive Plot icon in the Warrior shortcut folder or select Action/Screen Plot in 
Warrior Logging System 

 
FIG: 9.1 Interactive Plot 

 
 
 
 
 

9.1 File  
Select Dataset 
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FIG: 9.2 Select Action/Screen Plot 

9.1.1 Select Dataset 
Select Dataset from Database for specifically Log pass 
Selection of the database and dataset containing the data to be plotted. A standard Windows file 
selection box appears, see Figure 9.3 The required database is selected by double-clicking the 
selection, or highlighting it and clicking OK. 

 

 
FIG: 9.3 Select Data Base 

9.1.2 Import ASCII Files 
See Section 12.3.1 Read ASCII data into Warrior 

9.1.3 Export to LAS 
See section 12.1.1 Export to LAS Format 

From interactive plot select Action->Screen Plot menu. In addition double-clicking in the scales area 
of the interactive plot window will also start the Format Editor. 

 

FIG: 9.4 Select Action/Screen Plot 
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FIG: 9.5 Double Click over the header  

 

FIG: 9.6 Edit Presentation 
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9.2 Options 
Allows selection of various presentation options as shown below. 
Edit / Log Format… 
Provides rapid access to the Log Format Editor. When the Format Editor is invoked from Interactive 
Plot, changing the log format and saving it causes the active screen plots to be repotted with the new 
format. Note that many screen plots may be overlaid on each other at any one time. If a large number 
plots are present, a noticeable delay will occur while all are repotted. 

 

FIG: 9.7 Options 

Start and Stop depths can be selected or the full range of the database can be selected using the 
Maximize button. 
Alternative presentation files may be selected using the Browse button, which brings up a standard 
file selection box. Warrior log format information is contained in individual files with a prs extension. 
These files are created or edited using the Log Format Editor program. 
Note that a selection can be made to Use a private copy of presentation with this log. This 
embeds the current presentation file in the database so that the database can be archived complete 
with its presentation or sent to other Warrior systems without having to remember to send the 
presentation file along with it. Also, if the presentation is embedded and it is subsequently edited from 
Interactive Plot, the edit will only take place on the embedded copy, not on the original file. English 
or Metric depth units may be selected, or Time can be used as a reference. The log may be plotted 
Up or Down. The log data units may be selected as English or Metric, or you may define a hybrid 
system. The User Defined units setup is done from with the Control Panel. Whenever a parameter 
in the Options window is changed, the current log screen plot(s) will be redrawn with the new option. 
 

When an option is changed, ALL interactive plots are redrawn. This can be a 
heavy load on the computer if a large number of CBL-VDL plots are currently on 
the screen and with a slow machine it may look as though the system has halted! 
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Select the depth to Start/Stop to Plot the LOG 

Select presentation from the Warrior\Format (directory). 

Select Vertical Scale by default is 1:240 (5” = 100’) or (1’ = 240 ‘) 

Exit 
Closes the currently selected Interactive Plot. 
 
Annotations… 
Allow you to place annotations, curve labels and graphical objects on the log. 
 

9.3 Annotate the LOG 
Scroll the log to the area where annotations are required and select Annotate from the Action menu. 
Note that annotations may be placed on the log even whilst logging. Simply 'Pause' the scrolling log, 
scroll back to the area where the annotations are to be inserted, place the required annotations and 
'Unpause' to return to the current logging depth. 
 

9.4 Create a LOG Banner (Insert) 
Ensure that the pass, to which the banner is to be attached, is selected in the active plot window. 
Select Edit/Log Banner, and if required a database and dataset. 
 

 
 
FIG: 9.8 Log Banner Insert Window 
 
Clicking on the File menu and clicking the Select Format option can select the format of the Log 
Banner. There are a number of Log Banner formats (*.Wlb) to choose from. Select the most 
appropriate format and the edit the details by clicking on relevant areas within the window. 
 

 
FIG: 9.9 Edit Log Annotations 
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9.5 Screen Plot 
Select a database and dataset Go to Options and select the depth interval, plot presentation, etc.. Go 
to Action and select Screen Plot. The log will appear as below. 
The plot may be paused by using the Pause button and terminated by reselecting Screen Plot. The 
plot may be paused at any time and the scroll bar, used to move back through the log to any zone of 
interest. When moving the scroll bar, the actual log depth, corresponding to the scroll bar position, is 
indicated in a box in the centre of the log plot window. A popup window opens by right-clicking on the 
plot, displaying all the curve's values at the mouse position  
Note that the plot may be paused (or terminated) during logging without any loss of data, and 
subsequently returned to the current logging depth. 
A plot may also be generated by directly selecting Screen Plot under the Action menu. A file selection 
box will be displayed. 
Select a file in the standard Windows manner. If a presentation file is associated with the selected 
database, the plot will start immediately; otherwise a file selection box will be presented. Selecting a 
suitable presentation file will cause the plot to commence. 
Presentations may also be selected under the Options menu at any time, as previously described. 
 

9.6 Hardcopy 
Generates a hard copy plot to Warrior supported scrolling plotters devices and any Windows 
supported printer/plotter. Hardcopy can also generate PDF and TIFF files of the log, simply select 
the required option from the pulldown list. 
 
9.6.1 Plot a Hardcopy 
To plot a hardcopy, select Hardcopy… from the Actions menu. The selection of the database 
file, the presentation file and other menu options are identical to those of the screen plot. 
Selecting the Hardcopy… menu item brings up the following dialog box. 
 

 
FIG: 9.10 Hardcopy dialog Box 
 
There are normally several choices of printer. These include two classes of output. First, plotters 
supported by Warrior in the real-time scrolling mode, and second printers/plotters supported by 
Windows and installed on the system. Note that in the Windows mode, the output takes place in a 
paged manner, and that this mode is not suitable for use during logging. 
The number of copies and the media selection, for those printers that support it, can be chosen 
here. For those printers that support fanfold paper, Top of Form moves to the next fold. On some 
printers this will skip a fold so that new plots will start on an outside page when folded. 
 
9.6.2 Close the Current Plot & Select New Data 
Click on the plot selection, e.g. Screen Plot, and the plot is terminated. New Database file and 
Dataset selection may be made from the File menu, and presentation and other options may be 
chosen from the Options menu. 
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9.6.3 Make a TIFF File 
Install TIFF File as a Warrior printer with port name FILE: and driver None. You will be prompted for a 
file name for output. 
 

 
FIG: 9.11 Creating TIFF file 
 
By clicking on the Setup button you can customize the page length, resolution and compression of 
the TIFF file. 
This is an extremely useful feature that enables log presentations to be sent as e-mail attachments 
or used for presentation purposes as they can be inserted into Word, Excel, Powerpoint, etc.. Most 
common graphic file viewers can also view them. 
 
9.6.4 Make a PDF File 
Install the Adobe Acrobat reader from the Warrior Software CD or Download the Adobe Acrobat 
Reader http://www.adobe.com/products/acrobat/readstep2.html .It is a free version. 
This option is exactly the same as the TIFF files procedure, although to install use PDF File, rather 
than TIFF File. The Setup is also slightly different as the compression options vary from those of the 
TIFF file. 
The Output type can be Color or monochrome 
 

http://www.adobe.com/products/acrobat/readstep2.html
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FIG: 9.12 PDF file settings 
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10 Plot Job Editor  
The Plot Job Editor is a program module, which enables the operator to assemble the various 
components (heading, log sections, etc.) of a well log into its final presentation. The resultant plot job 
information is saved in a well log database, usually alongside the log data. The Presentation Plot 
program uses the plot job information to create the graphical output to a plotter or other graphics 
device (fax file, etc.).  
The Plot Job Editor is started from its icon in the Warrior group, the Presentation Plot File menu, or 
the Acquisition module Edit menu. (Video 10.1) 
Double click on the program group icon, the Acquisition Edit menu or the Presentation Plot File menu 
 
 

 
FIG: 10.1Select Plot Job Editor 
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FIG: 10.2 Select Plot Job 

10.1 File 

 

FIG: 10.3 File Menu 

The menu functions are as follows: 
 
10.1.1 New 
If a plot job is currently selected, New clears the editor for a new plot job.  
 
10.1.2 Open 
Displays the file selection window to allow the operator to select the database file containing the plot 
job to be edited. Note that plot job information is stored in the Warrior database file at the run level. 
 
10.1.3 Save 
After creating or editing the plot job it may be saved within a Warrior database file 
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10.1.4 Save As 
Allows a plot job to be edited and subsequently saved to new location with a different name. 
 
10.1.5 Screen Preview 
Starts Screen Preview of the selected plot job, see manual section on Presentation Plot. 
 
10.1.6 Hardcopy 
Displays a list of the plotters supported on the logging system. Selection of one of the plotters causes 
the plot job to be output to the hardcopy device (plotter). 
 
10.1.7 Exit 
Closes the Plot Job Editor 

10.2 Start the Plot Job Editor. 
When the selection of the items is complete the plot job data is saved in the Warrior database. 
If the Plot Job editor is invoked from within the Acquisition module the database path and name are 
set to be those of the current database. If invoked from elsewhere the full path must be entered by 
the user. (LEAVE NO ASTERISKS / WILDCARDS) The blank plot job appears as shown above. 
 
10.2.1 Change 
Changes plot job to be edited. 
 
10.2.2 Remove 
Removes the selected file from the plot job. 
 
10.2.3 Add 
To create a new plot job start with the Add button 
 

 

FIG: 10.4 Add File 

Add Displays the selection box containing types of files, which may be included in the plot job. 
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FIG: 10.5 Select the File to add 

Selecting a database file causes a list of plot jobs stored within the database to be displayed. 
 

 

FIG: 10.6 Select Database 



244 Warrior Software Version 7.0 Standard Cased Hole 

 

FIG: 10.7 Select Plot Job 

 

FIG: 10.8 Select Heading 

Typically a log heading would be the first file to appear in the plot job. Click on Heading and, because 
headings are stored in the log databases, the database selection window is displayed. Select the 
database where the required heading is stored. A list of the headings stored in that database is 
displayed 
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FIG: 10.9 Select Database  

Select the required heading by double clicking, or highlighting and the OK button. The heading 
appears as an icon at the start of the plot job sequence, as shown below. 

 

FIG: 10.10 Select Plot Job Input 
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FIG: 10.11 Add Heading 

 

 

FIG: 10.12 Add Heading, Log Pass, Tool String, and Calibration Report 

Other files may be added as required in the order they are to appear on the final log presentation. 
To add a log section click on Single Log Pass and a list of the log passes in the currently selected 
database is displayed.  
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Selecting Multiple Log Passes allows the operator to select for inclusion the plot job several log 
passes at the same time. This is useful when there are many passes to be included, as with 
production logging.  
Other items from the type list may be added as required. Tool string diagrams and calibration 
reports are stored at the pass level, therefore when adding an item of these types, a list of the log 
passes is presented. 
In this way the items to be presented on log print are defined together with the order in which they 
are to appear. Each item appears as an icon as shown below. 
 

 

FIG: 10.13 Save 

Note that the plot job contains information concerning which files are to be plotted, in which order, 
and with what presentation. It does not contain the files themselves, therefore the files may be 
modified e.g. by adding annotations, without the need to recreate or modify the plot job itself. 
Selecting External PRN file allows the inclusion within the plot job of plot or print output from any 
Windows application. It is necessary that the material to be added to the plot job have been 
previously printed to a PRN file from the particular application. See Windows Help - Print to a file for 
details on how to do this. 
Upon completion of the plot job sequence the job may be plotted by choosing the Hardcopy option 
from the file menu. Alternatively the Presentation Plot program may be started from the Warrior 
program group (particularly if a Screen Preview is required). 
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FIG: 10.14 Select Screen Preview 

 

FIG: 10.15 Heading 
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FIG: 10.16 Log Pass 
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FIG: 10.17 Tool String Add  
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FIG: 10.18Calibration Report 

 

VIDEO: 10.1 Plot Job Editor 
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11 Recalculation 
The recalculation mode allows log data to be recalculated or relogged from raw data. Calibrations 
and other acquisition parameters, such as filters and depth offsets, may be changed. The data 
monitors used during actual logging are available to the operator during recalculation. 
Double-click the Recalculation icon in the Warrior group and a menu box similar to that of Acquisition 
will appear. In this case though, Service and Action are disabled (appear feint on the menu bar). The 
Edit and Monitor menus are identical to those of Acquisition. 
 

 
FIG: 11.1 Recalculation 

11.1 File 
The following option can be select in File: 
Select Dataset, About, Exit, Close All. 

11.1.1 Select Dataset 
The Warrior well log database can (optionally) contain data from many wells, and within each well, data 
from many log passes. Each log pass is stored in a dataset. The dataset contains not only log data, but 
also other information about the logs, e.g. calibration and tool data 
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FIG: 11.2 Select Dataset 

Choose the Select Dataset option from the File menu. A dialog box will appear as shown below. 
The software includes a database named cbldem.db that may be used for the purpose of 
demonstrating the Recalculation mode. Select the dataset as shown below. 
 

 
FIG: 11.3 Select Database 

The Recalculation Output is the destination pass (or dataset) of the recalculated data. It may be 
named anything you like. If this pass already exists in the database when Recalculation. Is invoked, 
the software will give an error message and a new Recalculation Output should be selected. 
Allowing the system to give a default name to the recalculated output will cause it to be named x.1, 
where x is the name of the original pass. Repeated passes through Recalculation. Will cause an 
incrementing number to be attached to the Recalculation. Output. In this case pass1.2, pass1.3 etc. 
When recalculating, for example, pass 1.1 to 1.2, upon selecting 1.1 as the base pass the system will 
still indicate 1.1 as the output pass. It will however create a new pass 1.2 



254 Warrior Software Version 7.0 Standard Cased Hole 

 

FIG: 11.4 Select Pass Name and Set recalculated Output 

When OK is selected the software reads information from the log database and displays the 
Recalculation Control dialog box, as shown below. 

11.2 Recalculation Control 

 

FIG: 11.5 Recalculated Control 

The Recalculation Control allows setting of Start, Stop and Pause depths. It also enables setting of the 
Step size. The Step size is the log interval that Recalculation attempts to recalculate during its share of the 
CPU time and functions effectively as a speed control. 

Recalculation may be run in three modes. 
 
11.2.1 Run single step 
Select a step size. This may be as small as a single sample. 
Click the Single Step radio button. The log plot will appear on the left of the screen.  
Successive clicks on the Step button will cause the pass to be recalculated step by step. 

 
 11.2.2 Run variable speed 
Select a step size.  
Click the Variable Speed radio button. The log will appear on the left of the screen and will scroll at a 
rate that may be varied by the scroll bar in the Recalculation dialog box. Increasing the step size also 
increases the recalculation rate. 
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 11.2.3 Run maximum speed 
Select a step size. 
Click the Maximum Speed radio button. The log will appear on the left of the screen and scroll at its 
maximum rate. It is likely that the recalculation will complete quickly, but that the log on the screen 
will lag. 

 
11.2.4 Pause Recalculation 
Click once on the QUIT button causes the Recalculation to pause. 
 
 11.2.5 Quit Recalculation. 
Click twice on the QUIT button. 
 

11.3 Load Variables 
The Load Variable is invoked from the Recalculation File menu. It is used to Load variables from the 
database. 
Load Variables the other Dataset, enabling depth dependent parameters associated with the 
selected service to be zoned and values to be set. 
 

 

FIG: 11.6 Load Variables 

11.4 Monitor 
The Monitor option in recalculation has the same properties that Monitor in acquisition. (See Section 4.6) 

 

FIG: 11.7 Monitor Options 
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FIG: 11.8 Step Control 

11.5 Edit 
The Edit option in recalculation has the same properties that Edit in acquisition. (See Section 4.5). 
Change parameters as required. These may include: 
Tool String, Variables, Heading, Master Log Format, Plot Job, Sensors, Tool Configuration, Device 
Configuration, depth offsets, input channels, curve filters, calibrations, sonic amplitude gate settings. 
 

 
FIG: 11.9 Edit Options 
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FIG: 11.10 Acoustic Signal Control Off 

 

FIG: 11.11 Acoustic Signal Control set ON  
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FIG: 11.12 Thresholds and Gate Control ON 

 

FIG: 11.13 Gate control Set ON 

 

VIDEO: 11.1 Acoustic setup Travel Time gate, Amplitude gate, and scales. 
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FIG: 11.14 Edit GR Calibrations 

 

FIG: 11.15 GR Curve Before and After the Recalculation 
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12 Merge/Splice, TVD Merge/Splice 
The Wizard, Merge, Splice and TVD module allows data from one or more database files to be 
manipulated in the depth domain and output to one or more destination files. Data may be depth 
adjusted and correlated, curves from multiple runs spliced together, outputs renamed etc. The 
module also includes the capability to calculate True Vertical Depth (TVD) from directional survey 
data and generate log data referenced to TVD for subsequent plotting and other operations. Most of 
the Merge program operations may be accomplished with only one pass through the data. 
Double-click the Merge icon in the Warrior group 
 

 
FIG: 12.1 Warrior Group 

12.1 Wizard 
The Wizard option is easy way to do Merge two Passes, Splice, Replace and Add curves 
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12.1.1 Merge two Passes 
Double-click the Merge two Passes option. 

 

FIG: 12.2 Wizard/Merge two passes option.  

Set the Base Pass as Upper Pass or Lower Pass and select the Database 

 

FIG: 12.2 Merge two Passes set the Base Pass as Upper Pass 

Select the Input pass to merge from the Database 
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FIG: 12.3 Select Input pass for Merge 

Select the Pass from the database to set as Lower Pass 

 

FIG: 12.4 Select Pass as Lower Pass 

Select the Pass from other Database 
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FIG: 12.5 Select pass from the Database 

The software by default created a pass (Merge1). 
Set the depth to start the Merge1 (Splice the curves), Define the log interval and set the presentation. 
 

 

FIG: 12.6 Merge two passes 

Double-click the Process bar 
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FIG: 12.6 Start the Process 

Processing the Merge 1 

 

FIG: 12.7 Processing 

Select Interactive Plot in the warrior group 

 

FIG: 12.8 Select Database from interactive plot 
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Screen plot the Merge1 check the Merge the curves (Splice) at 200 FT. 

 

FIG: 12.9 Screen Plot Merge1 
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12.2.2 Merge two Passes (Add Curves) 

 

FIG: 12.10 Select Add/Replace a curve 

 

FIG: 12.11 Select the Base Pass  

 

FIG: 12.12 Select to add curve 
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FIG: 12.13 Select the curve 



268 Warrior Software Version 7.0 Standard Cased Hole 

 

FIG: 12.14 Select the curve in log Data Inputs 

 

FIG: 12.15 Modified input Curve 

 

FIG: 12.16 Add Curve and Process 
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FIG: 12.17 Processing 

 

FIG: 12.18 Interactive Plot select pass 
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FIG: 12.19 Plot the Pass 
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12.2.3 Merge two Passes (Replace curve) 

 

FIG: 12.20 Select Curve from the database 

 

FIG: 12.21 Process 
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FIG: 12.22 Select the database to keep the curve 

 

 

FIG: 12.23 Plot the pass with the new curve that replaced the old ones. 

 

VIDEO: 12.1 Wizard Merge 
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12.2 Merge 
Double-click the Merge icon in the Warrior group. The Merge Splice TVD window will appear as 
shown below. 

 
FIG: 12.24 Log data Inputs  

The Merge module interface consists of six independent windows within the main Merge window. 
Any or all of the windows may be displayed at the same time.  
Note that if you loose a window by inadvertently or deliberately closing it, you can get them all back 
by clicking Window/Open All in the main menu bar.  
The main Merge menu box contains several pull down menus and selection options, which control 
the operation and set up of the Merge sub-system. The pulls down menu functions are as follows: 
 
12.2.1 File 
12.2.1.1 Select Input Log Data.  
Selecting this option brings the Log Data Input window to the foreground. Data items e.g. curves, 
are selected from their source database(s) and dataset(s), and displayed as a scrolled list in the Log 
Data Input Window. Within the Log Data Input window several processing parameters are set. 
 
12.2.1.2 Detail Selected Inputs 
Selecting this option brings the Input Details window to the foreground. This window displays 
detailed information concerning the data items selected for processing. 
 
12.2.1.3 Select Output Path/File 
Selecting this option brings the Output Definition window to the foreground. This allows definition of 
the database and dataset to which the processed data is to be output. A default presentation, with 
start and stop depths, may be associated with the output database in this dialog also. Note that 
Browse buttons are available so that existing databases and presentation files may be easily 
selected. 
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12.2.2 Corrections 
12.2.2.1 Enter Depth Tie Ins 
Selecting this option brings the Depth Correction Tie Ins window to the foreground. Processing 
parameters for data depth corrections are entered in this window.  
12.2.2.2 Enter Directional Data 
Selecting this option brings the Directional Survey Stations window to the foreground. Entry of 
directional survey data for TVD calculations is made in this window. 
 
12.2.3 Processing 
12.2.3.1 Process Commands. 
Selecting this option brings the Process Control window to the foreground. Three selections may be 
made in this window. The type of processing to be performed, if the processing is to be done as a 
foreground or background task, and to the default depth units are to changed. 
 
12.2.4 Windows 
Conventional Windows commands for manipulating windows on the screen 

12.3 Merge data items (curves) from two (or more) log   passes 
If the Log Data Inputs window is not active, click on Select Input Log Data ...... under the File menu. 
The Log Data Input window appears in the foreground. Clicking the Add button brings up a file 
selection box where an existing log database may be selected in the usual way. 
Once a database is selected the contents in terms of runs, passes, curves etc. are displayed as a 
scrolled list, as shown below. 
 

   

FIG: 12.25 Select Curve from the database 

Select the curves and other items, present in this list that you wish to merge. When all the required 
curves present in the current database have been selected click OK and the selected items are 
passed to the Log Data Inputs list as shown below. 
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FIG: 12.26 Log Data Inputs 

In the same way (Add etc.) curves and other data items may be selected from other databases until 
all the required curves are present in the Log Data Inputs window. 
From within the Log Data Inputs window, details of the processing parameters for the individual data 
items are set. The processing parameters which may be adjusted are the depth range, the name of 
the output curve and the application (or otherwise) of depth corrections.  
Select one or more curves from the input list by highlighting them in the normal way. Note that 
Change button is now activated. 
Clicking the Change button brings up the Modify Input Item dialog as shown below.  
 

 

 
FIG: 12.27 Modify input item 

If a group of curves was selected, the Input Dataset is shown as Multiple because several curves 
have been selected. If a single curve is selected the actual name of the curve us presented. 
The depth range of the output curve(s) may be set as desired or left as the initial range. The name of 
the output curve may be changed only if a single curve was selected. 
If depth corrections are to be applied the Apply Depth Correction box must be checked and depth 
correction tie-in points entered (see below). 
Note that currently only one set of curves may be depth corrected per pass through the data. If you 
wish to correct more than one curve (or group of curves), where one curve (or group) has different 
depth corrections than the others, then tie-in points must be entered for the first group, the merge 
process run and then the second curve (or group) selected, the second group of tie-ins entered, and 
a second merge process run. 
Detailed information on all data items in the Log Data window is present in the Input Details window. 
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12.4 Access detailed information on data items. 
Select Detail Selected Inputs from the File menu. A new window is generated as shown below. A 
variety of information is shown about all the curves selected for processing. The horizontal and 
vertical scroll bars are used to access all the available information. 

 

 

FIG: 12.28 Input Details 

12.5 Enter depth tie in points 
Select Enter Depth Tie Ins.... bringing up the Depth Correction Tie Ins dialog as shown below. 
 

 

FIG: 12.29 Depth Correction Tie Ins 

Depth tie in points may be entered from the keyboard by first clicking the Add button to obtain the 
window shown below 

 

 
 FIG: 12.30 Add Tie-in 
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Enter the current log depth in the Measured Depth box, and the depth to which you wish to move 
those log points in the Actual Depth box. Click OK and the points appear in the scrolled list. The Add 
Tie-in window continues for entry of the next tie-in point. When all tie-in points have been entered, 
click Cancel. 
The log interval below the lowest tie-in point will be linearly shifted up or down, and by an amount 
corresponding to the lowest tie-in values. 
The log interval above the highest tie-in point will be linearly shifted up or down, and by an amount 
corresponding to the highest tie-in values. 
The log data between tie-in points will be linearly stretched or squeezed according to the tie-in 
values. 
Note that if only one tie-in point is entered then all the log data will be linearly shifted up (or down) 
according to the tie-in values. The same result may be achieved much more quickly by using the 
Apply Linear Shift to a Dataset or Apply Linear Shift to a Data Item functions in the Utilities package. 
Tie-in points mat be read from and written to a file using the Put and Get buttons. Points may be 
changed or removed using the corresponding buttons. 
Once the changes have been made to the input data, it is necessary to indicate where the merged 
data is to be written. 

12.6 Select the output path or file name. 
Choose Select Output File/Path from the File menu. The dialog box shown below appears. The 
output database and dataset are typed in from the keyboard, or an existing database is selected 
using the Browse button. 
Note that it is usually quicker to select an existing dataset with the Browse button and then modify its 
name and/or dataset path, than to type in all of the fields from scratch. 
A default presentation file may be attached to the output dataset with a depth range defined in this 
dialog.  
The Browse button may be used to select an existing presentation file from those in the system. 

 

           

FIG: 12.31 Output definitions 

The final step in merging the data is to define the processing operation, the processing mode and the 
depth units (if other than default).  
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12.7 Select processing options and start processing 
Select Process Commands bringing up the Process Control Window as shown below. 

 

 

FIG: 12.32 Process Control 

Select the Copy / Splice / Merge Log Data to process the data with optional depth corrections. Select 
Copy Log Data with TVD Correction to generate a new set of log data with depth referenced to TVD 
calculated from the directional survey data. Select Calculate TVD Report to generate an ASCII 
directional report. 
Process in Foreground causes the processing to take place in Windows foreground mode, whilst 
Process in Background allows processing to take place whilst other tasks, such as logging, are 
active. 

12.8 Splice a curve 
Select first input database as described above. Select the first section of input curve to be spliced 
from the Select Data Items window, then select the second and so on until all the original curves from 
which the spliced curve is to be assembled are present in the Log Data Inputs window. The original 
curves may originate from one or more databases.  
Select the first curve and input depth range of this curve to be used in the spliced curve e.g. 1200, 
1300. Select the second input curve and set its range e.g. 1300, 1400. Select the third input curve. 
When all the sections have been defined go to Output Definition and define where the new curve is to 
written, as described above. Process Control, select the Copy / Merge...option and click Begin. 

12.9 Enter Directional Survey Data 
Select Enter Directional Data. bringing up the Directional Survey Stations window as shown below. 
The depth, borehole inclination, and azimuth are entered in a manner similar to the depth tie in data. 
The Add, Change, Remove, Get, Put and Close buttons are used in the same manner as previously 
described for Depth Correction. 
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FIG: 12.33 Directional Survey Stations 

Once the data items have been selected, the destination file chosen and the processing parameters 
defined, the Processing menu or Process Control window may be selected to initiate processing of 
the data as previously described. 
The Window menu functions are identical to those found in any Windows application, allowing the 
individual windows e.g. Process Control, Log Data Inputs etc., to be tiled, cascaded, etc., as shown 
below.  

 

FIG: 12.34 Process Control 

Note that the interface to the Merge program may be customized by the user in terms of window 
sizes and layout. The layout in existence at the time the program is closed will be brought back the 
next time the program is run. 
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13 Utilities 
The Utilities icon in the Warrior Program Group allows access to several programs, some with 
general, and some with more specific, applications. 

 

FIG: 13.1 Warrior Program Group 

The warrior Utilities has six modules: 
 
1) Data Export 
2) Interpretation Tools 
3) Data Import 
4) Depth Correction 
5) Data Management 
6) Setup Tools 
 
Clicking on the icon Utilities gives a menu list as shown below. 
 

Section

13 
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FIG: 13.2 Warrior Utilities 

13.1 Data Export 
13.1.1 Export to LAS Format 

 

FIG: 13.3 Export LAS Format 
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FIG: 13.4 Select Database, Data Set, Heading 

 

FIG: 13.5 Set LAS Outputs 
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FIG: 13.6 Select curves Y/N and Start 

 

FIG: 13.7 Processing 

 

VIDEO: 13.1 Export LAS 
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13.1.2 Export to LIS Format 

 

FIG: 13.8 Export to LIS Format 

 

FIG: 13.9 Select DATA to Built the LIS 
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FIG: 13.10 Add a Heading to export list 

 

FIG: 13.11 Select Template (*.LET) 
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13.1.2.1 LET Files 
LET files are used to define the output data for Warrior LIS Exporting (LIS Export Template). 
This needs to be a sequentially numbered set of outputs. All outputs from a log pass do not have to 
be listed, but only those listed will be output into the LIS file 
13.1.2.1.1 First Item 
The first item in the list must be number [0]. This defines the title and frame spacing or output rate. 
The title is used for information only. The Frame Spacing is followed by one to three parameters. The 
first parameter is the out rate in inches if the rate is in feet. The second parameter is the output rate 
in Millimeters if the rate is in meters. The third parameter is the output rate in seconds if it is a time 
drive log. 
Example:  [0] 

Title=CBL Export 
FrameSpacing=3,77,.1 

13.1.2.1.2 Data Items 
Each data item output must be listed with an InputName that is shown as the mnemonic used in the 
Warrior database. OutputName is optional, but should be used if the input name is longer than 4 
characters, otherwise the input name will be truncated to the first 4 characters.  LIS Standard is no 
mnemonic longer than 4 characters. The SampleSpacing is optional. This is used if a rate different 
than the FrameSpacing is required. It has the same three parameters as the FrameSpacing listed 
above.  
Example:  [2] 

InputName=CCL 
OutputName=CCL 
SampleSpacing=1.2 

13.1.2.1.3 Last Item - Depth 
The last data item should be DEPTH. Note that since Depth is 5 characters, it will automatically be 
truncated to DEPT, but it is standard to show the output name as DEPT. 
Example: 

  [8] 
InputName=DEPTH 
OutputName=DEPT 
 

 

FIG: 13.12 Select Log Export Templates 
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FIG: 13.13 Open with Notepad the CBL.let file 

 

FIG: 13.14 Setup the Export File 



288 Warrior Software Version 7.0 Standard Cased Hole 

 

FIG: 13.15 Build Export File List 

 

FIG: 13.16 File Base Name 

 

VIDEO: 13.2 Export to LIS 
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13.1.3 Export to ODBC compatible Database 
This program will export data for Excel, Access, FoxPro and other ODBC compatible databases.  The 
limit for exporting data is 255 data points per sample.  A normal curve is one data point but a 
waveform will be many more points for each sample.  You will see a message in the progress window 
that the column count has exceeded if you exceed that amount. 

 

FIG: 13.17 Export to ODBC Compatible Database 
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13.1.4 Extract Pass (es) to New Database. 

 

FIG: 13.18 Extract Pass(es) to New Database 

 

FIG: 13.19 Select Database 
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FIG: 13.20 Select Pass(es)  

 

FIG: 13.21 Copy Target 
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FIG: 13.22 Packing 

 

FIG: 13.23 Check the Database Target 

 

FIG: 13.24 View Passes in the Target 

 

 

VIDEO: 13.3 Extract Pass(es) 
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13.2 Interpretation Tools 
13.2.1 Mathpack 
See section 15 

 

FIG: 13.25 Math Pack 

13.2.2 XY Plot 
A cross plot will consist of one or more curves. Each curve will be created by plotting one database 
item plotted against depth or time or from one database item plotted against another database item. 
 

 

FIG: 13.26 XY Plot 
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Select File/New or the Create a new plot icon to create a cross plot. Select Add Curve to create 
each curve. Each curve name will increment by 1 as you add curves. Select Delete Curve to delete 
the selected curve from the plot. 
To set up the cross plot you must first select what will be plotted on each axis. If depth or time is 
selected to plot on the x-axis, then no item will be selected to plot on the x-axis. Next select what 
database item(s) to plot by selecting the X - Axis or Y - Axis buttons. If you want to plot one database 
item vs. another, the items do not have to come from the same pass, but they must both be recorded 
on depth or both be recorded on time. Also the items must have an overlapping depth or time interval 
to plot from. 
Once the plot setup is complete select the OK button, and the plot will start. The scaling will be done 
automatically. To change how the plot is scaled select Edit/Scaling. 
The plot can be made real-time, and if the auto-scale option is used, the plot will resize automatically 
to fit all of the data points as needed. 
 
13.2.2.1 Scaling 
A separate axis will be drawn for each curve unless the option Overlap scales for each curve is 
selected. If the auto-scale option is selected for the x or y axis, the left, right and/or top, bottom 
scales will automatically be calculated to fit all of the data within the plot. If it is not selected, you can 
enter the scales yourself. If only one database item is selected to plot, then one of the axis will be 
depth or time. 
When plotting two database items, there is a depth or time scaling option. It can be auto-scaled or a 
range can be selected. The scales for the depth or time must be within the recorded range of the 
interval being plotted. 
The x and y origin is defaulted to (0,0). If the origin is outside the range of data being plotted, then the 
origin will be moved to the bottom left corner of the plot. 
The X and Y ticks give an approximate count to the number of gridlines that will be shown on that 
axis. The gridlines will attempt to be drawn at an integral distance apart, so the displayed ticks may 
not be the same as what are requested. 
Sometimes it may not be appropriate to draw a line to connect each data point. To make a dot for 
each data point, deselect the option "Draw a line between plotted points". 
 
13.2.2.2 Plotting 
If the plot is being created as the data is being collected, then the Start Plot button will change to 
Stop Plot. Press the Stop Plot button to halt the plotting. If the data collection continues, then press 
Start Plot to plot the entire collected interval again. Starting the plot in the middle of data collection 
will plot over the interval as described in Scaling. 
 
13.2.2.3 Annotations 
To create an annotation, select Annotations/Create or click on the "<-ab" annotation button in the 
toolbar. When the annotation button is depressed, an annotation can be added. When the cursor is 
moved in to the plot area, the cursor will change to indicate the type of annotation that will be added. 
Right click on the mouse to change the annotation type. Left click to place the annotation on the plot. 
Type in the text for the annotation while the annotation is highlighted. To move an annotation, click 
and hold the left mouse button and drag the annotation to the appropriate position. To delete an 
annotation, left click on the item to be removed. When it is highlighted, press the delete key. To edit 
an annotation, left click on the item and then type in the new text. 
 
13.2.2.4 Zoom 
Select the Zoom in, Zoom out buttons to change the cursor to a magnifying glass. Then select the 
area of the plot to magnify. To set the plot back to it's default size, select the Auto scale button. 
 
13.2.2.5 Save and Restore 
When saving the cross plot, two items can be saved. First the cross plot can be saved to a Warrior 
database to be plotted with pplot. Second, the plot setup can be saved and restored at a later time 
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with the cross plot program. Saving the setup does not save the plot itself - it only saves the curve(s) 
being plotted and the setup used to create the plot. 
The plot heading is only seen when the plot is printed. It can accept multiple lines by hitting the enter 
key at the end of each line. 

 

FIG: 13.27 Plot setup 

 

FIG: 13.28 Setup Axis 
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FIG: 13.29 Select database and Curve 

 

FIG: 13.30 XYPLOT 
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FIG: 13.31 XYPlot Scaling 

 

FIG: 13.32 Edit Curve setting 
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FIG: 13.33 XYPlot with new setting 

 

FIG: 13.34 XYPlot Change Axis 
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FIG: 13.35 XYPlot  

 

FIG: 13.36 XYPlot setup (X/Y) for two curves 
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FIG: 13.37 XYPlot  

 

FIG: 13.38 XYPlot new setting zoom 
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FIG: 13.39 XYPlot Two curves in the same chart 

 

 VIDEO: 13.3 XY PLOT 
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13.2.3 Tracer Interpretation 

 

FIG: 13.40 Tracer Interpretation 



 

303 Warrior Software Version 7.0 Standard Cased Hole

13.2.4 Create Differential Curve 

 

FIG: 13.41 Create Differential Curve 

 

FIG: 13.42 Create Differential curves. (DIFFCCL) 

 

 

FIG: 13.43 Processing 

 



304 Warrior Software Version 7.0 Standard Cased Hole 

13.2.5 Create Total Dissolved Solids Curve 
 

 

FIG: 13.44 Create Total Dissolved Solids Curve 

13.2.6 Calculate Borehole Volume from Caliper 
 

 

FIG: 13.45 Calculate Borehole Volume from Caliper 
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13.2.7 Calculate Rxo/Rt and Rwa Curves 
 

 

FIG: 13.46 Create Total Dissolved Solids Curve 

Click on the Calculate Rxo / Rt button. This produces as file selection box, where the required 
database may be selected. Double click or Open the database file containing the input data for the 
calculation. 
The program presents a list of the log curves present in the database and requests selection of the 
Rt curve. Select the desired curve. 
 

FIG: 13.47 Select Dataset for Deep Resistivity Curve 
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The system then requests the selection of the shallow resistivity curve. 
 

 
FIG: 13.48 Select Dataset shallow Resistivity Curve 

The system then requests the porosity curve for the calculation of Rwa. 
 

 
FIG: 13.49 Select Dataset for Porosity 

Note that the a and m variables must be present in the dataset for Rwa to be calculated. To set the 
values of a and m use Edit Variables in a Dataset. Note that the a is A and m is CMNTFC. After 
selecting the porosity curve the system requests the name of the dataset for the output. 
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FIG: 13.50 Select Dataset Output 

Select the required dataset and the system computes the Rxo / Rt and Rwa curves and displays a 
message indicating completion and log interval processed. 
 

 
FIG: 13.51 Processing 

Note that in order for the Rxo / Rt and Rwa curves to appear on the log, the respective curves must 
be added to the log format. The mnemonic for the Rxo / Rt and Rwa curves are RXORT and RWA 
respectively. 
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13.2.8 Pipe Tally 

 

FIG: 13.52 Pipe Tally 

 

FIG: 13.53 Get Joints from a Log Pass 
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FIG: 13.54 Scan log for Collars 

 

FIG: 13.55 Screen Plot 

 

FIG: 13.56 Scan Pass 
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FIG: 13.57 Plot Pass and select area 

 

FIG: 13.58 Accept 
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FIG: 13.59 Done 

 

FIG: 13.60 Done 

 

FIG: 13.61 Results 

 

VIDEO: 13.4 Pipe Tally 
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13.2.9 Curve Normalization 
This program will cross plot two curves over a chosen interval.  Then it calculates the gain and offset 
required to apply to the second curve (Curve to be normalized) to make it overlay the first (Reference 
curve). 
Select the reference curve, then the curve to be normalized.  Interactive plot should start with the 
reference log pass.  You should be able to plot the curve to be normalized on that same pass - look 
in the progress window to see the name (alias) that was created for the normalized curve.  From 
interactive plot you can drag a rectangle over the interval to choose the depth range for 
normalization.  Once that is done, and then selects MakeXY.  If you are satisfied with the data points 
in the XY plot, then select Normalize.  Interactive plot will start again, but this time with the pass from 
the normalized curve.  If you look in the progress window, another curve will have been created in the 
Normalized pass.  That curve will be what the curve looked like prior to the normalization.  The name 
should be the same as the normalized curve except preceded by a ‘.’, and the normalized curve will 
have the original name. 

 

FIG: 13.62 Curve Normalization 

13.3 Data Import 
13.3.1 Read ASCII Data into the Warrior (LAS) 
In the Warrior System group, choose the Utilities icon. (Double-click the icon, or use the arrow key to 
move the selection cursor to the icon and hit Enter.) The window shown below appears. 
The ASCII Importer reads data from existing ASCII file(s) and writes the data to one or more Warrior 
well log database files. 
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Start the ASCII importer from the program group or Interactive Plot. The dialog and control box is 
presented as shown below.  
 

 
FIG: 13.63 Read ASCII Data into Warrior 

The input files are selected by clicking the Add Files button. This produces a file selection box as 
shown below. 
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FIG: 13.64 Input File to Read 

 

FIG: 13.65 Select the ASCII File Type 

The importer will automatically import several common ASCII file types. Clicking on the Files of type 
selection displays the various ASCII formats handled. Select the type to be imported. 
If the ASCII file format to be imported is not displayed here contact SDS. 
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Select the required ASCII files in the normal way and click Open. 
The selected files may be viewed by clicking the � button in the Files to read: field. The selected files 
may be cleared by clicking the Clear List button.  
In Options Clicking the One log for each file radio button generates a warrior log pass for each ASCII 
file selected. 
Clicking the Merge all files into one log button merges all the selected ASCII files into one log pass. If 
the ASCII files contain curves of the same name, the importer will automatically add a numerical 
subscript to the duplicate curves according to the order they appear in the Files to read: list. 
The default presentation file for the new log pass is entered in the Log Format  field by clicking the 
corresponding Select File button. 
The filter list file has the default extension .wif. It may be selected by clicking the corresponding 
Select File button. 
Checking the Create Heading selection causes the importer to create a log heading file based on any 
available information from the ASCII input file(s). If no information is available it will create a blank 
heading in the new database. 
Checking the Create Plot Job selection causes the importer to create a default plot job based on the 
log heading (if any) and the imported log passes. 

 

FIG: 13.66 Select File 
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FIG: 13.67 Setup Warrior data Importer 

If required the curves may be filtered during the import process. An ASCII text file must be created in the 
\warrior\bin directory and consist of a list of filter definitions similar to those used in the tools.ini file to define 
default filters 

 

FIG: 13.68 Start to select the curves 
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FIG: 13.69 Reading the ASCII and convert to DB 

The status window displays a log of the importing operations. 
Having made the various selections and chosen the required options the importer may be run by 
clicking the Import button. The importer will read the selected ASCII files and display the status. 
Clicking the Heading button starts the Heading Editor program and displays the heading generated 
by the import process. If Create Heading was not selected a blank heading will be presented. 
Clicking the View button starts the Interactive Plot program for screen display of the results of the 
import process. 
Clicking the Plot button starts the Plot Job Editor program with the plot job generated during the 
import process (if any). If Create Plot Job was not checked a blank plot job is presented. 
The Close button closes the Importer program. 
 

 
VIDEO: 13.5 Read ASCII 
 
 
 
 
 
 



318 Warrior Software Version 7.0 Standard Cased Hole 

13.3.2 Read LIS Data into the Warrior 
 

 

FIG: 13.70 Select Read LIS Data into Warrior 

A tape must be copied to a disk file before it can be read in to a Warrior database.  Select ‘From 
Tape’ and then select the tape drive and the output file name.  Once that is completed, select OK to 
copy the data to a file.  Once the data is read to a file, then a scan or conversion can be done. 
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FIG: 13.71 Select LIS file 

After the LIS file has been selected, choose one of the LIS file types.  If you are not sure what the file 
type is then select Unknown.  This will loop through all of the LIS file types until it can read the file 
without an error. 

 

FIG: 13.72 CBL.NIT File 
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FIG: 13.73 Scan 

 

FIG: 13.74 Curves/Constants 
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FIG: 13.75 Convert List to Warrior 

The destination database file name does not have to exist, but the specific run given for the 
destination cannot exist.  For any LIS passes greater than the first pass, the LIS pass number will be 
appended to the output Warrior database pass name to create a unique Warrior name for each pass. 
If a header is requested, then the heading information will be filled out based on the type of heading 
chosen.  The heading that is chosen will affect the list of available heading names shown when 
editing constants from the Curves/Constants dialog.  The heading that is created will go to 
/[field]/[well]/[run]/_plots_/_headings_/1.  Only one heading is allowed per /[field]/[well]/[run]/.  
Therefore, if a database is created from a LIS file with multiple passes, only the heading information 
from the first pass will be used to create the heading 
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FIG: 13.76 Output 

 

FIG: 13.77 Header not Output Curves 

 

FIG: 13.78 Setup Output Details (see CBL.LET file Section 13.1.2.1) 
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More Information Required for Waveform Data 
The top line of the dialog contains the pass number and name from the LIS tape.   
The start time for the waveform is the number of microseconds that elapsed prior to the beginning of 
recording the waveform. 
The waveform sample rate is the total sample interval (in microseconds) divided by the total number 
of samples taken. 
The minimum and maximum recordable waveform values are required for scaling the waveform plot 
properly.  For example, a 13 bit-sampling device may have a range of values from –2048 to +2047. 
 

 

VIDEO: 13.6 Read LIS 

13.3.3 Import ODBC Data into Warrior 
This program will import data for Excel, Access, FoxPro and other ODBC compatible databases.  The 
limit for exporting data is 255 data points per sample.  A normal curve is one data point but a 
waveform will be many more points for each sample.  You will see a message in the progress window 
that the column count has exceeded if you exceed that amount. 
 

 

FIG: 13.79 Import ODBC Data Into Warrior 
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13.3.4 Create Log format from Dataset 
 

 

FIG: 13.80 Create Format from Dataset 

13.4 Depth Correction 
13.4.1 Apply linear Depth Shift to the a Dataset 
This feature is intended to provide a rapid tie-in capability by applying a linear depth shift to a 
Dataset. Once a section of log has been made and is displayed on the screen, select Depth Shift 
from the Action menu.  
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FIG: 13.81 Apply Linear Depth Shift to a Dataset 
 
Clicking on this button brings up the same depth shift dialog box that is available from the Acquisition 
module. It allows a linear depth shift to be quickly applied to a dataset (typically all the curves in a log 
pass). 
 
13.4.1.1 Depth Shift a Dataset 
In the Warrior System group, choose the Utilities icon. (Double-click the icon, or use the arrow key to 
move the selection cursor to the icon and hit Enter.). The Utilities menu box will appear. 
Click on the Apply Linear Depth Shift to a Dataset button. A dialog box will appear as shown below: 

 
FIG: 13.82 Depth Shift Pass 
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FIG: 13.83 Set Depth Shift 

Enter in the Amount of shift box, the shift to be applied (a positive number to make the data deeper, 
and negative to make the data shallower).  
Click on the Apply button and the data is shifted the requisite amount. 
Note that the default is for the Shift current Encoder Depth also box to be inactive, i.e. the encoder 
depth will not be updated unless the box is checked. 
 
13.4.2 Apply linear Depth Shift to the a Data item 

 
FIG: 13.84 Apply Linear Depth Shift to a Data Item 
 
Clicking on this button brings up a similar depth shift dialog box that is available from the Acquisition 
module. It allows a linear depth shift to be quickly applied to a data item (typically one curve from a 
log pass).  
In the Warrior System group, choose the Utilities icon. (Double-click the icon, or use the arrow key to 
move the selection cursor to the icon and hit Enter.). The Utilities menu box will appear. 
Click on the Apply Linear Depth Shift to a Data Item button. A dialog box will appear as shown below: 
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FIG: 13.85 Select Data 

Click the Select Data button to select the database file and then the data item (curve) to be depth 
shifted. 

 
FIG: 13.86 Select  

Enter in the Amount of shift box, the shift to be applied (a positive number to make the data deeper, 
and negative to make the data shallower). Click on the Apply button and the data item is shifted the 
requisite amount. 
Note that the default is for the Shift current Encoder Depth also box to be inactive, i.e. the encoder 
depth will not be updated unless the box is checked. 
 

13.5 Data Management 
13.5.1 Create an Alias for a Data Item 
Clicking on this button brings up a dialog box, which allows a data item, typically a curve from a log 
pass, to appear as though it were present in another (different) log pass. This allows curves and 
other data items to be effectively merged to other datasets, without using the Merge program or 
creating new merged log passes. Essentially a form of link is defined in the database(s) that allows 
application programs (such as Interactive Plot) to access data items from datasets other than the 
dataset currently selected.  
In the Warrior System group, choose the Utilities icon.  
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FIG: 13.87 Select Create an Alias for a Data Item 

Click on the Create an Alias for a Data Item button. A dialog box will appear as shown below: 
 

 
FIG: 13.88 Browse DataBase 

Click the Browse button and select the database file, then the dataset (log pass) and finally the data 
item to aliased. In the case shown below the curve GR has been selected from pass12 of the 
cbldemo.db database. 
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FIG: 13.89 Create data Item Alias 

This is the database item to be aliased to another pass.  
In the New Name for item field replace any or the entire data item path. For example if we want this 
GR curve to appear in pass1, we type over pass12 with pass1, as shown below: 
 

 
FIG: 13.90 Create Pass1 

The OK button is clicked and the GR curve from pass12 will now appear in pass1. If a curve with the 
same name already exists in pass1 then the program will give a message indicating that this is the 
case and the alias will not be performed. The easiest thing to do in this case is to rename the GR 
curve to something else (which does not already exist in that pass) e.g. GR2. 
 

 
FIG: 13.91 Create GR2 Curve 

Clicking the OK button will now alias the pass12 GR curve to pass1 as GR2. Note that if you now 
wish to plot this curve it will be necessary to include a curve called GR2 in the presentation file with 
which the pass will be plotted. 
Note that a linear depth offset may be applied to the data item as it aliased, so if the curve is not 
depth aligned with the other data in the destination path, it may be corrected at this point. 
Note also that no new log passes are created in this process and the size of the database(s) remains 
the same. This is very important when wishing to present waveform data from several passes 
simultaneously, as large amounts of data would otherwise be created. 
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13.5.2 Multiple pass Auto merge 

 

FIG: 13.92 Multiple Pass AutoMerge 

 

FIG: 13.93 Multiple Pass Automerge 
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FIG: 13.94 Set Passes and Curves 

 

FIG: 13.95 Four new aliases curves 



332 Warrior Software Version 7.0 Standard Cased Hole 

 

FIG: 13.96 View option 
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FIG: 13.97 Plot the new add curves 

 

 

VIDEO: 13.7 AutoMerge 
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13.5.3 Edit Variables in a Dataset 

 

FIG: 13.98 Edit Variables in a Dataset 

See Section 4.5.2 
 
13.5.3 Create Variables in a Dataset 
 

 
FIG: 13.99 Create Variables in a Data set. 
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13.5.6 Create Waveform Gate Curves 
 

 
FIG: 13.100 Create Waveform Gate Curves 

13.5.6 Create CCL Curve from Keyboard 

 

FIG: 13.101 Create CCL Curve from Keyboard 
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13.5.7 Delete Data from a Database 
 

 
FIG: 13.102 Select Delete data from a Database 

 
FIG: 13.103 Delete Individual Item(s)  

To delete a database item e.g. a curve, click on Delete Individual Item(s). The standard database file 
selection dialog appears. 
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FIG: 13.104 Select Database 

After selecting the database, the dialog for selection of the data item appears. 
Select the data item(s) to be deleted. All or no items may be selected by using the Toggle button. 
 

 
FIG: 13.105 Select Items 

A warning message appears informing that permanent data deletion is about to take place. 
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FIG: 13.106 Permanent Data Deletion 

 
DATA DELETED WITH THIS UTILITY CANNOT BE RECOVERED 
 

 
Clicking Yes in the above aborts the operation. Clicking No proceeds with the operation and allows the 
choice to repack the database file immediately or to defer the operation until later. 

 
FIG: 13.107 Deletion 

 

FIG: 13.108 Packing 

Clicking Yes causes the data item to be removed and the database repacked immediately and 
clicking No marks the data item for deletion, buts defers the packing of the data base. 
 

 
 

VIDEO: 13.8 Deleted data 
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13.5.8 Undelete Data 
 

 
FIG: 13.109 Undelete Data 
 
13.5.9 Rename a Data Item 
 

 
 
FIG: 13.110 Rename a Data Item 
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13.5.10 Edit a Log Curve 

 
FIG: 13.111 Edit a Log Curve 

 
FIG: 13.112 Select Pass for Curve to edit 
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FIG: 13.113 Select Curve 

 
FIG: 13.114 Plot Curve 
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FIG: 13.115 Zoom Curve 

 
FIG: 13.116 Draw  Curve 

 
FIG: 13.117 Curve List 
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FIG: 13.118 Plot Curves 
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13.5.11 Select Correlations Curves from Data Base 

 
FIG: 13.119 Select Correlation Curves to for Database 

13.6 Setup Tools 
13.6.1 Calibrate Printer 
In Utilities click on the Calibrate Printer button. 
 

 
FIG: 13.120 Select Calibrate Printers 
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FIG: 13.121 Select from Hardcopy Calibrate 

Select the printer to calibrate using the selection box. This printer may be made the Default Printer by 
checking the Default Printer box. 

 
FIG: 13.122 Select Make Test Print  

 
FIG: 13.123 Select Database to Plot 

The calibration is based on two parameters entered by the user. Enter the required length of print 
output for any given log interval, e.g. 10 inches for 200 feet of log on a 5-inch scale (5 in = 100Ft). 
It means Scale 1: 240.  Enter the actual length of plot currently output by the plotter for the same log 
interval. Press Calibrate. 
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FIG: 13.124 Calibrate 

Note that the required length can be any length, so that the current hardcopy may be forced to match 
any correlation log, even one with an incorrect hardcopy scale. 
 

 

FIG: 13.125 Click on OK  

 

VIDEO: 13.9 Printer Calibration 

13.6.2 Configuration Backup/Restore 
Every computer system will, sooner or later, suffer a failure, like a disk crash, where potential loss of 
programs and/or data is possible. This will generally happen at the most inconvenient time. The 
importance of keeping current backups cannot be overemphasized. It is vital that current 
backups are kept of all essential programs and data. 
The warrior system is usually configured for the selection of services to be run by a given client. This 
information is primarily contained in three files, namely warrior.ini, services.ini, and tools.ini.  A copy 
of all your files customized can be backed up to USB Memory/Hard disk/Floppy disk by using 
Backup/Restore utility 'Configuration Files'.  
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FIG: 13.126 Select Configuration Backup/Restore. 

13.6.3 Configuration Files 
Configuration files are the files that make one system different from another.  This includes Tools.INI, 
Services.INI, Warrior.INI and other initialization files. It also includes presentation files, heading files, 
logo files, tool drawings, DSP scripts, external calibration files, and other files that are particular to a 
given system setup. They do not include any of the program files for Warrior since these are the 
same for every system with a given software revision. 
A configuration file backup is normally made to removable media such as a floppy drive, CD, or a 
USB drive. There are two main purposes of a configuration backup. The first is to have a copy of files 
for a particular system off of the system in case of hard drive failure on the system. With a Warrior 
Installation CD and a configuration backup, the system can be restored to the same setup that was 
on the system when the configuration backup was made. The second purpose of a configuration 
backup is to transfer files, or portions on the files from one system to another. 
The User selects whether to do a backup or a restore by clicking on the appropriate option. When the 
[Select Defaults] button is clicked, a predefined set of files is chosen to either backed up or restored. 
If the [Clear Selections] button is clicked, then no files will be selected at that time to be either backed 
up or restored. If the alternate option of Back up selected files or Restore selected files is chosen, the 
default files are then reselected. The User then may select additional files, or deselect certain files by 
clicking on the box to the left of the file name. 
During a back up of configuration files, once the files have been selected, the User must select the 
Backup to file name. This can be done by either typing the path and file name into the Backup to text 
box, or by selecting the browse button to the right of the text box and selecting the drive and then  
typing in the file name. The selected files are then zipped and stored as the chosen file when the 
[Backup] button is clicked. 
To restore files, the User must select both the Restore from file and the destination Restore to folder. 
The browse buttons can be used to select the appropriate files and folders. With few exceptions, the 
Restore to folder should be C:\Warrior\. When the Restore from folder has been selected, the Select 
files to restore window will show the files that are in the backup with the files to be restored indicated 
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with a check mark. The User then may select additional files or deselect files by clicking on the box to 
the left of the file name. When the [Restore] button is clicked, the selected files will be restored.  
Care should be taken when restoring files from one system to a different system. Warrior.INI contains 
the Keycodes for software access. If it is over written and the new Warrior.INI does not contain a 
valid Keycode for the system, access to the software will be denied. 
 

 

FIG: 13.127 Select the Configuration Files Tap. 

If files are written to CD and subsequently restored to disk, they may be marked as read-only, which 
can prevent the proper operation of Warrior. This includes database files as well as configuration 
files. To change the attribute, use Windows Explorer, select the copied files, right click on them and 
select properties. Uncheck the 'Read Only' attribute and click the Apply button. 
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FIG: 13.128 Type Drive, File Name and Select Backup 

13.6.4 Configuration Restore 
There are three critical files that are required for acquiring data in a Warrior System. These are 
Warrior.INI, Tools.INI, and Services.INI. The User may select to do a backup when the computer is 
turned off after acquisition has been run. The maximum number of critical backups that will be 
retained is set to 50 by default. 
With User supplied software, selected backup critical files may be compared with active files.  
When the restore button is clicked, the selected set of critical files will be restored to the system. 
 

 

FIG: 13.129 Select Configuration Backup/Restore. 
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FIG: 13.130 Restore Select files 

 

FIG: 13.131 Restore All Files 

Restore of all your files customized can be restore from a USB Memory/Hard disk/Floppy by using 
Restore utility 'Configuration Files'. It means you restore all your presentations, tools string, services, 
key codes, etc. 
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13.6.5 Warrior Backup 
Warrior Backup is a utility used to backup and restore Warrior Software files. This can be a full 
backup of all files or a partial backup of only the files that have changed since the last backup.  It can 
also be a backup of only the configurations files that distinguish the system from other warrior 
systems. 

 
FIG: 13.132 Backup set to Defaults 

There are two typical procedures to start Warrior Backup. The first method is to select Warrior 
Backup from the Warrior 7.0 program group that is normally placed on the Windows desktop or from 
the Windows program list. Warrior Utilities could also be selected in the same manner, and then click 
on the Configuration Backup/Restore selection under Setup Tools. 
There are four page selections at the top of the Warrior Backup window, Backup, Restore, 
Configuration Files, and Restore Critical Files. Backup performs a backup of Warrior files to a drive 
on the computer. Restore will restore Warrior files done in a Backup into the Warrior folder on the 
computer. Configuration files for the Warrior System can be backed up and restored from this page. 
The three critical files, Warrior.ini, Services.ini, and tools.ini can be automatically backed up every 
time the computer is rebooted and then later restored from any of the backups. A short help file for 
each page is available by pressing the F1 key on the Keyboard. 
 
13.6.6 Backup Page 
The purpose of the Warrior Backup is to make a copy of the existing Warrior program, configuration, 
and auxiliary files. This is done so that if problems are found in files, either through the User making 
incorrect changes, a new bug in the software, or similar problems, then the User can restore the 
Warrior files to a know set of files that worked correctly for him. 
There are several options that can be set before a backup is performed. By clicking the [Set to 
Defaults] button in the upper right of the page, many of these will be performed automatically. Either 
incremental or full backups can be done. The default is to do an incremental backup of only the files 
that have changed since the last backup. 
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FIG: 13.133 Backup  Browse 
 
The maximum disk space that will be used for backup storage is initially set to 400 megabits. The 
default size will change depending upon the contents of the files in the Warrior Folder, but can be set 
by the User to any desired number of megabytes. If the maximum limit is exceeded, the User will be 
notified and asked if he wants to remove the oldest backup, this will be repeated until there is room 
for the backup to be completed or the User does not allow the oldest backup to be removed. The 
backup will then be performed, even if after the User has told it not to remove backups, it exceeds 
the maximum disk space set aside. 
Automatic backups can be performed by the Warrior system or can be turned off. It is recommended 
that automatic backups be done. The User can select whether he is notified that a backup is about to 
be done or not. If he is notified, he can elect to cancel the backup at that time. The default frequency 
for automatic backups is 30 days but can be set by the user. 
Normally the current Warrior installation directory is chosen for the files that are to be backed up, but 
the user can choose an alternate directory that contains Warrior files by clicking on the browse 
button. The backup location is initially set to the C:\warroldbin\ folder, but can be changed to a new or 
different folder by entering a new folder name in the text box, or by clicking on the browse button 
immediately to the right of the text box. 
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FIG: 13.134 Other directory Backup 
 
A text box is provided for the User to add additional information as to the reason the backup was 
done. This is to aid in selecting an appropriate backup set to restore. 
If a full backup of Warrior files is desired, then checking the Force total backup check box will do a 
backup of all files, otherwise an incremental backup of only the files that have changed since the last 
backup will be done. 
 
13.6.7 Restore page 
The restore page is used to restore the files made from previous Warrior backups that have been 
done on that particular system. Once the files have been restored, the system will be set up with the 
same files that it had when the restore was done. 
The Restore from default directory is C:\warroldbin\ and the Restore to default directory is 
C:\Warrior\. Each of these directories can be changed by clicking on the browse button to the right of 
the text boxes. 
Once a directory to restore from has been chosen, a list of Backup dates in that directory will be 
shown. Dates of full backups will be marked with an asterisk (*). When a date has been selected, a 
complete list of the files backed up on that date and a list of files that are different than the current 
files in the Restore to directory will be shown. Initially all files will be selected to restore. The User 
may wish to only restore certain files. He can do this by clicking on the [Clear Selected] button, then 
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clicking on the changed file that he wishes to restore. The User may restore multiple selections by 
holding down on the control key {ctrl} and then clicking on each file that he wishes to have restored. 

 
FIG: 13.135 Restore Browse 
 
When the [Restore] button is clicked, the selected files will be restored to the Restore to directory. 
 

 

VIDEO: 13.10 Backup/Restore 

13.7 Edit Logging service Details 
See Section 5 

13.8 Edit Logging Tools Details. 
See Section 6 
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14 Corrupted Database  
 

It is recommended to do a back up of the file before you begin 
this procedure. 

 
 
Run Windows Explorer.  
 
Warrior 16 Bit versions. Go to the C:\warrior\bin directory.  
 
Warrior 32 Bit versions. Go to the C:\warrior\bin32 directory. 
 
Find a file called dbdump.exe.  
 
Double click on dbdump.exe.  
 
This will open a window called Warrior Database Dumper. 
 
In this window click on file and click on Dump Records. 
 
Select corrupted database.  
 
Click on file again and click on Scan Linkage. 
 
Select corrupted database.  
 
Click on file again and click on Scan Data Blocks. 
 
Select corrupted database.  
 
Close the Warrior DataBase Dumper Window.  
 
There will be three new files in the c:\warrior\data directory.  
 
They will have the same name as the corrupted database with the following extension: 
dsc, scn, and dmp.  
 
Email these three files to sds.info@warriorsystem.com 
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The programmer will attempt to create a patch. The patch will be Emailed back to you and you will 
run dbdump.exe again from the   c:\warrior\bin directory 16 Bit Software, c:\warrior\bin32 32 Bit 
software. 
From the Data Base Dumper Window click on file, then click on Patch. Select corrupt database and 
following instructions in Email. 
An example of a patch is attached below. 
Example of Patch for data base 14377.db. 
A set of patch number will be supplied by Scientific Data Systems, Inc. 
Long word patch: 
  
Hex offset   Old Hex Value   New Hex Value 
------------    -----------------   ---------------- 
000000D8     02149C8A        037FFD5A 
00000378     02147B86        02112D6C 
 
This is an example so do not use these numbers, the correct numbers will be supplied by Scientific 
Data Systems, Inc. 
Open Dbdump.exe by double clicking on the file.   
 

 
FIG: 14.1 Run Dbdump.exe  

Click on File and then click on Patch: 
The Select Database for Manual Patch window will appear. 
Select the corrupted database and click on open. 

 
FIG: 14.2 Select Database 
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The Manual Patch window will appear: 
Do not enter anything in the Password box. 

 
FIG: 14.3 Manual Patch 

Long word patch: 
  
Hex offset   Old Hex Value   New Hex Value 
------------    -----------------   ---------------- 
000000D8     02149C8A        037FFD5A 
00000378     02147B86        02112D6C 
 
Select The Long Button, enter the Hex Offset number, the Old Hex Value will appear enter the New 
Hex Value, press apply. 
If more than one patch set of numbers were supplied enter the next set and select apply. 

 
FIG: 14.4 Set values 
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FIG: 14.5 Apply and Close 

Close the Manual Patch window, and the Warrior Database Dumper window.  The database should 
be accessible. 
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15 Math Pack 
A math pack output is created by a formula applied to one or more values from existing databases. 
A math pack job consists of one or more math pack outputs. Each math pack job is saved in a file 
with the extension ".wmp". 
 

 
FIG: 15.1 Warrior Utilities-Math Pack 

Math Pack user interface 
The Math Pack job file contains: 
A presentation file name and scale. 
Each output name, output units, data id, sample rate, description, and the formula used to create the 
output. 
The units for each input variable. 

Section
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Math Pack can be run from the command line - "Math Pack.exe [wmp file name]" to load a job file 
When the program loads. Note that the presentation file and scale will not be necessary if a Report is 
being generated. 

15.1 File Menu 
 

 
FIG: 15.2 Math Pack window. 

 
FIG: 15.3 Save Math Pack Job 

The file menu controls the Math Pack job files. The default directory for Math Pack jobs is "Warrior\ 
Config". The default extension is ".wmp". 
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15.2 Output  
Each output requires a formula to create the output. 
To create a formula, either select Output/Add from the main menu, or press the Insert key when 
inside the Output box in the Math Pack window. 
To delete a formula, first highlight the formula to be deleted. Then either select Output/Delete from 
the main menu, or press the Delete key. 
To edit a formula, first highlight the formula to be edited. Then either select Output/Edit from the 
main menu, or press the Enter key. 
 

 
FIG: 15.4 Output options 

 

FIG: 15.5 Output /Add 
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15.2.1 Output Units 
If an input variable has units selected as "None", then the units for that variable will come from the 
database, otherwise the selected units will be used. If the units for the output or input are "None", 
then no unit conversion will be done. Otherwise, an attempt will be made to convert the value from 
the input units to the output units. An example may be: 
CalAvg = (Cal1 + Cal2) / 2 
CalAvg units may be inches, Cal1 units may be mm, Cal2 units may be cm. 
Cal1 and Cal2 will be converted to inches before they are added together. 
 
15.2.2 Output Box 
The output box shows the output name, output sample interval, and the formula used to create the 
output. If the output sample interval is 0, then it will be calculated when the Run button is selected. 
The calculated output interval will be the maximum of the intervals of the input curves. Any zoned 
variables will be sampled at a rate of 600. 
 
15.2.3 Presentation / Scale 
The presentation file and scale to be used when creating a new pass. If the data is going to an 
existing pass, then the existing presentation and scale will be used. 
 
15.2.4 Main Input Data Source 
Will overwrite any data sources that were selected for particular curves. Will default data source for 
each formula variable to: field/well/run/pass/[variable name]/* 
At runtime, if it cannot locate field/well/run/pass/[variable name]/* then it will try to locate it as a zoned 
variable: field/well/run/pass/_vars_/[variable name] 
If that cannot be located, then a warning message will appear "Unable to connect to input [variable 
name] in [database]:[pass]" 
If the Output Data Destination is blank when this is selected, then a default new database name will 
be created. The new name will be: field/well/run/mpk_[x] where x increments for each math pack run. 
 
15.2.5 Output Data Destination 
This can be created automatically by selecting the Main Input Data Source first. This can be an 
existing database if the created curves do not exist already. If the created curves exist then the 
following message will appear: "Unable to create output [database]:[pass]/[variable name]/1" 
If you select Generate Report from the Options menu, then the destination will be the location of the 
embedded text report. 
 
15.2.6 Processing Interval 
To process the entire input interval, leave FROM and TO values as "*". 

15.3 Formula Editor 
15.3.1 DataID 
A value used for Warrior databases. Default is 0. 
 
15.3.2 Description 
This will be written to the output database along with the output name. 
 
15.3.3 Formula 
To see what functions are available, select the "f(x)" button. This will also show what parameters are 
needed for each function. There is a different set of formulas for the Report output and for the Curve 
output. The AVG curve formula will create a new curve which will be the average of one or more 
curves - i.e. AVG(GR1, GR2, GR3). The AVERAGE Report will create the average value of the 
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curve(s) over the entire interval. The MIN, and MAX functions are similar to the AVG function, and the 
MINIMUM and MAXIMUM functions work like the AVERAGE function. 
 

 
FIG: 15.6 Formula Editor 

15.3.4 Test 
This will run sample values through the formula and show the result. It will automatically fill the 
variables with values starting with 1 and incrementing for each variable. You can also test the formula 
with other values by placing a number in the Data Source box next to the variable name. 
 
15.3.5 Compile 
This will determine if the created formula will be able to compute a value. The Formula Editor window 
will change after the compile to show the new variable list. 
 
15.3.6 Data Source 
Select the Curve button to select a curve from a dataset. Select the Var button to select a zoned 
variable from a dataset. This will be the source of the data for each variable. This will also be filled in 
if the Main Input Data Source from the Main Window is selected. 
 
15.3.7 Variable Units 
To override the units from the database, change this setting; otherwise leave it "None". Also see 
output units. 

15.4 Options 
The Math Pack program will generate two types of outputs - curves and reports. The curve output will 
create another log pass with the output curves generated by applying the formula at each data point. 
A report output will generate an embedded text report, which will contain the results of the formula(s) 
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applied to all of the data points over the entire interval. The output data destination will be the 
location of the embedded text file in the database. 
 

 
FIG: 15.7 Options 

15.5 Demo example 
Create a new Math Pack Job  (demo), Add new output curve (GRADD), Select GR curve from DB 
CBLDEMO, ADD 200 API, and plot. 
 

 
FIG: 15.8 New Job Math Pack 

Type new Math Pack job “demo’ 
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FIG: 15.9 Formula Editor Setup 

ADD or create a formula, either select Output/Add from the main menu, or press the Insert key  
Type on Name box “GRADD” 
Type on description box  “Gamma Ray ADD “ 
Type the formula GR+200 
Type the formula and click on Test  
Click on Save 

 

FIG: 15.10 Run Math Pack 

Select Main input data source from the warrior Data Base (CBLDEMO)  
The Output Data Destination can be created automatically by selecting the Main Input Data Source 
first. 
Click on Run  
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FIG: 15.11 Select New Curve 

Add a new curve GRADD 
 

 

FIG: 15.12 Set Curve 

Set Scales and Track values 
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FIG: 15.13 Plot Curve 

Plot the Curve GRADD 
 
 

 
 

VIDEO: 15.1 Math Pack 
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16 Simulator Box 
The USB Simulator connects to the USB port of the system pc and receives 5-volt power up to 
500ma from it.  Tool waveforms can be downloaded and then played back in analog form through the 
line or directly into the system.   Outputs to test the Depth Encoder and Tension are also provided. 
 

 
FIG: 16.1 Simulator 

When the USB Simulator is powered up by plugging it into the USB port of a PC or the USB HUB of a 
Warrior Interface panel, it goes through a two-step enumeration according to the device code found 
on EPROM IC5.    Double clicking the SIMULATOR icon in the Warrior panel will bring up the control 
window.   
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FIG: 16.2 Simulator Controls 

Select LOAD and choose the tool waveform from a list.  These files are located in the Warrior Bin 
directory. 
 

 
FIG: 16.3 Simulator tool files 
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FIG: 16.4 Power Control 

 
FIG: 16.5 Outputs 

To playback the waveforms press the START button. 
There are slides for Encoder Speed and Output Gain.  The Encoder speed will depend on what 
number is input for pulses/foot.  120 should give a reasonable range.  If less speed is needed change 
the number to 600 pulses per foot.  There is a button for high and long range.  Low range will provide 
speeds less than 100 feet per minute.  There is a button for changing the direction, up/down. 
The Depth Encoder power from the interface panel lights an LED or both if it is twelve volts. 
 

16.1 Circuit Description 
The simulator gets its intelligence from IC1 – a Cypress AN2131Q EZ-USB controller with 8k of 
internal ram.  An external 128k x 8 static ram, IC2 - CY71019B – is used to store waveform data.  IC5 
- 24LC00P, EPROM is used to store the USB address code so the device enumerates as a Simulator 
and not as something else. 
IC6 provides 3.3 volts for most of the logic from the USB 5 volt supply.   A DC-DC Converter supplies 
+/- 12 volts from the 5 volts supplied by the USB port.  An external 5-volt supply can be used if it is 
needed. 
The encoder frequency is set by OUT0 from DAC, MAX519.  The DAC output goes to a voltage 
divider to reduce the 0 to 5 volt swing to 0 to 1 volt for the V to F converter, IC10, AD654.  Software 
controls the high and low range of the encoder speed.  The output frequency goes to IC9B, buffer, 
and then is split and one side inverted.  One side goes to IC12A, and the other to IC12B, SN74LS74, 
dual D flip flop.  These are wired to give two wave trains 90 degrees apart.  The A signal goes to 
Encoder Out A.  The B side goes to IC9A where PA5 sets direction.  When PA5 is changed the 
output of IC9A will be inverted.  That is how UP/DOWN is controlled.  The signal then goes to 
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Encoder Out B.  IC7 and IC8 test the ENCODER voltage, lighting one led if it is five volts, or both 
leds if it is twelve volts.  The encoder pulses are derived from the supply voltage.  A 5 volt supply 
produces 5 volt pulses and a 12 volt supply produces 12 volt pulses. 
SDA and SCL from IC1 control the DAC.  IC4 address lines: 01000000 address byte. 
PA6 controls IC14, DG411, switch.  It connects R32 for 20ma and disconnects it for 2ma.  The 12 
volts from the STIP is converted to a current by IC7, LM317 to furnish the output signal.   The circuit 
will accept a 24 input also. 
The data loaded into the ram, IC2, is sent to the DAC a byte at a time and reproduces whatever 
waveform has been recorded.  The chip enable comes off A15 to allow memory paging.  It is 
inverted.  Write enable and out enable are active low.  A15 is used because we are only interested in 
high addresses.   A16 comes from PC1/TXDO.  R36 was added to shift the DC offset of the DAC to 
zero.   The signal is sent from the DAC to U2A, TL082P, op amp, and then to U3, AD633, and 
voltage multiplier, through a 1K resistor.  The multiplier voltage is supplied by IC4, serial DAC, and 
OUT1, which set the output gain.  The signal then goes to U2B and IC3, BUF634, op amps to the line 
out connector. 
Cable to Encoder and Line Weight: 

16.2 SIMULATOR Hookups 
  
5 PIN MALE - Tension -------------------------Interface Panel    
 
A – TENSION SIGNAL GROUND REF ----------A 
B – TENSION SIGNAL OUT -----------------------B 
C – Tied to E   ------------------------------------------C 
D – +12 VOLTS IN------------------------------------D 
E – GROUND ------------------------------------------E 
 
7 PIN MALE – Depth Encoder 
  
 A – ENCODER-A 
 B – ENCODER-B 
 C – N/C 
 D – ENCODER POWER IN  
 E - GROUND 
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FIG: 16.6  Simulator Box Hookups 
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FIG: 16.7 USB SIM R2 board layouts 
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FIG: 16.8 USB SIM R2 Schematic 
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FIG: 16.9 USB SIM R2 Schematic 
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17 Recorder 

17.1 Warrior Line Signal Recorder Service 
With the Recorder service, it is possible to make a recording of the line signal with minimal filtering. 
The recording can then be used to make a Simulator file to play back into the system through the 
Scientific Data Systems Simulator Box. Or the recorded file can be sent to Scientific Data Systems to 
check the tool telemetry or set up a new service for the tool telemetry. The recorder service is not 
normally installed as one of the default services. The service can be imported through the Service 
Editor.  

 
FIG: 17.1 Select Edit logging Details 

To install the Service Editor, go to Warrior Utilities and click on [Edit Logging Service Details]. To 
Import the Recorder Service, Click on Service ->Import. From the Warrior\Config folder, choose the 
CH USB 70.WSV file and click the [ Open ] button. From the service import list, choose the 
Recorderservice. It will then be added as the last service in your active service list. The Service 
Editor and Utilities can now be closed. If Acquisition is open, it will have to be closed and then 
reopened before the Recorder service will be available. 
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FIG: 17.2 Service\Import 

 
FIG: 17.3 Import Recorder service 

To make a line recording, start Acquisition and select Service -> Recorder. When the Tool String 
editor comes up, click [ Save ] or [ Exit ], there are no tools to select or edit. In the Acquisition window 
click on Action -> Power Control and enable the line in the normal manner. Adjust tool power for 
proper operating voltage and current for the tool that you are using. The Recorder Threshold window 
will show a sample of the signal that will be recorded. No adjustments are necessary in the Recorder 
Threshold window. 

 
FIG: 17.4 Recorder  
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FIG: 17.5 Set up Signal Recorder 

There are two other windows that come up when the Recorder service is started. These are the 
Panel Controls window and the Signal Recorder Setup window. The Panels Controls are not normally 
used unless the default Input Channel is changed from 15 to a channel that corresponds to the Sync, 
Aux, or Sonic input channels. This will be discussed further later. 
There are 4 settings in the Signal Recorder Setup window that can be adjusted. If any of these 
settings are changed, the [Apply Settings] button must be clicked before the recording is done, 
otherwise the original settings are used. 
The Input Channel is the selected DSP input channel (0 to 15). These channels are hard wired within 
the Warrior Interface Panel. Channel 15 comes from the ANASW board. The signal has been 
capacitive decoupled from the line and ran through a buffer. It is as true a raw signal as the system 
can digitize.  
The Sample Rate is how often the DSP will digitize the incoming signal. A 5us rate is appropriate for 
most recordings. It should not be set to lower than 3us. 
Signals may be attenuated on the DSP before they are digitized. Before doing a recording, the 
Attenuation setting should be adjusted to maximize the signal in the Recorder Threshold Window. 
The signal should not go to the top or the bottom of the window. The smaller the Attenuation setting 
value, the larger the signal will be. An Attenuation of 100 will not show any signal and will not give a 
usable recording. 
The record time is the number of seconds that the signal is recorded.  
When settings have been adjusted as needed and the [Apply Settings] button has been set, the next 
step is to click the [Record] Button. You will need to select a file name to save the file. It is 
recommended that the file extension show the sample rate so that the file can be played back at the 
appropriate rate to give a valid recording such as 5us for a 5-microsecond sample rate. Once the 
[Save] button is clicked, the recording will start and continue for the number of seconds set in the 
Record Time setting. The Record Time will count down showing the number of seconds left to record 
until the recording is complete. 
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FIG: 17.6 Save the Recorder signal 

The following is a list of the Hard Wired DSP channels in the SDS Interface Panel. 
 

Input Channel Signal Note 
0 Sonic Amplitude Configurable Filter 
2 Audio X10  
3 Audio X1  
4 Sync / Pulse Configurable Filter 
5 Audio X.1  
6 Audio X.01  
8 AUX Configurable Filter 
15 ANASW Signal Recorder Default  

 

17.2 Converting Recordings to SDS Simulator Box Files 
The recording must first be converted from a DSP recording to a WAV file and then the file must be 
edited to fit a format needed by the simulator box.  
In Warrior\Bin32 is SIMConvert.exe that will read in a recording and write a WAV file. Click on the 
[Load Oscope File] button to select the DSP recording. After loading the file and before writing the 8 
Bit Wave file, be sure that the sample period matches the sample rate done during the recording. For 
simple recordings, the difference in the Start Sample and Stop Sample should be less than 128000, 
since this is the maximum number of samples the Simulator box can hold. Click the [Write 8 bit 
Wave] button to write the file. If this is a simple file, it can be saved with a .SIM extension and used 
directly by the Simulator Box. 
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FIG: 17.7 SIM convert 

 
FIG: 17.8 Open  

 
FIG: 17.9 Save As 

With more complex recordings, it may be necessary to use a Wave Editor to view and modify the 
recording before converting it to a simulator file. The Warrior software does not include a waveform 
editor, but there are many free editors available through the Internet. The following Internet link is a 
down load for a very versatile editor - http://www.yamahasynth.com/download/twe.html. 
If the signal being recorded has a periodic rate, the waveform should be edited to start before a given 
point in the period of the signal and to end before the same point at a number of cycles later in time 
and keep below the 128,000-sample limit of the Simulator Box. The waveform editor could also be 
used to adjust the amplitude of the recording or insert or enhance features in the recording, such as 
gamma pulses in a bond tool recording. 

http://www.yamahasynth.com/download/twe.html
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18 Multi-Arm Caliper 
This program will read in LAS data from a Multi-Arm service and create a single pass in a Warrior 
database.  This pass will not only contain the curves found in the LAS data, but will also create a 180 
point VDL curve by interpolating between each of the Multi-Arm caliper readings.  This program also 
contains a viewer that can display a 3 dimensional view of a section of the Multi-Arm data. 
The first step is to import the Multi-Arm data in to a Warrior database.  Use the build button (…) to 
select the LAS file to import. 
Color maps are used by the Multi-Arm program and by Iplot to create the range of colors used to 
draw the diagrams.  To have the color of the VDL in Iplot match the Multi-Arm plot,  have them use 
the same color map.  To make the VDL plot match, use the Minimal value for the VDL black level, 
and the Casing OD value for the VDL white level. 
In warrior.ini go to the section [Color Maps].  Once you have run the Multi-Arm program at least once, 
there should be an entry called MultiArm. 
 
[Color Maps] 
1=GrayScales 
2=Sectors 
3=Colors01 
4=MultiArm 
 
In the [Screen] section there should be an entry like this  
MultiArm=69,{96,0,0},{112,0,0},{128,0,0}, etc. 
From Iplot, plot the SIG curve as a Variable Density presentation type, and select Multi-Arm for the 
Color Map.  Scale from 0 to 180 to see all the points.  Now the color of the 3-D plot should match the 
VDL.  For the hardcopy to match, you also need an entry under the section with your printer name 
like the one in the [Screen] section. 
To change the color map used for the XY plot, go to Multi-Arm Plot Options, select the color map you 
want to use from the list of color maps, and select the Load button.  Any future plots will default to the 
plot option you have selected. 
You can make your own color maps from the Warrior Log Format Editor.  Select “Color Maps -> Edit” 
from the main window 

18.1 Caliper Presentation 
The presentation file will be embedded in the database as the presentation to be used when the data 
is plotted.  This can be edited later. 
Edit the warrior.ini with your NotePad (copy and Paste) 
Add under [Color Maps] spectrum 
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Open with NotePad the file Color Map and copy and paste in Warrior.init 
Add in warrior.ini 
Spectrum=253,{204,51,51},{205,50,50},{207,48,48},{208,47,47},{210,45,45},{211,44,44},{213,42,42},{214,41,41}
,{216,39,39},{217,38,38},{219,36,36},{220,35,35},{221,34,34},{223,32,32},{224,31,31},{226,29,29},{227,28,28},{2
29,26,26},{230,25,25},{232,23,23},{233,22,22},{235,20,20},{236,19,19},{238,17,17},{239,16,16},{240,15,15},{242
,13,13},{243,12,12},{245,10,10},{246,9,9},{248,7,7},{249,6,6},{251,4,4},{252,3,3},{254,1,1},{255,0,0},{255,0,0},{2
55,7,0},{255,15,0},{255,22,0},{255,29,0},{255,36,0},{255,44,0},{255,51,0},{255,58,0},{255,66,0},{255,73,0},{255,8
0,0},{255,87,0},{255,95,0},{255,102,0},{255,109,0},{255,117,0},{255,124,0},{255,131,0},{255,138,0},{255,146,0},{
255,153,0},{255,160,0},{255,168,0},{255,175,0},{255,182,0},{255,189,0},{255,197,0},{255,204,0},{255,211,0},{25
5,219,0},{255,226,0},{255,233,0},{255,240,0},{255,248,0},{255,255,0},{255,255,0},{248,255,0},{240,255,0},{233,
255,0},{226,255,0},{219,255,0},{211,255,0},{204,255,0},{197,255,0},{189,255,0},{182,255,0},{175,255,0},{168,25
5,0},{160,255,0},{153,255,0},{146,255,0},{138,255,0},{131,255,0},{124,255,0},{117,255,0},{109,255,0},{102,255,
0},{95,255,0},{87,255,0},{80,255,0},{73,255,0},{66,255,0},{58,255,0},{51,255,0},{44,255,0},{36,255,0},{29,255,0},
{22,255,0},{15,255,0},{7,255,0},{0,255,0},{0,255,0},{0,255,7},{0,255,15},{0,255,22},{0,255,29},{0,255,36},{0,255,4
4},{0,255,51},{0,255,58},{0,255,66},{0,255,73},{0,255,80},{0,255,87},{0,255,95},{0,255,102},{0,255,109},{0,255,1
17},{0,255,124},{0,255,131},{0,255,138},{0,255,146},{0,255,153},{0,255,160},{0,255,168},{0,255,175},{0,255,182
},{0,255,189},{0,255,197},{0,255,204},{0,255,211},{0,255,219},{0,255,226},{0,255,233},{0,255,240},{0,255,248},{
0,255,255},{0,255,255},{0,248,255},{0,240,255},{0,233,255},{0,226,255},{0,219,255},{0,211,255},{0,204,255},{0,
197,255},{0,189,255},{0,182,255},{0,175,255},{0,168,255},{0,160,255},{0,153,255},{0,146,255},{0,138,255},{0,13
1,255},{0,124,255},{0,117,255},{0,109,255},{0,102,255},{0,95,255},{0,87,255},{0,80,255},{0,73,255},{0,66,255},{0
,58,255},{0,51,255},{0,44,255},{0,36,255},{0,29,255},{0,22,255},{0,15,255},{0,7,255},{0,0,255},{0,0,255},{7,0,255}
,{15,0,255},{22,0,255},{29,0,255},{36,0,255},{44,0,255},{51,0,255},{58,0,255},{66,0,255},{73,0,255},{80,0,255},{8
7,0,255},{95,0,255},{102,0,255},{109,0,255},{117,0,255},{124,0,255},{131,0,255},{138,0,255},{146,0,255},{153,0,
255},{160,0,255},{168,0,255},{175,0,255},{182,0,255},{189,0,255},{197,0,255},{204,0,255},{211,0,255},{219,0,25
5},{226,0,255},{233,0,255},{240,0,255},{248,0,255},{255,0,255},{255,0,255},{251,0,251},{248,0,248},{244,0,244},
{240,0,240},{237,0,237},{233,0,233},{230,0,230},{226,0,226},{222,0,222},{219,0,219},{215,0,215},{211,0,211},{2
08,0,208},{204,0,204},{201,0,201},{197,0,197},{193,0,193},{190,0,190},{186,0,186},{182,0,182},{179,0,179},{175
,0,175},{172,0,172},{168,0,168},{164,0,164},{161,0,161},{157,0,157},{153,0,153},{150,0,150},{146,0,146},{143,0,
143},{139,0,139},{135,0,135},{132,0,132},{128,0,128},{128,0,128} 
 
Run Multiarm.exe from Warrior\Bin32 (double click over multiarm.exe file) 
Select the Las File 
Select The Presentation file (multiarm.prs) 
Select the output database Select an existing database or type in a new database name.  Fill in the 
field/well/run portion of the dataset.  The name of the pass will always be the same as the LAS file 
name. 
Type AM, It is mnemonic in your DB or LAS  
Set the offset between calipers to show all the calipers in one track  
Type the VDL output name (the name that you referrer) 
If you just have LAS then select import from LAS. If you have the database select create VDL 

18.2 Output curves 
The program will search through the Multi-Arm LAS data for caliper curves that start with this name – 
i.e. ARM1, ARM2, etc.  It uses these names to create the 180 point interpolation for the 3-D view.  
The offset between each caliper is automatically applied to the presentation file to display the 
individual arm data.  An offset of 0 would put all of the arm curves on top of each other which may 
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make it difficult to see responses of individual curves.  The VDL output name is the name of the 
curve that will contain the interpolation of the caliper data.  This curve will contain 180 data points for 
each depth sample. 

 
FIG: 18.1 Set up Multi-Arm Caliper 

Start the process to convert the LAS to BD It takes long time for example to produce 1Gb of the DB 
takes close to 25 minutes. 

 
FIG: 18.2 Warrior Data Import 
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FIG: 18.3  Read LAS data 

 
FIG: 18.4   Creating VDL  

When finished the conversion Select Create VDL  
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FIG: 18.5   Start Plot 

Select Start plot 
. 

 
FIG: 18.6   Select Data Item 

Define the parameters for DB item (multiarm)  
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FIG: 18.7   Set presentation. 

Define the parameters for DB item (INSIDE) 
 

 
FIG: 18.8  Select option to set the XY plot 

18.3 Edit Presentation 
A pseudo-curve will be created called MULTIARM.  In Warrior terms the MULTIARM curve is a “curve 
list”.  Rather than setting up 15 curves to plot from Iplot, the MULTIARM curve contains all the 
information to plot those 15 curves.  So from Iplot you only need to set the scale and position of the 
single MULTIARM curve.  The color and style of each individual curve is set up with this dialog.  A 
different offset can be applied to each curve so the activity of each caliper can be viewed much 
easier. 
The left hand side of the Presentation dialog contains all of the curves that will make up the 
MULTIARM curve list during the plot.  From the plot program, the scaling and location of all of these 
curves will be done by editing the “MULTIARM” curve.  But the color, thickness, style, and offset of 
each curve will be set from this dialog.  This information is saved in the database for that pass.  Only 
the scaling and location of the MULTIARM curve will be saved with the presentation information. 
If you select “Pick first caliper name” to choose the first caliper name from the pass you have already 
selected, the list of all outputs for your pass will be shown.  Then you can choose the first caliper 
name in the list to create the Base caliper name. 
 
18.3.1 Create VDL: 
A cubic spline interpolation will be done between each caliper reading to create a 180 point curve.  
The name of the curve will be whatever is entered as VDL output name.  This curve will be used to 
do the plotting in the 3-D window and can also be plotted as a curve from Iplot. 
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FIG: 18.9  Multi-Arm Plot Options 

18.3.2 What to Plot 
Select the check box of the item you would like to view.  Select the Color button to change the color 
of the item to be viewed.  The background color and the color of the text can also be changed.  The 
Opacity value is how transparent the front part of the image is.  An opacity of 100 means that you can 
not see through the image to the back side at all.  An opacity of 0 means the front part of the image is 
not visible at all. The Casing ID and Casing OD values will be read from the database.  Select Edit 
ID,OD to change these values.  The default ID and OD values will be read from the LAS file entry that 
looks like the following: 
 
# User Entered ID = xxx 
# User Entered OD = xxx 
 
The Casing ID and OD values can change with depth.  Select the Zones button from the Variable 
Edit box to make more than one set of values. 
Minimal Diameter: 
The Minimal Diameter value is calculated to be the Casing ID minus the difference between the 
Casing OD and Casing ID.  The Casing OD will then be the center of the range of colors to be 
plotted.  To make the VDL plot match, use the Minimal value for the VDL black level, and the Casing 
OD value for the VDL white level. 
 
18.3.3 Depth Axis 
The Depth Axis will display a depth scale to the side of the diagram.  The scale will be rotated with 
the image.  If this option is not selected, then the depth and range will be displayed in the lower left 
corner of the diagram. 
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18.3.4 Plot Resolution 
To speed up the plot to the screen, you can decrease the plot resolution.  High resolution will plot all 
180 data points for each sample.  The lower the resolution the less data points will be plotted for 
each sample.  A resolution of 2 will plot 180/2 data points for each sample. 
 
18.3.5 Make Window Bigger 
The “Make window bigger” option will change the range of values to plot.  If it is zero, then the range 
of values will be from Minimal to OD.  If it is 25, then the width of the window of data to plot is 25% 
greater than the value OD – Minimal.  If this value is not zero, then to make the colors of the VDL 
match, you must use the range shown next to the spectrum, not the raw Minimal/OD values. 
 
18.3.6 Bulge Factor: 
The Bulge Factor will amplify the drawing by applying a magnifier to any reading that is different from 
the Casing ID.  The Casing ID is taken to be a Nominal reading.  If the value is less than the ID, then 
the caliper will be drawn as a value smaller than the actual reading.  If the value is greater than the 
ID, then the caliper will be drawn as a value larger than the actual reading – hence the bulges in or 
out will be amplified.  Here is how the value to be plotted is calculated: 
    Dif = Real Value – Inside Diameter; 
    Value to Plot = Real Value + Dif * Bulge Factor 
To not amplify the bulges, enter 0 for a bulge factor. 
 
18.3.7 Line Width 
The 2-D line width is the thickness of the lines used for the 2-D plot. 
 
18.3.8 Logo 
On hardcopies and saved pictures, you have the option to add a logo to the upper left corner of the 
picture.  The logo must be a Windows metafile format. 
 
18.3.9 Plot Range 
The Plot range is how tall the section of the log you want to view.  The larger the range, the more 
points will be plotted, so you may want to increase the Undersample and Plot Resolution values to 
speed up the plot. 
 
18.3.10 Undersample: 
The 3-D view is created by a series of rings.  Each ring is one depth sample.  The undersample value 
is how many samples separate each ring.  For the highest detail, set the undersample value to 1.  
Then the rings will be 1 sample apart, but it may take longer to draw.  Increase the undersample 
value to speed up the plot, but decrease the resolution.  The Actual value is what is actually used to 
draw.  This number will never be smaller but may be larger than the undersample value.  If your plot 
range is 200 ft. and your sample rate is 60 samples/ft, the undersample value may be 10 or 20 or 
more.  This value takes in to account the resolution of the screen or printer and computes the lowest 
sample value needed to draw the diagram to that resolution.  To draw to the absolute best resolution, 
leave the undersample value at 1.  If the actual value is 20, then to see any increase in plot speed, 
you need to make the undersample value greater than 20. 
 
18.3.11 Save/print Resolution 
When you print, the larger the value for the resolution, the better quality the print is, but the longer it 
will take to print.  For highest quality prints, set this to the resolution of the printer.  The larger the 
save resolution value is, the larger the file size will be, but the better the resolution will be when the 
file is viewed/printed later.  The default value for this is 100 to give fast yet good quality images. 
 
18.3.12 Perspecive Image 
 If this option is yes, then the image will be drawn with a perspective view with items closer to the 
viewpoint being shown larger than items farther from the viewpoint.  The viewpoint will be the center 



392 Warrior Software Version 7.0 Standard Cased Hole 

of the image.  If the option is no, then the image will be drawn with all points drawn as if they were 
the same distance from the viewpoint. 
 
18.3.13 Saving 
The plot can be saved in different file formats.  Choose the format for the image to be saved as from 
the list at the bottom of the dialog that comes up when you select the save button.  The image will be 
saved at the resolution that is set from the Options dialog. 
 
18.3.14 Set the XY plot option 
Note to increase the speed to print out set the value Actual more than 100 you should play with the 
Plot range and Undersample. 
 

 
FIG: 18.10  IPLOT 

Right click on depth track to update the XY plot and show the first time 
 
18.3.14.1 3-D 
Use this button to toggle between a 3-D view and horizontal cross section of the readings at the 
selected depth. 
Click over 3D to see all the arms values. 
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18.3.15 Cross-section, Wireframe 
The cross section button will do a vertical cross section.  The wireframe view will show how the 
diagram is created.  Each intersection of the wire frame is one data sample. 
 
18.3.16 XY, Z rotation 
When these buttons are pressed, use the mouse to drag and drop the image to another view, or use 
the arrow keys to rotate the image.  You can also right-click in the image to activate the XY rotation 
and then rotate the image by moving the mouse without having to hold down the left mouse button.  
Right click again to deactivate. 
 
18.3.17 Zoom in, Zoom out 
With the Zoom in button selected, click on an area of the image to zoom in to.  Click on the zoom out 
button to zoom back out. 
 
18.3.18 Start Plot 
This will start off Warrior Iplot and will also start the Multi-Arm XY Plot window.  From the Warrior Iplot 
window, left click on any depth and an area around that depth will be displayed in the Multi-Arm XY 
Plot window.  Right click on any depth in the Warrior Iplot window, and that window becomes 
sensitive to the mouse movements.  As you move the mouse up and down, the Multi-Arm XY Plot 
window will be continuously updated.  Right click again to disable the updates. 
Save to storage a snap shot Pdf, TIFF, BIM formats  
 
The Plus and Minus keys will always zoom in and out from the center of the diagram.  Select the 
magnifying glass to zoom in to a particular point.  Use the tab keys to move between menu items.  
Use the space bar or enter key to select the chosen item from the menu.  If the zoom and rotation 
buttons are not selected, then you can click on the image to drag to move the entire image. 
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19 Panels Hookups 
DEPTH CABLE 
Depth Panel 7 Pin Female     Interface Panel 7 Pin Male 
 A       A (Signal A) 

 B       B (Signal B) 
 D       D (5 Vdc) 
 F              F (GND) 
 G 
            
ENCODER CABLE 
7 Pin Male       Depth Encoder 7 Pin Female 
 A       A (Signal A) 
 B       B (Signal B) 
 D       D (5 Vdc) 
 F           F (GND) 
 G 
TENSION CABLE 
Depth Panel 5 Pin Female     Interface Panel 5 Pin Male 
 C       A   
 D       B 
 E       E  
 
TENSION TRANSDUCER CABLE (XPRO-HONEYWELL PRESSURE 
TRASMITER) 
 5 Pin Male       Pressure Transducer  
 D       1 (Excite Usually Red)   
 B       2 (Signal Usually Black) 
 A        Shield           3 (Case) 
 E 
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TENSION TRASDUCER CABLE  (ASCO PRESSURE TRANSMITER) 
5 Pin Male       Pressure Transducer  
 D       3 (Excite Usually Red)   
 B       2 (Signal Usually Black) 
 A              Shield           
 E 
 
DC CABLE 12V DC 
3 or 2 Pin Male      Battery Truck (12 VDC)  
 A       Positive   
 B       Negative 
 C       NC 
 
LIGHTS CABLE  
4 Pin Male       Lights  
 A       Common   
 B       RED Light 
 C       GREEN Light 
           D       NC 
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20 Job Planner 
The primary purpose is to assist in the design and assembly of perforating strings and help the user 
execute perforating and TCP jobs.  For TCP jobs, the end result will be an inventory of all the items 
required to complete your TCP string.  For wireline jobs, you will have a list of all the runs you plan on 
making and the design of each tool string that goes in the hole.  For either type of job, you build every 
gun to your specifications, and then add all the other components required to complete the tool 
string. 

20.1 TCP Jobs 
For TCP, the job table will be the inventory list of all the items that will go in the hole. 

20.2 Wireline Jobs 

 

FIG: 20.1 Job Plan  

For Wireline jobs, the job table will be a list of all depth intervals that you will be dealing with during 
your job.  One line in the job table will indicate either a depth to be perforated or a depth to set a plug 
or a depth to cut casing. 
Each job consists of 1 or more Runs.  Each Run contains 1 or more Intervals.  Each run has a Base 
Service.  The Base Service is what service will be run in the hole that will be attached to the gun, 
plug, whatever.  Each interval consists of either a single depth or a single depth range (top depth - 
bottom depth).  A run may contain more that 1 interval if the string contains a select fire assembly, or 
is a core gun, or is any other combination of devices that can be activated over more that one depth 
or depth range.  The other possibility is that you may have more than one interval that will be part of 
one gun.  If you have to perforate from 5000-5002 and 5008-5010, then that may be achieved with 1 
10’ carrier but will still have to be entered as 2 intervals.  The program will verify with the user if two 
intervals can be placed in the same carrier and that will be shown in the Job table by two intervals 
with the same serial number.  Serial numbers of guns will be generated by the system and not 
editable by the user. 
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One interval takes up one line in the Job table.  An interval consists of a single depth or a single 
depth range (top depth - bottom depth).  An interval must be associated with a run name and a base 
service and also must consist of some type of device. 
here are two types of inventory you will need to do in order to take full advantage of the job plan 
module. 
 
20.2.1 Tools Inventory: 
Since the purpose of this is to design perforating and TCP jobs, to start you need to make entries for 
all the equipment you will run in the hole using the Tools Editor.  This includes gun subs, sinker bars, 
tandem subs, setting tools, firing heads, etc.  Some items you may want to create as non-serial items 
so you can add as many to a tool string as you need.  In order for this to properly calculate offsets 
and tool string lengths, all items that go in the hole that modify the length of the tool string need to be 
added to the tool string through the tool string editor.  For example, if you choose a 10’ carrier for a 
perforating job, that carrier will automatically be added to the bottom of the service you have chosen.  
But you will have to add the top and bottom gun subs to the tool string through the tool string editor. 
 
20.2.2 Perforating Inventory: 
From the job plan module, you can create the gun types that you use.  From job plan menu select 
Job->Wizard, and then go to the Build guns tab.  From there you can create your gun types and 
charge types that you use.  Right click on the Gun Type, and then select New Item or New Category.  
Each gun type can have 0 or more categories and each category can have 0 or more items 
associated with it.  Categories are optional.  For each item you create, you will see a picture on the 
right side.  Just click on the item you want to edit.  When you are done, select Save gun type.  Now 
when you go to creating a perforating job, you will select from your inventory and the gun will 
automatically be filled in with the requested shot length.  You will be warned if the requested shot 
length does not fit in the gun you selected. 

20.3 Getting Started 
There are two types of inventory you will need to do in order to take full advantage of the job plan 
module. 
 
20.3.1 Tools Inventory: 
Since the purpose of this is to design perforating and TCP jobs, to start you need to make entries for 
all the equipment you will run in the hole using the Tools Editor.  This includes gun subs, sinker bars, 
tandem subs, setting tools, firing heads, etc.  Some items you may want to create as non-serial items 
so you can add as many to a tool string as you need.  In order for this to properly calculate offsets 
and tool string lengths, all items that go in the hole that modify the length of the tool string need to be 
added to the tool string through the tool string editor.  For example, if you choose a 10’ carrier for a 
perforating job, that carrier will automatically be added to the bottom of the service you have chosen.  
But you will have to add the top and bottom gun subs to the tool string through the tool string editor. 
 
20.3.2 Perforating Inventory: 
From the job plan module, you can create the gun types that you use.  From job plan menu select 
Job->Wizard, and then go to the Build guns tab.  From there you can create your gun types and 
charge types that you use.  Right click on the Gun Type, and then select New Item or New Category.  
Each gun type can have 0 or more categories and each category can have 0 or more items 
associated with it.  Categories are optional.  For each item you create, you will see a picture on the 
right side.  Just click on the item you want to edit.  When you are done, select save gun type.  Now 
when you go to creating a perforating job, you will select from your inventory and the gun will 
automatically be filled in with the requested shot length.  You will be warned if the requested shot 
length does not fit in the gun you selected. 



402 Warrior Software Version 7.0 Standard Cased Hole 

20.4 Job Wizard 
Use the Job Wizard to complete the information for your job.  You will have 4 pages (tabs) of 
information to fill out.  The first 3 tabs will be the same whether you are doing a TCP job or a Wireline 
job. 
 

 
FIG: 20.2 Job Wizard  

 
20.4.1 Job information 
You can enter the database name of the correlation log here.  If you have a correlation log entered 
here, when you set your results, a well object will be added to this pass indicating the completion of 
that interval.  All of the other information is for reference use only. 
 

 
FIG: 20.3 Job Planner  
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20.5 Shot Depths 
Enter your shot depth information here.  Fill in the job table with shot depths or select an item from 
the list to edit.  To enter a new interval, if the button says Update interval, press the Clear selection 
button.  Then type in your new depths and select the Add interval button. 
 

 
FIG: 20.4 Job Planner 

20.6 Build Guns 
Now that you have intervals in your table, you need to assign a gun type to your depth interval.  If you 
have no gun types in your list, then you have to create new ones (see Gun types below).  To assign a 
gun type, first select the interval from the list of intervals, and then choose the gun type from the list 
of gun types.  If you want more than one interval to fit in one gun, then select more than one interval 
by using <ctrl> left click.  If the intervals can fit in one gun, then a message will pop up reminding you 
that more than one interval has been assigned to a gun.  Otherwise the same gun will be assigned to 
each of the selected intervals.  You should see your gun in the picture on the right.  The parameters 
that show up (length, top shot, etc. ) are the ones that you assigned to that gun type.  You can edit 
any of those parameters to change them for this gun by clicking on any of the values and typing in 
new values. 
The gun will be loaded by default starting at the top of the gun.  To change where the loaded interval 
starts, click in the loaded area of the gun (where the red dots are) and slide the loaded interval up or 
down.  The distance to the top shot and bottom shot will change as you slide the loaded interval.  The 
distance to the top shot can be no less than the top loadable number and the distance to the bottom 
shot can be no more than the bottom loadable number. 
When you are viewing the design of a gun with no interval assigned to it, the shots will be indicated in 
black.  When you are viewing a gun that does have an interval assigned to it, the interval will be 
displayed in the upper left part of the diagram and the loaded interval will be indicated by red shots. 
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You can print a picture of the gun from here to give to the gun loader. 
 

20.6.1 Gun types 

 

FIG: 20.5 Gun Types  

 

FIG: 20.6 New Item  

There are several predefined gun types or you can add your own gun type.  Your own gun type will 
require a metafile picture to go with it.  To add new items, right click on the Gun type and then select 
New Item, New Category, or Delete.  For each type of gun, you can have 0 or more categories, and 
then for each category you can have 0 or more items.  You can drag and drop items and categories 
within their gun type if you want to organize things differently.  All of the gun and charge type 
information goes in the file explobjs.ini so once you have all the standard gun information entered; 
you can pass out copies of this file. 
Once you have a new gun showing in the window on the right, you can edit any of the parameters for 
the gun.  All entries are edited by clicking on the value to be edited and then typing in a new value.  
The following entries are critical to having the gun diagrams and shot calculations come out properly.  
The Total length value is the total length of the item without any gun subs.  The Top shot value is the 
distance from the top of the gun body to the top shot.  The Shot length is the maximum shot length 
that this type of gun can be loaded.  All of the parameters can be edited for a specific gun once you 
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assign this gun to an interval in case you have a carrier that is slightly different from the generic gun 
type you created. 

 
FIG: 20.7 New Gun Type 

 
20.6.2 Charge types 
All of the charges that you create in this list will show up in the list of charge types that you can 
choose from when you edit your gun parameters from your gun picture on the right. 
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FIG: 20.8 Add New Charge 

 

 
FIG: 20.9 New Charge 

 
 

20.7 Build TCP string 
Selected TCP for the job type, then you will see this tab.  The TCP job is centered around the gun 
shot depth, so as you add items to the string, their depth will be calculated based on the gun shot 
depth.  To find items to add to the TCP string, select the Edit TCP string button.  This will bring up the 
tool string editor and allow you to add and remove items from your TCP string.  It is up to the user to 
add any gun subs to the carrier to make the diagram complete.  If you have more than one gun in the 
TCP string, the depths will be referenced off of the top gun.  You will have to fill in items below the 
top gun to get the rest of the guns on depth or you will get a warning message.  When you are 
completed with your TCP string, and then select the Finish button. 
 
20.7.1 Off Depth Warning: 
If you have more than one gun in the TCP string, then you may get a warning message that displays 
how far off depth the gun is.  The depth value is the amount of space you need to add above that gun 
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to make it come out on depth.  If it is negative, then you have too much space above the gun.  From 
the Build TCP String tab, you can modify that amount by changing the value TCP Depths must be 
within.  The default is 0.25 ft. 

20.8 Build Tool Strings 
Selected Wireline for the job type, then you will see this tab.  The first thing you have to do is assign 
a service to one or more intervals.  From the services editor, there is an option for every service – 
“Make this service available for perforating”.  Only the services that have this option checked will 
show up as services you can assign to a perforating interval. 
Select one or more intervals from the list that will be run in the hole on one tool string.  Say you have 
10 intervals in the list.  You may have two intervals that you will perforate with one run in the hole - 
either with select fire or because they both fit on one gun.  Once you have those items selected, then 
choose a service from the list of services at the bottom of the screen and then select the Assign 
Service button.  The tool string editor will start up with those selected guns in the tool string as well 
as the tools from the service you selected.  It is up to you to add your gun subs and any other items 
to make this match what you are running in the hole.  When completed, select the Finish button. 
 

 
FIG: 20.10 Service editor  

20.9 Main Window 
20.9.1 Job menu 
Saving a Job:  The following information will be saved with each job: 

20.10 The job plan itself 
- /f/w/r/_jobplan_/_job_/1 
 
The results of the job 
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- /f/w/r/_jobplan_/_report_/1 
 
Each tool diagram 
 
- /f/w/r/_jobplan_/_wtd_/[name] 
 
The TCP diagram ( for TCP jobs ) 
 
- /f/w/r/_jobplan_/_tcp_/1 

20.11 Utilities 
Insert a Well Object into a Log: Will create a well object in the run you have chosen.  The tool 
diagrams will be saved in the database also, so you can re create the picture. 
 
20.11.1 Import/Export 
The loaded job can be exported to a floppy disk to be imported on another machine.   The floppy will 
contain one file with the job information as well as tool diagram files for the guns.  Note that every 
gun has a serial number assigned to it.  When the job is imported to another machine, those gun 
serial numbers may already exist, so the imported serial numbers may be reassigned to prevent 
conflicts. 
 

 
FIG: 20.11 Utilities Charge 

 
20.11.2 Changing order of runs 
Let’s say you have 2 different runs created.  Then you decide you want to have run 5 be the first run.  
Click on run 2 and drag it up above run 1 and drop it.  You will be asked “Move run 5 before run 1?”.   
The run numbers will be rearranged; run 5 will be called run 1, run 1 will be called run 2, etc.  The 
renumbering will always start at 1. 
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FIG: 20.12 Reorder Runs 

 
FIG: 20.13 Job Planer swap Runs 

 
20.11.3 Running a wireline job 
Now that you have built a custom service for each run in the hole, you will control the service that is 
loaded from Job Plan.  Right-click the run you are making from the list of runs and select Load 
Service.  That will start Acquisition with the selected run.  Make sure the tool diagram matches what 
is going in the hole, including gun subs.  If this does not match exactly, then your Stop Depths will not 
be calculated correctly.  When you close the tool diagram window, the Stop Depth will be updated, 
indicating the depth to stop the hoist to make the perforation.  If you have made a previous run with 
this service, then Acquisition should load with the next free pass as the Dataset. 
In the Depth Configuration screen, there is a “Stop Depth” setting that you can use to indicate when 
your logging depth is close enough to perforate. 

20.12 Active interval 
You will also notice there is an Active Interval choice below Load Service.  Since a single run in the 
hole can have more than one interval associated with it, you can choose the interval within the 
loaded service you want to be active.  If you only have one interval within the run, then that interval 
will be active.  The active interval will change the color of the depth to green when the hoist depth is 
at the active interval stop depth.  Also, the active interval will have an icon next to the run indicating it 
is active. 
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20.12.1 Results 
Once you have completed one interval, right click on the interval and select Results.  Your interval 
will show a different icon dependent upon what choice you make for your results.  You can also add a 
text string to go with your results.  You must at least choose one of the options (Successful, 
Unknown, Missfire) so you can keep track of the runs you have made already.  If you choose 
Successful, then it will automatically add a perforating  or plug well object to the log pass.  If you have 
a correlation log entry in your Job Information screen, then the well object will be added to that log 
pass.  Else the well object will be added to the current log pass. 

 

 
FIG: 20.14 Results 

 
FIG: 20.15 Comments 

 
FIG: 20.16 Job Status 

 

20.13 Print 

 
FIG: 20.17 Print options 

Select the option to print. 
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21 USB Shooting Panel 
The shooting panel has a new additional option Safety Software Key to run guns, if the panel has the 
USB port available (USB board inside), it should be connect to USBHUB back to the interface panel 
,add the DEVICE, SENSORS and  Check the box to Make this service available for perforating 
must be include in the service  
Setup in the software the new device, add the Device CYSHPNL, 4 

21.1 Software set up 

 
FIG: 21.1 Device 
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FIG: 21.2 Add Device 

 
FIG: 21.3 Sensor 
Add the new two Sensors SHVOLT=CYSHPNL, and SHCURR=CYSHPNL 
 

 
FIG: 21.4 Add Sensor 
Shooting Voltage sensor 
 

 
FIG: 21.5 Add second Sensor 
Shooting Current sensor 
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Add sensor in order to acquire at the same time DEPTH and TIME versus Curves in the same Data 
Base. 
Double check the ADPTH = AUX is under sensor. 
Set the Data base for two outputs (Time and Depth) 
TimeToDepthInputSec = (seconds per time sample),     e.g. 0.10 
TimeToDepthOutputFt = (feet per depth sample),          e.g. 0.25 
 

 
FIG: 21.6 Add Time to convert to Depth Input 
Set the File Time with sample rate every 0.1 Sec, for high resolution for low resolution increase the 
sample rate  Time. 
 

 
FIG: 21.7 Add Time to convert to Depth Output 
Set the Depth File with sample rate every 0.1 Ft. for high resolution, for low resolution increase the 
sample rate to 0.25 FT. 
Check the option Make this service available for perforating  
 

 
FIG: 21.6 Set Service 



 

415 Warrior Software Version 7.0 Standard Cased Hole

 

FIG: 21.7 Interactive Time Plot 

Select the File Pass1 to plot Time Vs Curves 

21.2 Time Plot 

 

FIG: 21.8 Time Plot 
The time plot is continues just depend of start acquisition (Record Up, Record Down, Record Time) 
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FIG: 21.9 Depth Plot 
The Depth is the standard plot Depth Vs curves if the you stop the tool the plot stop to acquire data. 

21.3 Depth Plot 

 

FIG: 21.10 Depth Plot 
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FIG: 21.11 Panels Connection 
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21.4 Shooting Panel Calibration 

 

FIG: 21.12 Shooting Panel Calibration 

 

 

FIG: 21.13 Voltage and Current Calibration 
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FIG: 21.14 Voltage and Current  Values 

21.5 Operation of the Shooting Panel 
 
The speaker will emit a continuous WARNING tone while the AC / DC switch is in the AC position. 
The ‘LOG’ and ‘AUX’ positions on the ‘MODE’ switch are active when the shooting panel is not 
powered. If the ‘MODE’ switch is set to the ‘LOG’ position, the ‘LOG’ and ‘LINE’ connectors on the 
rear of the panel are connected. 
 
21.5.1 AUX Position 
Place Switch in Aux Position 
The ‘AUX’ key switch position simply connects the AUX connector to the line connector on the rear of 
the panel. 

 
FIG: 21.15 Switch in AUX 
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21.5.2 LOG Position 
Place Switch in LOG Position 
To log, set the 'MODE' key switch to 'LOG'. The 'SAFE LIGHT' connector on the back of the panel 
will have pins A & C shorted for a UNSAFE 'red light' to be illuminated on the rear of the logging 
truck. 

 
FIG: 21.16 Switch in LOG 

21.5.3 SAFE Position 
Place Switch in SAFE Position 
The panel is in 'SAFE' mode (line is shunted) any time the ‘MODE’ key switch is in the ‘SAFE’ 
position. The 'LIGHTS' connector on the rear of the panel will have pins A & C shorted for a SAFE 
'green light' to be illuminated on the rear of the logging truck. If the ‘MODE’ switch is in any other 
position, pins A & B of the ‘LIGHTS’ connector are shorted to indicate an unsafe CONDITION. 
 

 
FIG: 21.17 Switch in SAFE 
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21.5.4 CCL Position 
Place Switch in CCL Position 
To log CCL, set the ‘MODE’ key switch to ‘CCL’.  The CCL amplifier is now connected to the line. 
The 'CCL GAIN' control adjusts the relative reading of the 'CCL' meter and the 'VOLUME' control 
adjusts the volume of a speaker inside the panel that emits a chirp when a collar is detected. The 
CCL amplifier will function when the power plant is shut off as long as the 'MAIN' switch is on. 
 

 
FIG: 21.18 Switch in CCL 

21.5.5 ARM Position 
Place Switch in CCL Position 
To arm the panel, set the 'MODE' key switch to 'ARM'. The 'SAFE LIGHT' connector on the back of 
the panel will have pins A & C shorted for a UNSAFE 'red light' to be illuminated on the rear of the 
logging truck. 
 

 
FIG: 21.19 Switch in ARM 
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FIG: 21.20 Set Stop Depth 

 

FIG: 21.21 Set Enable Shoot 

Click over Enable Shoot 
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FIG: 21.22  Software Ready to Shooting 
 
Ready to shooting 
To shoot, verify that the 'MODE' key switch is set to 'ARM' and the 'ADJUST VOLTAGE' control is 
rotated fully counter clock wise. Set the 'AC / DC' switch the and the 'POS / NEG' switch to the 
required settings (NOTE: the 'POS / NEG' switch has no effect when the 'AC / DC switch is in the AC 
position.) The panel is now ready to shoot. Lift and hold the 'SHOOT' switch up and rotate the 
'ADJUST VOLTAGE' control clock wise while watching the 'VOLTAGE' and 'CURRENT' meters. 
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FIG: 21.23 CCL on Depth 

Tool on Depth CCL Reference 
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FIG: 21.24 Positive Voltage and Current Shooting 
 
Set Switch in Positive position 

 

FIG: 21.25 Negative Voltage and Current Shooting 
 
Set Switch in Negative position 
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FIG: 21.26 Voltage and Current Shooting 
Set Switch in AC position 
 
 
 
 

 
VIDEO: 21.1 Shooting Procedure 
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22 Convert from 6.2 to 7.0 Warrior 
Goto Warrior system with 6.2 version, open Warrior and copy the 6.2 bin file unto a blank CD 
Put CD in the cd driver of the computer that will be upgraded. 
Copy the 6.2 bin file unto the desktop.  

 
FIG: 22.1 Bin 

22.1 Procedure 
• Place the 6.2 Bin file on the desktop... 
• Open My Computer\C:\Warrior folder 
• Open the 6.2 Bin file that you placed on the desktop. 
• Copy all of the ".wtd" files from the 6.2 bin folder to Warrior \ Format folder 
• Copy all of the ".was" files from the6.2  bin folder to Warrior \ 7.0 bin32 folder 
• Copy all of the ".hdg" files from 6.2 Bin folder to Warrior \ Format Folder 
• Copy all of the ".prs" files from 6.2 Bin folder to Warrior \ Format Folder 
• Copy the Company logo file from 6.2 Bin to Warrior \ Config Folder 
• Close all windows 

22.2 Import a Tool 

 
FIG: 22.2 Utilities 

Open the 7.0 Warrior Utilities program. 
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FIG: 22.3 Edit Logging Tool Details 

Open "Edit Logging Tool Details. 
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FIG: 22.4 Tools Editor 

Highlight "Tools"  

 
FIG: 22.5 Tools Restore 

From the tools menu, select Calibrations --> Restore. 
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FIG: 22.6 Browse Cal File 

In the box marked "Filename", change the .wcf to "*" and press enter. 
 

 
FIG: 22.7 Browse Cal File 6.2  

Click on the Desktop icon to the left side of the window. 
Double click on the 6.2 Bin folder. 
Highlight "Tools.ini" file. 
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FIG: 22.8 Browse Cal File 6.2  

Click on Open. 
 

 
FIG: 22.9 Tools Restore 
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FIG: 22.10 Select Tools 

From the Select Tool drop down menu, choose the tool type to be imported. Highlight all of the tools 
under the tool type that you wish to import into 7.0 
NOTE: There are several categories of tools that can be selected. 
Click on the "Restore" button. 

 
FIG: 22.11 Restore Calibrations  

At this point, you can give the tool a different name if you are concerned about over writing original 
tool information. If you do not wish to rename the tool, click on OK. 
 

 
FIG: 22.12 Restore Calibrations  

If you wish to rename the tool, highlight the name in the "To" box and then type in the name you 
desire. 

 
FIG: 22.13 Restore Calibrations  

Click on OK. The tool will be imported under the new name. 
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FIG: 22.11 Restore Calibrations  

Close the restore window. 

 
FIG: 22.12 Tool editor 

You can now find your new tool in the list. 
Repeat this for each tool category. 
All tools are now available. 
Close Tools Editor window. 
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22.3 Import a Service 

 
FIG: 22.13 Edit Logging details 

In the 7.0 Warrior Utilities window, click on Edit Logging Service Details. 

 
FIG: 22.14 Import service 

From the tool menu, select Service --> Import 
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FIG: 22.16 Browse Cal File 

In the box marked "FileName", change the .wcf to "*" and press enter. 
 

 
FIG: 22.17 Warrior Cal File versions 6.2 

Click on the Desktop icon to the left side of the window. 
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FIG: 22.18 Services.ini versions 6.2 

Click on services.ini, click enter 

 
FIG: 22.19 Select services 

Highlight all services to be imported and click ok 

 
FIG: 22.20 Overwrite Select service 
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If there is a service with the same name, the program will ask if it should be over written. Keep in 
mind that any changes you have made to the original service (the one being over written) will be lost 
to import the service, click on OK. 
If you do not want to loose the changes, click no. Follow the procedure to rename the original service 
below, and then return to "Import Service" procedure. 
 

 
FIG: 22.21 Service Editor 

All service that was selected has now been imported. You must now convert the imported services 
from 6.2 to 7.0 
Close all windows. 

22.4 Convert Services 

Open My Computer\C:\Warrior folder 
Open bin32 folder. 

 
FIG: 22.22 WarConv.exe 
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Double click on warconv.exe 

 
FIG: 22.23 Run WarConv.exe 

Click on yes 

 
FIG: 22.24 Select Configuration File Converters 

Highlight Convert to ADC/CTR Combo card then click Run. 

 
FIG: 22.25 Convert to ADC/CTR Combo Card 

Click on Yes. 

 
FIG: 22.26 Select Configuration File Converter 

You will see "Conversion Successful" when the conversion is finished. 
Restart your computer. 
Again, open My Computer\C:\Warrior folder 



440 Warrior Software Version 7.0 Standard Cased Hole 

Open bin32 folder. 

 
FIG: 22.27 WarConv.exe 

Double click on warconv.exe 

 
FIG: 22.28 Run WarConv.ex 

Click on yes 

 
FIG: 22.29Warrior configuration File converter 



 

441 Warrior Software Version 7.0 Standard Cased Hole

Highlight Convert to DAMUPCI CBL01-09 then click on Run. 

 
FIG: 22.30 Convert 

Click on Yes. 

 
FIG: 22.31 Warrior Configuration File Converter 

You will see "Conversion Successful" when the conversion is finished. 
Restart your computer. 
Again, open My Computer\C:\Warrior folder 
Open bin32 folder. 

 
FIG: 22.32 WarConv.exe 
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Double click on warconv.exe 

 
FIG: 22.33 Run Conversion 

Click on yes 

 
FIG: 22.34 Warrior Configuration File Converter 

Highlight Convert DAMUPCI to USB then click on Run. 

 
FIG: 22.35 Convert 

Click on Yes. 

 
FIG: 22.36 Warrior Configuration File Converter 

You will see "Conversion Successful" when the conversion is finished. 
Restart your computer. 
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This ends the conversion process. 

22.5 Rename Original Service 

 
FIG: 22.37 Warrior Utilities 

Open Utilities by clicking on the Utilities icon. 

 
FIG: 22.38 Edit Logging details 

Click on Edit Logging Service Details. 



444 Warrior Software Version 7.0 Standard Cased Hole 

 
FIG: 22.39 Edit Logging details 

Highlight the service to be renamed. In this example, TECKO Sector is highlighted. 

 
FIG: 22.40 Rename 

From the drop down menu, select Service -> Rename. 
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FIG: 22.41 New Service name 

Type in the new name for the service and click on OK. 

 
FIG: 22.42 Service Editor 

The service now has new name. 
This ends the renaming process. 
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23 Spartek Tools 
23.1 Tool Editor Setup 
In the Warrior Utilities, Edit Logging Tool Details check to see if the default (sample) Spartek logging 
tools are present. SPTK-BULLPLUG, SPTK-CCL, SPTK-CENT, SPTK-FULLBORE, SPTK-GRCCL, 
SPTK-MAST, SPTK-PTC, SPTK-SPIN, SPTK-TEMPPRES, SPTK-TPCD. 
 

 
FIG: 23.1 Tools Editor 

If these tools are not present use the Calibrations->Restore feature to either restore the sample tools 
from “CH USB 70.wcf” or “SpartekPL.wcf”. 
There are also some “external” calibration files needed to correctly configure some of the tools, these 
are the pressure and temperature quartzdine format .cff and .cft files. These will be provided by 
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Spartek but sample files are included in our release and also in the file “SpartekCals.zip”. These 
files need to be in the “Warrior\Config” directory. 
Special care needs to be taken when creating a new Spartek tool in the Warrior system when basing 
it on an existing example tool. The Spartek tools communicate their types and serial numbers via 
telemetry to the system, and likewise the tools are set up in Warrior to convey their types and serial 
numbers to the telemetry handling device (the DSP inside the panel). Each tool will be examined in 
turn to demonstrate where the type and serial information is stored to be passed on to the telemetry 
 
23.1.1 SPTK-BULLPLUG 
Well, the first one on the list is an exception to the rule, no ID or type; this tool can be copied again as 
necessary without any special steps. 
 
23.1.2 SPTK-CCL 
In the example screenshot the field in the Software, Serial section termed “TelID” needs to be filled 
correctly, this tool, serial number L00121, has the TelID field set to “ccl@121”, this is type@serial 
and the format follows through the tool family. Note that the “L00” has been stripped off, this is 
because the tools identify themselves in telemetry in the same manner, only the numerical part of the 
serial number is used. This field will need to checked and filled when creating new tools. 

 
FIG: 23.1 CCL Tool 

23.1.3 SPTK-CENT 
The centralizer does identify itself in the toolstring so appropriately there is the need for it to have the 
correct TelID setup. In the first screen shot the software section of the tool serial L00318 is shown 
having a Sensor called “IDOnly”, double clicking on this brings up a second screen where the field 
“Telemetry ID” is filled in with “cent@318”. This field will need to be checked and filled in correctly for 
new tools created in the system. 
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FIG: 23.2 CENT Tool 

 
FIG: 23.3 CENT Sensor 
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23.1.4 SPTK-CFB 
This tool type takes care of the 1-3/8” caged spinner tools. The example shown with tool serial 
“L00264” shows the TelID field in the Software screen, Serial Section, filled with “cfb@264” 
appropriately. This field will need to checked and filled when creating new tools. 

 
FIG: 23.4 CFB Tool 

23.1.5 SPTK-FULLBORE 
This tool takes care of the 1-3/8 folding flow meter. It is setup in the same manner as the SPTK-CFB 
as seen in the following screenshot, the “TelID” uses the same “type” being “cfb” as before. This field 
will need to checked and filled when creating new tools. 

 
FIG: 23.5 CFB Tool 
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23.1.6 SPTK-GRCCL 
The setup for this tool is slightly different as for the spinner tools as the tool incorporates two software 
modules combined to represent the tool in its single housing, being the CCL and GR. The “TelID” 
information only has to be present in one part of the tool information, we have chosen to use the CCL 
screen as this is the default when looking at the tool information and creating the new copies of the 
tool. In the screen shot below for example tool “L00043” the “TelID” is “grccl@43”. This field will 
need to checked and filled when creating new tools. If you click on the “GR” in the “Software in this 
toolstring” box you will see the GR setup and also note that intentionally the “TelID” field is left 
blank, this does not have to be filled in as the CCL software is communicating to the telemetry that 
the tool is present. 

 
FIG: 23.5 GRCCL Tool 

23.1.7 SPTK-MAST 
This takes care of both the 1” and 1-3/8” telemetry master tools. There is one example of the 1” tool, 
serial “L00020” and several examples of the 1-3/8” tools, such as “L00041”. Care must be taken 
when copying one of these tools to create a new one in the system that the correct model type is 
selected, this is in the “Model” tab-screen of the tool in the Tools Editor. The SPTK-MAST tools have 
three sensors, double clicking on any sensor will bring up its set-up screen. As each sensor can have 
a “Telemetry ID” but we only need one to convey the tool type and identity to the telemetry we have 
chosen to set this up with the “CHV” sensor. Care must be taken to check and fill in this field when 
copying  these tools. 
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FIG: 23.6 MAST Tool 

In this example the “Telemetry ID” is “mast@41”, the same type “mast” is used for both 1” and 1-
3/8” tools. 

 
FIG: 23.7 Edit sensor 
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Calibration values for the INCL and ZACC have to be provided by Spartek and are hand-entered in 
the software using Acquisition->Edit->Calibrations and selecting the appropriate output. For example 
with the INCL (inclinometer): 

 
FIG: 23.8 Edit Calibration 

23.1.8 SPTK-PTC 
This tool is another composite of several tool software modules using CWH (Capacitance) and 
PRESTEMP (Pressure/temperature) software. The example tool “L00026” sets up the “TelID” in the 
CWH page as seen in the screen shot, “ptc@26”.  Care must be taken to check and fill in this field 
when copying  these tools. The CWH calibration is hand entered similarly to the INCL mentioned 
above, via Acquisition->Edit->Calibrations and selecting the “CWH” from the list. Currently Warrior 
software is supporting this with 10 calibration multi-points (provided by Spartek), this may change in 
the future converting to a curve-fit type calibration that can handle more points. Clicking on the 
“PRESTEMP” line on the “Software in toolstring” box will bring us to the pressure/temperature 
setup. There are three sensors here, PTCP, PTCT and PTCTEMP. All of them need correct 
configuration when setting up a new tool. Double clicking on a sensor will take you to the sensor 
setup screen and importantly the “Gauge Serial No.” of each sensor needs to be filled correctly. 
These fields relate directly to the external calibration files (provided by Spartek) for the tool. Each 
prestemp sensor has a calibration file. The file name is the composite of the serial number and the 
sensor channel, for example for tool “L00026” the pressure calibration name is “L00026-01303”, 
software automatically assigns the file extension (.cff or .cft) by gauge type (pressure or 
temperature). These fields have to be correctly configured for each sensor and each tool. 
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FIG: 23.9 Tools Editor 

 
FIG: 23.10 Tools Editor 
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FIG: 23.11 Edit Pressure sensor 

 

 
FIG: 23.11 Edit Temperature sensor 

 
FIG: 23.12 Edit External Temperature Sensor 
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23.1.9 SPTK-SPIN 
This is for the 1” spinner that is optionally run on the PTC. Setup is very similar to the SPTK-CFB 
except that the “TelID” has a different identifier, for the example tool “L00026” the “TelID” is 
“spin@26”. 

 
FIG: 23.13 Tools editor Spin 

23.1.10 SPTK-TEMPPRES 
This tool is the combined 1-3/8” Temperature/Pressure. Setup is similar to the PTC Prestemp 
software section. Each sensor must have the correct “Gauge Serial No.” entry to identify the 
calibration file. The “Telemetry ID” is entered only in the “TPP” sensor setup as shown in the screen 
shots below. The example tool is serial “L00022” and the “Telemetry ID” is “tp@22”. Each sensor 
must have the calibration file info entered as before in the PTC example and as demonstrated below. 
These fields have to be correctly configured for each sensor and each tool. The external calibration 
files will be provided by Spartek and copied to the Warrior\Config directory as before. 
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FIG: 23.14 Tools editor PresTemp 

 
FIG: 23.15 Edit Pressure sensor 

  
FIG: 23.16 Edit Temperature sensor 
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FIG: 23.17 Edit Compensation Temperature sensor 

23.1.11 SPTK-TPCD 
This is set up for the 1-3/8” TPCD tool with dual pressure, external temperature and capacitance. It 
comprises three software modules, CWH, PRESTEMP and GRADIO. GRADIO is purely a calculation 
module that uses pressure or delta pressure outputs together with the INCL output of the SPTK-
MAST to calculate fluid density.  Setup is the same as for the SPTK-PTC and this can be used as a 
reference with the exception shown in the  “TelID” type being “tpcd”, so for example tool “L00051” 
the “TelID” is set up as “tpcd@51” as seen in the CWH screen shot below. There are 5 Prestemp 
sensors to be configured correctly as seen in the example and this will need 5 corresponding external 
calibration files from Spartek copied to the \Warrior\Config directory. The sensors are PRESU, 
PRESL, TEMP, TEMPU and TEMPL. 

 
FIG: 23.18 Tools Editor TPCD 
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FIG: 23.19 Edit Pressure sensor 

 
FIG: 23.20 Edit Pressure sensor 

 
FIG: 23.18 Edit Temperature sensor 
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FIG: 23.19 Edit Temperature sensor 

 

 
FIG: 23.20 Edit Temperature sensor 
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23.2 Acquisition 
When selecting the Spartek service you will first need to configure the Tool String in the Tool String 
Editor: 
 

 
FIG: 23.21 Tool String 

Once this is set up how you want to run the tools pres Save. 
The normal acquisition windows will now appear and will include the Spartek Telemetry monitor, and 
the TEL Threshold screen. This is how they will appear before tool power is applied: 
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FIG: 23.22 Telemetry Monitor 

 
FIG: 23.23 Telemetry  

Currently the system is set up to work with manual thresholds but possibly future automatic 
thresholds will be made available. Initial threshold settings (that can be saved so as not to set them 
every time the service is loaded) as above work fine. 
Other settings that influence the telemetry detection are the line conditioning and gain settings. In 
Edit->Devices->SDSTIP the following general settings work well where only changes in the gain 
using the AUX slider will be needed to “sync” the tool. 

 
FIG: 23.24 SDSTIP 
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On powering the tool, if an uplink is detected the system goes through a sequence of enquiring the 
tools themselves as to what type and serial numbers they are and also configuring the telemetry to 
be setup in the specified configuration that the user selected. 
Any differences between the user set up and the tool responses to the enquiries will be shown in the 
monitor. One other possibility is that the tools are unable to respond to the system downlink (on 
extremely long cables), in this case the system makes no attempt to downlink a new configuration 
and will simply try to acquire data from the tools in the manner they are sending it. Since these tools 
memorize their prior configuration it is possible to use the system to configure the tools while on 
surface using a dummy-load cable and then running them in the whole where they will work without 
being configured again on power-up. 
The following screen shots indicate a normal start up and also ones with non-matching user selection 
and actual tools and a shot of the TEL Threshold monitor: 

 
FIG: 23.25 Tel Threshold 

 
FIG: 23.26 Telemetry Monitor 
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FIG: 23.27 Telemetry Monitor 

It is advisable that once the status screen has been updated with the tool information that the user 
switch to the Channels display. This will show the Frame Count and as importantly the Errors. Normal 
operation will show an update of 10 frames per second, some initial errors are normal while the 
configuration is taking place but this should not update once the tools are running. The sensor 
channels are unprocessed raw counts. 

 
FIG: 23.28 Telemetry Monitor 

The final view option is Setup. This tells us exactly what the downhole EEPROM was programmed 
with to configure the master controller. Each press of Setup will take us on to a new setup screen. 
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24 Radioactive Tracer Survey 
24.1 Setup Procedure 
Bring up Radioactive Tracer service.  
Click Acquisition Box - Edit - Tool String  
Edit the tool string as necessary to reflect the tool string being run. This is important to insure proper 
offsets, filters, and tool diameters. 
Click Acquisition Box - Edit - Variables  

 
FIG: 24.1 Tool String 

Edit the variables to reflect the correct casing ID and tubing ID sizes for proper flow rate calculation 
(Tubing OD is also important if running in annulus). Add multiple zones if needed. (Note: a size of 0 
indicates no casing, tubing, etc). 

 
FIG: 24.2 Edit Variables 

Click Acquisition Edit Tool Configuration TREJCT to bring up tracer configuration dialog box.  
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FIG: 24.3 Tool Configuration 

 

FIG: 24.4 Tracer Configuration 

Pick the method of tracer log you wish to run Dual Detector, Single Detector, or Drop Run. 
For Single Detector Velocity logs, the detection level can be determined from a base log pass if one 
has been run, (use browse to select it, it must be in your current database). Or enter a threshold 
value for the level of when a shot should be detected. More on this later. 
If the log is being run in the annulus between the tubing and casing, check this box for proper flow 
rate determinations. 
Other than base runs, make sure the Log Passes into Shot Table Box is checked. 
While normally all shot passes are logged into a single table, more than one table can be used and 
would need to be selected. 
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24.1.1 Tracer Ejection Control 
Click Ejection Control box to set up ejector control. The ejection duration that you choose is 
dependent upon your tool type and strength of the tracer material being used. (This should be tested 
with water prior to the job to determine the approximate number of shots that will be available during 
the job.) 

 
FIG: 24.5 Tracer Ejection Control 

The Additional Squelch time is set to allow settling of the gamma detectors after the ejection to avoid 
noise being detected on the log. 

24.2 Logging Procedures 
The depths where a tool is positioned in the well can be critical to the final log interpretation. Normally 
the Warrior system uses the bottom of the tool string as its zero point; this may put the detectors 
several feet above the depth shown. (It is possible to change the zero point to a sensor if desired.)  
If drag runs or velocity shots with a single detector are going to be done, it is recommended that a 
base run be logged first to record a background gamma. Use this to determine the threshold 
detection level or as a base curve that the threshold level is added to before detection occurs. Be 
aware detection occurs when the detector value crosses this threshold or base curve value plus 
threshold level, statistical deviations may cause premature detection. (Pick a high threshold level 
high enough to not cause premature detection.) 
 
24.2.1 Velocity Shots 
Position the tool in the well at the depth that you wish to make a shot. Shot passes can be Recorded 
on Time or by using the encoder simulator. The true depth of the encoder is used as the shot depth. 
Start a log pass. Allow sufficient time for the detectors to obtain a “background reading”. Then click 
the Start Ejection control. Continue recording until the detectors have drop back to the previous 
background reading. Stop the log pass. 
Log as many passes in this manner as desired. 
The Shot Table will now reflect the information just recorded. If a single detector method was used, 
the times and the flow rates will be complete. If a dual detector method was used the pass will have 
to be correlated to calculate the proper time, and thus the flow rates, as described below. 
 
24.2.2 Drag Runs 
Normal procedure is to eject a tracer slug, then to drop down and Record Up until the slug passes, 
then stop the pass. Then drop back down and start another pass. Each pass is recorded as a 
separate entry into the shot table. 
The normal calculations integrate the area between the detection level and the curve, so it is 
important to record the complete passing of the tracer material. 
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FIG: 24.6 Generate 

 
FIG: 24.7 Generate Drag Run Profile 

By clicking on the Generate button of the Shot table, all drag runs with a plus sign will automatically 
be merged into a single presentation. Selected annotations can be added for each pass. By using 
auto merge, curves from other passes, such as collars, temperature, or gamma, can automatically be 
added to the presentation. 
By clicking on Velocity Shots from Drag Runs, records in the shot table will be generated with 
distances between runs. To get the times, each record will then have to be correlated. 
 
24.2.3 Shot Table Editing, Correlation, and Flow Rate Log Generation 

 
FIG: 24.8 Table flow rate 
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FIG: 24.9 Table Flow rate 

Access to the shot table can be obtained through the Acquisition box and Editing Tool Configuration 
and choosing TREJCT and then clicking the Shot Table Button.   It can also be accessed from the 
Utilities menu through the Tracer Interpretation selection. 
The Shot Table shows the information taken each time a log pass was started. The first column 
contains a +, -, or ?. A + indicates a valid calculation. A – indicates that the record has been excluded 
from calculations. A ? indicates that correlation has not been done to determine time.The second 
column indicates the type of record. DR is drag run. DRV is velocity determined from drag runs. SDV 
is single detector velocity. DDV is dual detector velocity. 
Other columns indicate depth of pass, flow rate, percentage of flow rate, change of flow rate, percent 
change of flow rate. By clicking on the view button, casing and tool dimensions can be viewed. Also 
available are detection times, integration, and dataset information. 
Certain information for a given record can be edited by selecting the record and clicking the edit 
button or by double clicking on a record. Casing and tool dimensions can be changed. Weighting 
other than 1.0, adjusts the calculated output. . An unsatisfactory station can be removed from the 
flow rate calculations by removing the check mark beside Include in calcs. A record marked as 
reference will be considered to be maximum or 100% flow rate. 

 
FIG: 24.10 Options 
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FIG: 24.11 edit shot 

If a Dual Detector method or velocity shots from drag runs was used, the data recorded will have to 
be correlated before times will be computed. Shots that have not been computed will be tagged with 
a question mark (?). Click on a shot pass to select it, then click on correlate to open the correlation 
process box.  
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FIG: 24.12 Liner Correlation 

Normally the selected base curve, specimen curve, and output curve will be setup. There are options 
to select different curves to be used if desired. On the base data, click and drag on the portion of the 
data that you think is valid, if the whole pass looks good, this step may be skipped. On the specimen 
data, click and drag on the portion of the data that is valid. The length of this data MUST be less than 
the length of the base data.  
It is important that the whole response to the shot be selected since the calculations are done on the 
area under the curve and not on a given level. 
Click Begin to compute the time. Click Save to retain the present calculations. Click Exit to return to 
the Shot table. 
When all stations have been edited as desired, click on Generate. Choose Merged Composite File. 
Curves from a collar locator pass, a gamma ray pass, etc. may be added to the final presentation if 
desired. Finally when OK is clicked the flow rate presentation will be plotted out. 
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24.3 Service Specific - Tracer Survey 
The Tracer service incorporates several special features that may require further explanation. The 
Warrior software attempts to calculate results from each pass of data as it is recorded or immediately 
afterwards.  
24.3.1 Dual Detector Velocity 
In Dual Detector Velocity mode the time displacement between the two curves is determined by a 
correlation technique. Any part or all of the data may be used to match the curves together. It is 
essential that complete event of the slug passing the detectors be recorded for this technique to be 
effective. 
 
24.3.2 Single Detector Velocity 
In Single Detector Velocity mode, the time from the ejector shot to a threshold crossing by the GR 
(or detector) curve is measured. If two detectors are in the tool string, the time measurement is made 
from the ejector shot to the first GR curve to cross the threshold. 
 
24.3.3 Tracer 
In Tracer the area between the designated GR (or detector) curve and either a baseline GR or a 
fixed level, is the primary measurement. 
The results and other information are placed in a Shot Table. The contents of the shot table are used 
as a basis for the calculation of total and differential flow rates for display in tabular or log format. 
When a Tracer survey is selected,  Edit/Tool Configuration/Tracer brings up the Tracer 
Configuration window as shown below. 

 

FIG: 24.13 Tracer Configuration 

The user defines the type of survey to be run from a choice of Single or Dual Detector Velocity, or 
Tracer (Drop Run). This selection defines the type of on-line calculation that the software will attempt. 
If the survey is being run in the annulus the In Annulus box should be selected on order that the 
correct calculations be made. 
If it is required that the passes be inserted into the current shot table the Log passes into Shot 
Table should be selected. This would be the normal case to actually record the results and is the 
default. 
More than one Shot Table may be defined for each survey. 
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24.3.4 Drag Run 
Drag Run option is selected the user is asked to define which detector is to be used. 

 

FIG: 24.14 Tracer Configuration 

When two detectors are in the tool string and single detector velocity is selected the system will make 
calculations based on the first curve to cross the threshold. 
When making calculations from the tracer passes (i.e. the area under the DET curve) it is necessary 
to define either a fixed threshold value or a baseline DET pass. The area under the DET curve and 
above the Threshold or  
Base Curve is used to calculate the percentage of the original radioactive material passing the 
detector and the flow profile. 
This information is defined in the Threshold or Base Curve fields. 
To display the current Shot Table and/or Tracer Ejection Control window click on the appropriate 
button. 

 
FIG: 24.15 Tracer Ejection Control 

When running the service with the SDS interface panel the operator has the option to control the run 
time of the ejector motor from the Tracer Ejection Control window. 
The length of time for each motor run is entered in the Duration dialog box. Clicking on the Start 
Ejection button changes the polarity of the line power for the time set in the Duration box. 
 
24.3.5 Additional Squelch 
The Additional Squelch field allows the user to set an additional dead time period in the DET curves 
after the ejector motor has run in order to avoid line noise appearing on the log. The time needed 
depends on various factors and is best set by trial and error. 
The Tracer tool software module generates a curve called EJECT which shifts one unit to the right for 
the period of the ejection, thus indicating the occurrence and duration of the ejector motor run. 
The survey is currently run by logging with the internal encoder simulator, however the actual depth 
is recorded as a curve named ADEPTH. This curve may be presented on the log in curve or tabular 
form, in order to indicate movement of the tool during the survey. 
The elapsed time from the start of the survey is available via a curve named ELTIM.  
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25 PANEX 
25.1 Panex Monitor 
The Panex Monitor will now appear when the service is loaded automatically. A few enhancements 
have been made.  
It is now possible to change the downlink attenuation from the monitor (previously set in the script), 
the starting value will be whatever the script is set to. The default has now been set to 70%, this 
value seems to work fine on a large selection of cables we have tested on. 
Also added are individual frame counts for each DSRO and a clear stats (“X”) button, particularly 
helpful in determining the source of error frames when one particular DSRO is having problems only. 

 
FIG: 25.1 Panex Monitor 

The below settings work on a large selection of cable types and should be used in the future. Please 
change to these settings on your computer if they are not this way by default. (In Acquisition, Edit-
>Devices->SDSTIP). You may need to increase the Q value slightly on shorter (low impedence) 
lines. 
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FIG: 25.2 SDS Tool Interface Panel  

 
FIG: 25.3 Panex Script 

The default script settings have been changed and have been tested on a large variety of cables. 
In Acquisition it is possible to reset the C10 calibration coefficient (also editable via the Tool Editor). 
To access this Edit->Tool Configuration->PNX-FLOW. When this value is set to zero then C10 from 
the coefficient file will be used. 

 
FIG: 25.4 Panex CFV Editor 
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Panex Gamma Ray tools are now supported, the TelID and C86 to C89 coefficients have to be 
entered in the Serial Number specific section of the tool editor and the CalbType has to be set to 
Panex. 

 
FIG: 25.5 GR Tool editor 

25.2 Tool-strings: 
CCL-EMDSRO-GR-ADAPTER-FID-QP-TLS-FLOW 
GR-QP (you would invert the GR so the gold connector screws in to the QP) 
GR-EMDSRO-TLS-ADAPTER-QP (invert the TLS and GR so the gold connectors screw in to the 
EMDSRO) 
GR-EMDSRO-ADAPTER-TLS-QP (invert the GR so the gold connector screws in to the EMDSRO) 
FID-QP-ADAPTER-GR-FLOW (invert the GR so that the gold connector screws in to the FLOW) 
QP-ADAPTER-GR-FLOW (invert the GR so the gold connector screw in to the FLOW) 
QP-GR-ADAPTER-FLOW (invert the QP so the gold connector of the GR screws in to the three 
conductor connector of the QP). 

25.3 Adapters 
Shows the two possible box connector ends, on the left there are three conductors and the right is 
one. The left would be like the top of the FLOW or QP tools. The right would be like the box end of a 
sensor tool like the TLS, GR or FID. 

 
FIG: 25.6 Box Connector 
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This is the ADAPTER as used in the tool string; both ends are pin (external thread). 

 
FIG: 25.7 Pin Connector 

This is the sensor three conductor end of a sensor tool like the TLS, GR and FID. This end must 
connect to a DSRO (EMDSRO, QP or FLOW) in the 3 conductor box connection for the sensor 
reading to be read. 

 
FIG: 25.8 Three Pin Connector 

Box end of a DSRO where a sensor can connect to as an input. 

 
FIG: 25.9 Three Box Connector 

This is a coupling from the GR tool 

 
FIG: 25.10 Gamma Ray Connector 

 
Make sure that the sensor offsets are correct if you invert any tools 
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26 Freepoint Service  
The Warrior system supports Freepoint tools that do not require motorized deployment. This includes 
Applied Electronics Bowspring and Magnetic tools and Homco tools. Other models of Freepoint tools 
could also be setup in the Warrior system if the frequency of the transponder is known. 

Be aware that the tool power and line termination passes through the Freepoint 
board. This means that the Freepoint board must be in the Warrior Interface 
panel or a jumper must be added between pins 10 and 12 on the connector for 
the Freepoint board. Also with the Freepoint board in the interface panel, the 

Routing codes for the system must be properly set up to allow the line to properly connect to the 
system. (Symptom of improper installation is having tool voltage but drawing no current in other 
services.) 

26.1 FREEPOINT CONTROL PANEL 

 
FIG: 26.1 Freepoint Control panel 

When the Freepoint service is first started, the window show below will appear. This is the Freepoint 
service control panel. It shows a graphical representation of the Freepoint output and a text output. It 
has selection buttons that allow one to select whether the next station is to be run is to be torque or 
stretch. There are three large buttons that control the Freepoint tool setup, starting and stopping time 
log passes, and station manager access. 
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26.2 FREEPOINT TOOL SETUP 

 
FIG: 26.2 Freepoint Setup 

When the Setup button on the Freepoint control panel is pressed, the window shown below will 
appear. This is the Freepoint setup control panel. Up to five different setups may be saved. Which 
setup is used may be selected by clicking on the dropdown box and choosing from Heavy Drill Pipe, 
Drill Pipe, Large Casing, Small Casing, and Tubing. Any changes made to the log sample rate or 
reading for 100% movement will be saved to the setup that has been selected. 
A normal sample rate for the log should be set to 5 to 10 samples per second. 
The 100% movement box is used to control the sensitivity of the response similar to the gain knob on 
an analog panel. Note that the lower the number the more sensitive the response will become. This 
does not have to be a whole number and may contain a decimal point (2.75 would be valid). 
The Set Tool button engages a relay in the interface panel and temporarily applies a DC voltage to 
the line to set the Applied Freepoint tool. Note that the tool power switch on the interface panel must 
be on to do this but the tool power adjustment potentiometers should be turned to 0.00. 
The Zero slide bar is used to set the zero position of the output before the log pass is started and 
torque or stretch is applied to the casing. 
There is an optional check box to clamp the Freepoint output to 0% to 100% so that it does not go off 
of the page on the log. 

26.3 Running the Service 
Once the Freepoint service has been selected and the tool lowered into the well to a depth where the 
casing is known to be free, the tool should be set and the output zeroed. Stretch or torque should be 
put on the casing and the 100% movement number adjusted to get near a 100% output reading.  
This should be repeated until you are satisfied that the equipment is responding correctly in free pipe. 
Once satisfied, the 100% Movement number should not be changed while recording stations. 
You are now ready to record the first station. Click the Start Log button on the Freepoint Control 
panel. The system will start recording on time. Have the rig apply torque or stretch and the output will 
be recorded. When you have seen the tool response, click the Stop Log button to stop the pass. The 
minimum and maximum Freepoint readings will be entered into the Station Manager table at the 
encoder depth (note that since the encoder depth is used, the log cannot be simulated using the 
depth simulator. You can only simulate a log by using the encoder and resetting the depth before 
each pass). 
Drop down the well to the depth that you wish to make the next pass and repeat the process. Make 
as many passes as desired to determine the Freepoint location in the well. Each pass will have the 
maximum output entered into the station manager table.  
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The depths at which you run the stations do not have to be in descending order. You would normally 
start at the top of the well, and start doing stations going down. Once stuck pipe is found, you can 
come back up to a depth between there and your last free pipe station to refine the stuck depth. What 
ever order the stations are run, they will be entered into the Station Manager table in descending 
order. 
26.3.1 Station Manager 

 
FIG: 26.3 Freepoint Survey Station 

 

 
FIG: 26.4 Freepoint Table 

 
As each station is run, the minimum and maximum values are placed into the station manager table. 
Notice that the stations can be done in any order but are placed into the table in descending order. 
Once a station has been entered into the table. It can be viewed and edited. Any field except the 
station # can be edited. This can be useful to make your final presentation more acceptable. There is 
a check box to disable the station so that it will not be included in the final log presentation in the 
event that the tool slipped or something else occurred to make the station invalid. 
When all of the stations have been edited as desired, the final log presentation can be made by 
clicking the Generate button, and then click the Depth Log button.  
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FIG: 26.5 Generate 

 
FIG: 26.6 Generate Depth 

There is a check box for Logarithmic Interpolation that will produce a slight smoothing effect to the 
output curves. Additional curves from the same database, such as a CCL or gamma ray, can be auto 
merged into the output. When the OK button is clicked, the interactive plot will be presented on a ½” 
/100’ scale. 
Using the Plot Job Editor, a presentation can now be made for the customer. This will normally 
include a heading, the Freepoint survey table, the generated depth log. The individual station passes 
could also be included and a tool string diagram if desired. 
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27 Freepoint Service Howco-GO 
The Warrior system supports Freepoint tools that require minimum DC voltage for motorized 
deployment. This includes Applied Electronics Bowspring and Magnetic tools, and Homco tools. 
Other models of Freepoint tools could also be setup in the Warrior system if the frequency of the 
transponder is known. 

 
Be aware that the tool power and line termination passes through the Freepoint 
board. This means that the Freepoint board must be in the Warrior Interface 
panel or a jumper must be added between pins 10 and 12 on the connector for 

the Freepoint board. Also with the Freepoint board in the interface panel, the Routing codes for the 
system must be properly set up to allow the line to properly connect to the system. (Symptom of 
improper installation is having tool voltage but drawing no current in other services.) 
Frequency style tools such as Homco and Gearhart do not require the use of the  
Freepoint Board. Signals are processed through the DSP in much the same manner as pulse type 
tools. 

27.1 FREEPOINT CONTROL PANEL 

 
FIG: 27.1 Freepoint Control panel 

When the Freepoint service is first started, the window show below will appear. This is the Freepoint 
service control panel. It shows a graphical representation of the Freepoint output and a text output. It 
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has selection buttons that allow one to select whether the next station is to be run is to be torque or 
stretch. There are three large buttons that control the Freepoint tool setup, starting and stopping time 
log passes, and station manager access. 

27.2 FREEPOINT TOOL SETUP 

 
FIG: 27.2 Freepoint Setup 

When the Setup button on the Freepoint control panel is pressed, the window shown below will 
appear. This is the Freepoint setup control panel. Up to six different setups may be saved. Which 
setup is used may be selected by clicking on the dropdown box and choosing from Heavy Drill Pipe, 
Drill Pipe, Large Casing, Small Casing, collars, and Tubing. Any changes made to the log sample 
rate or reading for 100% movement will be saved to the setup that has been selected. 
A normal sample rate for the log should be set to 5 to 10 samples per second. 
The Zero slider bar is used to set the frequency for when no torque or stretch is applied. The 100% 
slider bar is used to set the frequency for the maximum Torque or Stretch to be used. 
There is an optional check box to clamp the Freepoint output to 0% to 100% so that it does not go off 
of the page on the log. 

 
FIG: 27.3 Freepoint PMON Threshold 

Remember that the signals in the PMON (pulse monitor) window need to be discriminated properly, 
similar to a gamma/ neutron service. 
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27.3 Running the Service 
Once the Freepoint service has been selected and the tool lowered into the well to a depth where the 
casing is known to be free, the tool should be set and the output zeroed. Stretch or torque should be 
put on the casing and the 100% movement number adjusted to get near a 100% output reading.  
This should be repeated until you are satisfied that the equipment is responding correctly in free pipe. 
Once satisfied, the 100% Movement number should not be changed while recording stations. 
You are now ready to record the first station. Click the Start Log button on the Freepoint Control 
panel. The system will start recording on time. Have the rig apply torque or stretch and the output will 
be recorded. When you have seen the tool response, click the Stop Log button to stop the pass. The 
minimum and maximum Freepoint readings will be entered into the Station Manager table at the 
encoder depth (note that since the encoder depth is used, the log cannot be simulated using the 
depth simulator. You can only simulate a log by using the encoder and resetting the depth before 
each pass). 
Drop down the well to the depth that you wish to make the next pass and repeat the process. Make 
as many passes as desired to determine the Freepoint location in the well. Each pass will have the 
maximum output entered into the station manager table.  
The depths at which you run the stations do not have to be in descending order. You would normally 
start at the top of the well, and start doing stations going down. Once stuck pipe is found, you can 
come back up to a depth between there and your last free pipe station to refine the stuck depth. What 
ever order the stations are run, they will be entered into the Station Manager table in descending 
order. 
27.3.1 Station Manager 

 
FIG: 27.4 Freepoint Survey Station 

 
FIG: 27.5 Freepoint Table 
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As each station is run, the minimum and maximum values are placed into the station manager table. 
Notice that the stations can be done in any order but are placed into the table in descending depth 
order.  
Once a station has been entered into the table. It can be viewed and edited. Any field except the 
station # can be edited. This can be useful to make your final presentation more acceptable. There is 
a check box to disable the station so that it will not be included in the final log presentation in the 
event that the tool slipped or something else occurred to make the station invalid. 
When all of the stations have been edited as desired, the final log presentation can be made by 
clicking the Generate button, and then click the Depth Log button.  

 
FIG: 27.6 Generate 

 
FIG: 27.7 Generate Depth 

There is a check box for Logarithmic Interpolation that will produce a slight smoothing effect to the 
output curves. Additional curves from the same database, such as a CCL or gamma ray, can be auto 
merged into the output. When the OK button is clicked, the interactive plot will be presented on a ½” 
/100’ scale. 
Using the Plot Job Editor, a presentation can now be made for the customer. This will normally 
include a heading, the Freepoint survey table, and the generated depth log. The individual station 
passes could also be included and a tool string diagram if desired. 
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28 Bond Index and Borehole Volume 
28.1 BL Attenuation and Bond Index arithmetic 
Bond index is the ratio of measured attenuation to maximum attenuation. 

28.2 Calculation parameters 
 
28.2.1 fMxAmp 
Maximum expected amplitude; should be the same as the free pipe 
Reference value used in calibration. 
Obtained from zoned variable MAXAMPL. If the zero is entered then a value is calculated from the 
casing O.D. 
 
28.2.2 fMnAmp 
Minimum expected amplitude; should be the same as the zero signal 
used in calibration except for one caveat: Zero is not a valid 
value, even though it is commonly used for calibration. Suggest 
using a value of one millivolt for both. 
Obtained from zoned variable MINAMPL.  
 
28.2.3 fMnAtt: 
Minimum attenuation. Attenuation value expected to be measured in free pipe. 
Obtained from zoned variable MINATTN. SPE papers suggest a value of 0.8 as an overall average 
for common casing sizes and weights. 
 
28.2.4 fLogValue: 
Calibrated log amplitude. (each sample). Transmitter/receiver spacing is assumed to be 3 feet. 
 

28.3 Outputs: 
28.3.1 fAtt: 
Calculated output attenuation. 
28.3.2 fBI: 
Calculated output Bond Index. 
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28.4 Processing for each log sample: (math protection not shown) 

ffRatio = fLogValue / fMxAmp; 

fAtt = 20.0 / 3.0 * log(fRatio) - fMnAtt; 

fRatio = fMnAmp / fMxAmp; 

fBI = fAtt / (20.0 / 3.0 * log(fRatio) - fMnAtt); 

28.5 BOREHOLE VOLUME 
From Warrior Utilities select ‘Edit Logging Tool Details’. From the Edit Tool drop down box select 
‘STD’ Tool.  From the Serial Number drop down box select the serial number of the STD tool. 

 
FIG: 28.1 Tools editor 

Double click on the 'Calipers=' line. Enter a list of any output names, from all of your different services 
that should be used as main ('X') caliper inputs into the borehole volume calculation. Separate 
multiple names by commas. 

 
FIG: 28.2 Edit item 

Repeat for the YCalipers line. Y calipers measure perpendicularly to X calipers and allow a better 
calculation with an elliptical hole. 
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FIG: 28.3 Edit Y Caliper 

If any service has more than one X or more than one Y caliper then those readings will be averaged 
unless the NoCaliperAverage flag is set to Yes. 
Double click on the ‘VolumeTicks =’ Line. 
Select ‘YES’ if you want volume ticks displayed instead of a tabular output. 
Each small tick equals 10 cubic feet or 1 cubic meter.  Each large tick equals 10 small ticks. 
Select ‘NO’ if you want a tabular output for volume. 
You can get either ticks or tabular volume, not both. 

 
FIG: 28.4 Edit Volume Ticks 

From Acquisition ‘Edit Variables’ the ‘BOREID’ size and ‘CASEOD’ size must be entered correctly for 
a valid calculation of borehole volume. 
A total borehole volume curve ‘TBHV’ must be added to the Log format as follows: 

 
FIG: 28.5 Define Data Item 

An annular bore hole volume curve ‘ABHV’ needs to be added to the log format as follows:  

 
FIG: 28.6 Set Scales Data Item 
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29 CSS Radial Bond Services 
Computer Sonics produces two types of radial bond tool. One (the earlier model, though still 
produced) is known as the sequential tool. This tool has four modes of operation: 
3 ft.- 5 ft. mode for generating the conventional dual spaced CBL radial mode for generating the eight 
receiver radial bond log (RBL) 
calibration mode for generating the internal calibration signal open hole mode 
The tool is switched from mode to mode and to acquire data for a complete log two passes must be 
made over the log interval, one in CBL mode and one in RBL. 
The later tool model generates all the required signals simultaneously and is known as the 
multiplexed tool. 
Both tools transmit nuclear, collar, and temperature log data in a digital form interleaved with analog 
sonic data. The telemetry scheme employed is not the same for the two tools, however in both cases 
it is detected and decoded in the Warrior system by DSP software through selection of the 
appropriate script command. 
The sequential tool transmits acoustic signals on the wireline at their natural frequency 
(approximately 20 – 25 kHz). The multiplexed tool divides the downhole frequency by a factor of four 
before transmission to the surface, therefore the frequency of the tool signals on the line is 
approximately 6 kHz. Special provision must be made for this feature in the logging system in the 
form of a special filter / amplifier card that can be switched to accommodate conventional as well the 
CSS multiplexed tool. 
In both tools CSS has provided an internal calibration signal which can be used for a well site 
calibration which does not rely on finding (assuming) free pipe in the well. For both tools the 
philosophy is the same, namely the tool is calibrated in a known environment (zero signal and a 
calibration pipe) and the internal calibrate signal evaluated. The calibrations for all the receivers and 
the value of the internal calibration signal are recorded by tool serial number. This procedure is 
termed the shop or master calibration. At the well site the receiver zero signals and internal 
calibration signal are re-evaluated and corrections made to reproduce the readings obtained during 
the shop calibration. In this way any changes in signal amplitudes due to electronic drift, differences 
in wireline and other factors may be minimized. 
The 3 ft receiver signal curve is calibrated to industry standard values. The sector signals are 
normalized to a given log amplitude during the shop calibration for calibration pipe diameter. When 
logging casing of other diameters the sector amplitudes are adjusted to produce the same log 
deflection and cement map appearance. 
 

29.1 SDSTIP 
The gains and filters for the CSS tools should be setup as follows: 
From Acquisition Window Select ‘Edit/Device Configuration/SDSTIP’ 
For the CSSM 1 11/16” tool, with Short to medium lines the following values should be entered in the 
SDSTIP Panel. 
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FIG: 29.1SDS Tool Interface Panel Configurations 1 11/16 Short to Medium Lines 

The Gains set the maximum gain for the Panel Control Slider bars and should be set to give a usable 
range for the slider bars depending on line length and tool signal. 
The Sonic line is for the Sonic signal. 
The Sync line is for the Sync signal. 
The Aux line is for the Telemetry signal. 
The FC is the frequency of the signal being detected.  The Q is the sharpness of the filter, the higher 
the Q the sharper the cutoff frequency. Band Pass or High Pass is the type filter used. 
The FC for the Sonic Line should be set for the frequency of the sonic receiver crystals, with a Band 
Pass Filter. 
The FC for the Sync Line usually works best with a low Q and Low FC, with a High Pass Filter. 
The FC for the Aux Line has been tested for short to medium lines and medium to long lines, and 
should be entered as shown. 
For the CSSM 1 11/16” tool, with medium to long lines the following values should be entered in the 
SDSTIP Panel. 

 

FIG: 29.2 SDS Tool Interface Panel Configurations 1 11/16 Medium to Long Lines 

For the CSSM 3 1/8” tool, with short to medium lines the following values should be entered in the 
SDSTIP Panel. 
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FIG: 29.3 SDS Tool Interface Panel Configurations 3 1/8 Short to Medium Lines 

For the CSSM 3 1/8” tool, with medium to long lines the following values should be entered in the 
SDSTIP Panel. 

 
FIG: 29.4 SDS Tool Interface Panel Configurations 3 1/8 Medium to Long Lines 

These values are not set and stone and may have to be tweaked for individual situations. 

29.2 Acquisition 
After starting Acquisition, the first step when running a Bond Tool of any type on Warrior will be to set 
the proper casing size.. This will ensure that the gates will default to the correct saved settings. 
 
29.2.1 Edit 
Click on the Edit menu box of the Warrior Logging System menu box and scroll down to and select 
Variables. 
 
29.2.2 Variables 
Displays the Variable (parameter) editor window, enabling depth dependent parameters associated 
with the selected service to be zoned and values to be set. 
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FIG: 29.5 SDS Variables 

Check the proper Casing OD under CASEOD. If you are outputting a Bond Index curve, enter the 
Minimum and Maximum Amplitudes. Enter any other variables that may be required. Then push the 
Accept button. 
The Minimum and Maximum Amplitude values are used for calculating the Bond Index Curve. Of 

these values the MINAMPL will have the greatest impact upon the calculations. 
The proper values are listed in Appendix A. Also, the MINATTN value is typical 
for most standard casings. 

 
29.2.3 Edit Logging Services Details 
From the Warrior Logging System menu box, click on Services and select the proper service for the 
tool type. Tools have different telemetry schemes and the services must be set up to match the 
telemetry. 
 
29.2.4 Edit logging Tools details 
When the Service is selected the Edit Toolstring Window will come up automatically. Or, select Edit 
and Tool String, to display the following window: 

 
FIG: 29.6 Toolstring 
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From this window it is possible to change the tool being run, the order of the tools in the string, and 
add or delete centralizers, weight bars, knuckle joints or other tool string components. It is from the 
information set in this window that the calibrations, default offsets and filters settings for the log to be 
run are derived. 
 
29.2.5 Tool String 
Depth offsets that were derived from the Edit - Tool String step may be viewed by choosing Edit - 
Sensors, to display the following window: 

 
FIG: 29.7 Edit Sensors 

These offsets may be edited from this window, by double clicking on a sensor. The information in this 
window normally consists of the hardware source of the sensor (Device and Channel number), the 
depth offset of the sensor from tool zero reference, and the sampling rate. 
The information contained in Edit Sensors is defaulted to the current service and current tool string 
information. For example, sensor depth offsets are derived from the selected tool string and the 
information contained in the tools database. The default sample rates and device channel 
assignments are derived from the services file. The default device and channel settings, and the 
default sample rates are contained in the services.ini file. The default depth offsets are derived from 
tool information contained in the tools.ini file. 
Sensors can not be modified while in a record mode. 

It is important to know that no permanent changes are saved from this window. If 
you change anything in the Edit Tool String window and save them, any changes 
under Edit Sensors will be deleted when the service is closed. If you have to edit 
offsets in the Edit Sensor window the Tool.ini file should be modified. 

 
29.2.6 Power Up 
Power up the tool string. (Nominally 125V at the STIP) 
Adjusting the sync. Start by turning the Panel Control ‘Sync’ slider bar all the way down.  Monitor the 
Waveform Window and slowly raise the Slider Bar.  In the Waveform Window you will see the 0/s 
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changes to typically 3/s or 4/s on the 1 11/16” tool and 7/s or 8/s for the 3 1/8” tool.  At this point the 
waveforms are synced. The PMON Window is used to adjust the telemetry thresholds. (This window 
will be hidden behind the Waveform window, and must be brought to the front.) On the PMON 
Window the left arrow adjusts the positive threshold and the right arrow the negative threshold. 
Adjusting CSS Telemetry sync. While looking at the PMON window, adjust the positive (+) and 
negative (-) thresholds to about 50%.  Adjust the Panel Control ‘AUX’ Slider to adjust the height of 
the digital signal, until the pulses are just below saturation  

 
FIG: 29.8 Tel threshold 

The PMON discriminator values will be what is saved in the ‘Source/Save Setup’ 
for this service. Options - View Axis Scaling may be used to more accurately set 
these values. This window is digital. The screen will not update until waveform 
sync is established. Select Source/Save Setup to retain these values for your 

next log. 
 
29.2.7 Telemetry 
Verifying Telemetry Data: 
From Warrior Acquisition Window -Select Monitor/ Devices/ DSP: 

 
FIG: 29.9 Devices 

Values for CSSM 3 1/8” Radial Bond Tool 
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FIG: 29.10 Devices List 

The above values are very close to what the tool normally reads.  Monitor TEL5-CCL, TEL7-Cable 
head voltage and TEL8-Temperature for stable readings.  If necessary adjust the positive threshold 
in the PMON window up or down to stabilize the readings. 
 
29.2.8 Monitoring Outputs. 
From Warrior Acquisition Window select Monitor /Outputs. An Outputs window will appear that allows 
you to monitor signals such as CCL, GR, and other sensors.  
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FIG: 29.11 Outputs List 

Continue to Shop Calibration Section. 

29.3 Shop / Tank Calibration: 
Make up the tool with the centralizers and slide it into the tank. The tool should show signals on all of 
the signals in the Waveform Window. 
 Bring the Waveform Window to the front. The gates appear on the waveforms as a white line on the 
section of the waveform where they are set.  
The gates can be changed on this window by clicking on the waveform that needs to be adjusted 
(note the dark border around the selected waveform) and then using the buttons in the top right 
corner of the Waveform Window. To move the gate right or left on the x-axis use the buttons labeled 
<< to move it to the left or the button labeled >> to move the gate to the right. The width of the gate 
can be increased by selecting the < = > button and decreased by using the > - < button. 
Note: It is recommended that you keep all of your gate widths the same. Approximatly 30 micro-
seconds works well with most tool types. 
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Also, specific waveforms can be viewed by selecting Options – Enable, and selecting the waveforms 
that you want displayed. Reducing the number of waveforms gives you a screen that is easier to 
work with. Remember to click on the waveform before adjusting the gates. 
Before gating on the first arrival use the (‘BHC/CBL’ pot on the panel for CBL01-09 sytems) (Panel 
Control ‘Sonic’ Slider Bar on CBLDR systems) to increase/decrease the signal. Make sure that none 
of the signals are saturated. (If you are going to be running logs in casing that is smaller than your 
calibration tank, be aware that the signals will be larger in smaller casings and decrease your signal 
to accomodate this.) 
Note: The signal height on the screen is not valid if you are in threshold mode. 
After all of the gates are set select Source – Save As.  Give this setup a name, such as ‘CSSM 1 
11/16” Cal Tank Amplitudes.’  If there is a problem later the setting can be restored by selecting 
Source – Load and selcting that setup name. 
Note: The same can be done for settings on the PMON Window. 
 

AT THIS POINT YOU SHOULD HAVE YOUR GATE (WHITE LINE) ON ALL THE 
FIRST POSITVE ARRIVALS OF ALL THE SIGNALS BEING DISPLAYED. (The 
CAL pulse first arrival should be positive. If the first arrival is not positive, the 
polarity can be changed through Warrior/Utilities/Edit Logging Tool Details.) 

 
On the Waveform Window, select Source – Threshold Mode and use the UP/DOWN Arrows (Only on 
the 3 ft and 5 ft display). To move the red threshold line to a suitable position where the threshold 
cuts the first arrival. Make sure it is far enough to avoid baseline noise (This may be above or below 
the baseline).  Threshold Mode is only used to set the travel time thresholds.   
On the Waveform Window, select Source – Normal Mode. 
On the Acquisition Window select Action – Calibrate – Shop / Free Pipe Zero Cal. A window will 
appear to sample the base line noise. 

 
FIG: 29.12 Calibrate 
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FIG: 29.13 Zero Baseline Calibration 

FIG: 29.14 Signals 
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Make sure the gates for all signals are on the flat part of baseline before the first arrival.  These 
values will be updated when doing the well site air zero cal.   
Click on the <<sample button.  The Sample & Average Sensor(s) box will appear.  Click on the begin 
button.  When the sample is complete, monitor the values they should be very close to zero.  If they 
are click the Accept button.  If the values are not close to zero click the Reject button and correct the 
problem. 

 

 
FIG: 29.15 Sensors signals 
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FIG: 29.16 Sensors Value signals 

 
The SCBL Zero Baseline Calibration box will appear check that the values are all close to zero and 
click Accept. 

 
FIG: 29.17 Zero Base line 



502 Warrior Software Version 7.0 Standard Cased Hole 

On the Acquisition Window select Action – Calibrate – Shop/Free Pipe Reference. The SCBL E1 
Amplitude Calibration window will appear to sample the first arrival pipe amplitude.  The Free Pipe 
Millvolt of the casing you are sampling is in the cells at the top of the window. The Sector E1 
amplitude is normally set to 100 or made to match the 3ft E1 amplitude. 
Note: If the value is not there or not correct check to see if the Casing OD and Maximum Amplitude 
were input in the Variables Window.  

 
FIG: 29.18 Pipe signal Calibration 

 
FIG: 29.19 Amplitude Calibration  
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FIG: 29.20 Signals 

Make sure the gates for all signals are on the positive part of the first arrival.  Click on the <<sample 
button.  The Sample & Average Sensor(s) box will appear. 

 
FIG: 29.21 Sample Signals 



504 Warrior Software Version 7.0 Standard Cased Hole 

Select <<Sample. After the sampling has finished select Accept. The calibration gains and offsets for 
each waveform are displayed. The offsets on all waveforms should be near zero. The gains should 
range from 20 to150. Select OK. 

 
FIG: 29.22 Amplitude Calibration Results 

The SCBL E1 Amplitude Calibration window will appear with the raw voltage readings displayed.  
Select Accept. 

 
FIG: 29.23 E1 Amplitude Calibration 

Note: If you need to make more than one calibration for each tool you must enter a different Serial 
Number. 
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 Do not do a downhole cal with the same Serial Number because if you accept 
the cal and it is no good you will have over written the good shop cal, which can 
be utilized, if there is no Free Pipe found in the well. 

 
Note: To create In the Warrior Screen select Utilities – Edit Logging Tool details then click Edit Tool. 
A list will come up, select SCBL and enter the “alias” Serial Number which you will use to do other 
cals on the same tool without over writing the original. Then Click Create – Tool. Enter a new serial 
number. 
 

29.4 Wellsite Calibration Procedures: 
The GR can be calibrated like any other GR tool. Select Action – Calibrate – Gamma Ray. Follow the 
onscreen menu. 
 
29.4.1 SCBL Air Zero Cal. 
SCBL Air Zero Cal:  The following step is performed with the tool hanging in the air. On the 
Acquisition Window select Action/ Calibrate/SCBL Well Site Air Zero Cal.  The SCBL Air Zero Cal 
window will appear.   

 
FIG: 29.24 Air Zero calibration 

 
FIG: 29.25 Air Zero calibration 
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Ensure the gates are set in the proper position for the size pipe to be logged select <<Sample.  The 
Sample & Average Sensor(s) box will appear.  Select Begin. 

 
FIG: 29.26 Air Zero Values 

All the values should be close to zero, and are used to establish the offset to be applied to  
the primary gain and offset established in the Shop Calibration.  Select Accept. 
Select Accept in the SCBL Air Zero Cal Window. 

 
FIG: 29.27 Air Zero reading 

29.4.2 SCBL Wellsite Internal Ref Cal 
SCBL Wellsite Internal Ref Cal:  The following step should be performed down hole. The CAL pulse 
is recalibrated to compensate for line resistance and temperature.  The new values are used to 
normalize all waveform amplitude values back to the shop calibration.   



 

507 Warrior Software Version 7.0 Standard Cased Hole

On the Acquisition Window select Action/ Calibrate/ Well Site Internal Ref Cal.  The SCBL Internal 
Reference Cal window will appear  

 
FIG: 29.28 Wellsite Internal Calibration 

 
FIG: 29.29 Internal Reference Calibration 
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FIG: 29.29 Zero Reference 

 
FIG: 29.30 Gain and Offset 

Move the gate in the WVFCAL Signal window to the flat part of the baseline in front of the first 
positive arrival.  Select <<Sample on the Reading of Ref Baseline.  The Sample & Average Sensor(s) 
window will appear. 
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FIG: 29.31 Signal calibration reference 

 
FIG: 29.32 Calibration  value  

Select Begin the values should be very close to zero.  Select Accept. 
Move the gate in the WVFCAL Signal window to gate the first positive arrival.  Select <<Sample on 
the Reading of Ref Maximum.  The Sample & Average Sensor(s) window will appear. 

 
FIG: 29.33 Signal Reference Maximum value  
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FIG: 29.34 Reference Maximum value  

Select <<Begin on the Sample & Average Sensor(s).  Select Accept.  A gain and offset value will be 
shown in the SCBL Internal Reference Cal window. The gain should be very close to 1.0 and the 
offset value will be very close to 0. If they are not, redo your calibrations to ensure that the correct 
voltage is set for the WVFCAL and the gate was set in the proper position for each reading.  Select 
Accept in the SCBL internal Reference Cal window. 

 
FIG: 29.35 Reference Maximum value  

Go in the hole monitoring the various waveforms as shown below. Ensure that the gates are over the 
first positive signal and that the relative positions of the gates are correct. The gate for the 5ft 
receiver should be approximately 114 microseconds later in time than the 3ft. The various sector 
gates should be approximately 57 microseconds earlier in time than the 3ft (for a 2 foot sector 
spacing). 
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FIG: 29.36 Signals  

All waveforms may be shown by selecting Options - Enable from the waveform window. 
After the gates are adjusted, open the Monitor -Outputs Window and monitor the various outputs. 
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FIG: 29.36 Outputs 

The maximum of the 3ft and sector outputs should be approximately those shown in appendix I for a 
given size casing. The minimum values in bonded casing should also match the indicated values. 
Sector values will tend to be slightly above indicated values in bonded pipe.  
 
29.4.3 Setting Travel Time: 
While monitoring the 3ft Waveform, choose Source - Threshold Setup Mode. Using the right hand 
scroll bar to set the Threshold Setting. The Travel Time should read within 10 microseconds of the 
value listed in Appendix I. This threshold should be kept as close to the baseline as possible without 
the threshold picking up baseline noise and triggering early. 
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29.5 Running the Log:  
1 11/16” CSSM Radial Bond Tool 
CCL Calibrations –  Gain = 0.1       Offset = -12.8 
Temp Calibrations - Gain =1.8  Offset = 32 
3 1/8” CSSM Radial Bond Tool 
CCL Calibrations –  Gain = 0.0005  Offset = -3.7 
Temp Calibrations - Gain =0.02  Offset = 0 
An example Radial Bond presentation is shown below.  

 
FIG: 29.37 Log 

The additional Radial Bond presentation is shown below. This presentation shows the eight sector 
readings and the waveforms of each as a signature presentation. 
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FIG: 29.37 Log Additional Radial Bond Presentation with Cement Map 

 
FIG: 29.38 Presentation Options 
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The Presentation may be changed by clicking on Options in the Interactive Plot Window. This brings 
up the window shown below. Either browse to select the presentation required, or edit the 
presentation name to the desired presentation. 
Under Plot Job Editor, calling up Single Log pass will bring up a similar window. Editing the Format 
field will allow you to show the same pass, using different presentations. 
Note: This same window allows you to show the same pass with different logging scales. 
Note: Annotations must be made from the Interactive Replay Window for each presentation, as the 
annotations will not be transferred from one presentation to another. 

 
FIG: 29.38 Presentation Options Type 
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APPENDIX A 

PIPE  1 11/16” RCBS 3 1/8” RCBL 
 OD   WEIGHT  ID  RADIAL 3 FT 5 FT RADIAL 3 FT 5 FT 

2.875 6.500 2.441 128 204 318    
 7.900 2.323 126 202 316    
 8.700 2.259 125 201 315    
 9.500 2.195 123 199 313    
 10.700 2.091 121 197 311    
 11.000 2.065 121 197 311    

3.500 9.300 2.992 139 215 329    
 10.300 2.922 138 214 328    
 12.800 2.764 135 211 325    
 12.950 2.750 134 210 324    
 15.800 2.548 130 206 320    
 16.700 2.480 129 205 319    

4.000 11.850 3.476 149 225 339    
 14.000 3.340 146 222 336    

4.500 9.500 4.090 161 237 351 151 208 322 
 10.500 4.052 160 236 350 150 207 321 
 11.600 4.000 159 235 349 149 206 320 
 13.500 3.920 157 233 347 148 205 319 
 15.100 3.826 155 231 345 146 203 317 

5.000 11.500 4.560 170 246 360 160 217 331 
 13.000 4.494 169 245 359 159 216 330 
 15.000 4.408 167 243 357 157 214 328 
 18.000 4.276 164 240 354 155 212 326 
 20.300 4.184 162 238 352 153 210 324 
 23.200 4.044 160 236 350 150 207 321 
 24.200 4.000 159 235 349 149 206 320 

5.500 13.000 5.044 179 255 369 170 227 341 
 14.000 5.012 179 255 369 169 226 340 
 15.500 4.950 177 253 367 168 225 339 
 17.000 4.892 176 252 366 167 224 338 
 20.000 4.778 174 250 364 165 222 336 
 23.000 4.670 172 248 362 163 220 334 
 26.000 4.548 170 246 360 160 217 331 
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6.000 15.000 5.524 189 265 379 179 236 350 
 18.000 5.424 187 263 377 177 234 348 
 20.000 5.352 185 261 375 176 233 347 
 23.000 5.240 183 259 373 174 231 345 
 26.000 5.132 181 257 371 172 229 343 

6.625 17.000 6.135 201 277 391 191 248 362 
 20.000 6.047 199 275 389 190 247 361 
 24.000 5.921 197 273 387 187 244 358 
 28.000 5.791 194 270 384 185 242 356 
 32.000 5.675 192 268 382 182 239 353 

7.000 17.000 6.538 209 285 399 199 256 370 
 20.000 6.456 207 283 397 198 255 369 
 23.000 6.366 205 281 395 196 253 367 
 26.000 6.276 203 279 393 194 251 365 
 29.000 6.184 202 278 392 192 249 363 
 32.000 6.094 200 276 390 190 247 361 
 35.000 6.004 198 274 388 189 246 360 
 38.000 5.920 196 272 386 187 244 358 

7.625 20.000 7.125    211 268 382 
 24.000 7.025    209 266 380 
 26.400 6.969    208 265 379 
 29.700 6.875    206 263 377 
 33.700 6.765    204 261 375 
 39.000 6.625    201 258 372 
 45.300 6.435    197 254 368 

8.625 24.000 8.097    230 287 401 
 28.000 8.017    228 285 399 
 32.000 7.921    226 283 397 
 36.000 7.825    224 281 395 
 40.000 7.725    222 279 393 
 44.000 7.625    220 277 391 
 49.000 7.511    218 275 389 

9.625 29.300 9.063    249 306 420 
 32.300 9.001    247 304 418 
 36.000 8.921    246 303 417 
 40.000 8.835    244 301 415 
 43.500 8.755    243 300 414 
 47.000 8.681    241 298 412 
 53.500 8.535    238 295 409 
 58.400 8.435    236 293 407 
 61.100 8.375    235 292 406 
 71.800 8.125    230 287 401 
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APPENDIX B 

29.6 Map 
29.6.1 Introduction 
The heart of the Radial Bond Tool is the segmented crystal found below the transmitter. This crystal 
is cylindrical in shape. It is divided into 6 or 8 segments, each of which covers a section of the well 
bore.  

 
FIG: 29.39 Sector Map 

29.6.2 The Calibration Procedure 
When the Radial Bond Tool is calibrated, the sonde section is rigidly centralized in a 5-1/2” 
calibration chamber and the chamber is pressured up to 500 lbs of water pressure. The tool is 
powered up and the calibration signal is set to a reference voltage, using pots within the electronics 
section of the tool. Gates are then set over E1 of the 3ft, 5ft,  and each of the segmented crystals. 
Each of these signals is then set to 1 Volt, again using pots within the electronics section. 
Using the SCBL Shop/Free Pipe Calibration routine, the tool is then calibrated so that each of the 
signals reads 100 millivolts within the test chamber. Then, the test chamber is depressurized, and the 
tool is rotated 180 degrees. The test chamber is again pressurized and the calibrations are checked 
again to assure that the tool was properly centralized during the calibration procedure. 
NOTE: While it is true that the expected amplitude reading for the 3ft receiver in 5-1/2” casing is 72 
millivolts, that is the expected reading with pressurized water on the backside of the casing. The 
presence of air on the backside allows the test chamber to vibrate more freely than 5-1/2” casing. 
The expected readings of the 3ft in various sizes of pipe, are based upon a tool calibrated to 100 
millivolts in a 5-1/2” test chamber with air on the backside. 
 
29.6.3 The Radial Readings 

 
FIG: 29.40 Radial Readings 
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With the Shop Calibration recorded in the Tools.ini file, all that is left for the Engineer to do at the well 
site, is to perform the SCBL Wellsite Internal Reference Cal and the SCBL Air Zero Cal. These 
calibrations generate a secondary Gain and Offset that are applied to readings from the SCBL 
outputs before they are plotted and recorded. These secondary calibrations are identified by WS_ 
and are listed directly under the curve to which they are applied. 
When the SCBL Internal Reference Calibration is performed, the High and Lo Read of the AMPCAL 
from the Shop Calibration are used as the Hi and Lo Ref for the WS_CAL and the Calibration Signal 
is calibrated back to the readings taken during the Shop Calibration. The Gain derived from this 
calibration is then applied to ALL of the Bond curves. This calibration adjusts the Warrior Logging 
System for differences in line length and variations in CBL/BHC Signal gains. 
When the SCBL Air Zero Cal is performed, the gates of all the bond signals are set to their 
approximate values for the casing size anticipated by choosing the appropriate Setup (under Load 
Setup), while to tool is in air. This calibration generates the secondary calibration offset, which is 
applied to each of the Bond curves individually.  
When using Shop Calibrations for logging, both of these calibrations must be done before going in 
the hole. If, for some reason a Wellsite Calibration is performed, there is no need to perform these 
two additional calibrations. Wellsite calibrations are not recommended except under unusual 
situations. 
 
29.6.4 The Cement Map 
The Cement Map is a graphical representation of the response of the sector measurements. The 
shading of the cement map is purely representative of the recorded amplitude readings from the 
various sectors. Look back to the representation of the segmented crystal shown at the beginning of 
this bulletin, and visualize the sectors laid out horizontally. 

 
FIG: 29.41 Cement Map 

Each of the individual sectors is represented by a section of the cement map, as shown below. The 
shade applied to each section of the map is a function of the amplitude of that sector as recorded. 
The Warrior Logging System uses an algorithm to determine the shading associated with the 
amplitude recorded, based on several factors. These factors include: 
The number of grayscales and the density of the grayscales in the Cement Map, as applied in the 
screen and printer setup within the Warrior.ini file. 
The Filter level associated with each of the Sector Curves. 
The amplitude reading of adjacent sectors. 
The High Reference recorded in the Shop Calibration associated with each Sector Curve. 
The Black and White values set in the presentation file. 
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FIG: 29.42 Sectors 

The only factor under control of the engineer is the Black and White values within the presentation 
file. The purpose of the Cement Map is to graphically illustrate small channels that may pose a 
problem. With that end in mind, the following is the proscribed setup for the Cement Map. 
With the Black and White Levels set as above, the grays scales of the Cement Map will change as 
follows: 
1. Amplitudes less than 10mv     Black 
2. Amplitudes greater than 10.0mv and less than 26.7mv  Dark Gray 
3. Amplitudes greater than 26.7mv and less than 43.3mv  Medium Gray 
4. Amplitudes greater than 43.3mv and less than 60.0mv  Light Gray 
5. Amplitudes greater than 60.0mv     White 
If different gray scales are needed for a particular application, contact Technical Support. 
 
29.6.5 Logging Conditions 
The Cement Map is a visual representation of the cement conditions behind the pipe. The Sector 
Crystal is not free to rotate within the tool, and the cement and casing are not free to rotate. However, 
the tool itself is free to rotate with the well, and it is expected that it will. For this reason, apparent 
“channels” may rotate within the cement map while running repeats, and that the Cement Map may 
not repeat exactly. 
The Cement Map also becomes an important aid to quickly identify problems in tool setup or logging 
procedures. 
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30 Ultrawire Memlog Chart 
30.1 Updating Warrior V7.00 
Run the self extracting Warrior Updates executable. 
Add the following entry to Warrior.ini (found in the Warrior Config directory, or use the shortcut in 
Sondex Utilities). 
In the Device Alias section add UWD=UWMEMORY 
[Device Alias] 
UWD=UWMEMORY 
Next import the new UW memory tools using the Warrior tool editor (found in Utilities). 
In the Calibration select Restore and select MBH025.wcf, UMT003.wcf, MITUW.wcf, PRC034.wcf, 
PRC057.wcf in turn. This imports the Memory Battery Holder, Ultrawire memory tool, Ultrawire MIT 
and 2 new centralizers. 
Now add the new Ultrawire memory services. In the Service Editor (Utilities) import UMT 
Services.wsv which contains all 4 memory services. 

30.2 Update MCU driver 
Uninstall the current MCU device driver (using the Device Manager) and reinstall the latest MCU 
driver (SXMCULDR.SYS). The version required is V1,0,0,6 or greater. 

30.3  Update UMT firmware 
Open Ultrawire Memlog, select the Diagnostic menu and click on Upload new firmware. Select the 
latest firmware file (XXXX.bin) and as long as the UMT is connected to the MCU the new firmware is 
uploaded. 

30.4 Using Ultrawire Memlog 
Setting up the Service (tool string). 
All service information is set up in Warrior. In Warrior Acquisition select the required Memory Service 
(i.e. Ultrawire Memory MIT). Make up the tool string, and at this point it is possible to perform all the 
calibrations using an XTU. 
Next, if required set up the zoned variables in Warrior. 
Once the service information is complete then UW Memlog can be used. 
 

LEAVE WARRIOR RUNNING, DO NOT CLOSE UNTIL YOU HAVE FINISHED 
USING UW MEMLOG! 
 

Section

30 
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30.4.1 Open UW Memlog  
The first thing that must be done is to set up the DPT Settings. In the Edit menu select Edit DPT 
Settings, the options in this window must match those on the DTR or UW Memlog will not output the 
correct depth units! 
Create a new project (File menu, or toolbar), the user is then prompted to create the project files. 
Only do this if the service has been completely set up in Warrior. 
UW Memlog takes all the service information from Warrior (toolstring, telemetry information etc) and 
creates the Project.ini and the Service.ini in the project directory. It also copies any calibration files in 
Warrior to the Project directory. They are not used by UW Memlog, but are a useful archive. 
Next import the zoned variables from Warrior. In the UW Memlog File menu select Create Variables 
database. This takes the zoned variable information and places it in the Project directory (vars.db). 
 
30.4.2 Create the Profile 
The profile editor is slightly modified from the previous version of Memlog. Is it now possible to 
sample any tool, at any rate (within reason). For each profile line a tool can be sampled at a different 
rate. 
The first difference is that a start time for the profile line is NOT entered; this has been changed to 
the length of the profile in seconds. 
The second major change is the profile type. There are 4 options, LOG, OPEN, CLOSE and SLEEP. 
LOG is the default and will record all the tools at the selected sample rates. 
OPEN and CLOSE can only be used on tools with motorized arms. (i.e. MIT). It is recommended that 
each OPEN and CLOSE profile be 3 minutes in length to allow the tool to fully open and close. 
Note when an OPEN or CLOSE profile type is selected the tool to be opened\closed must also be 
selected in the rate window. The drop down list will now contain OPEN or CLOSE rather than sample 
rates. 
NOTE: Only one tool can be opened or closed in a single profile! 
NOTE: During an open or close no other tools can be sampled. 
I recommend that a LOG profile precedes each open or close profile type. 
The amount of memory being used can be seen at the bottom of the window. Make sure this does 
NOT exceed your memory limit. 
If an MIT is in the service there will be two memory usage values. Click on the Details… button and 
select the MIT compression rate to view the true memory used. 
Save the profile. 
 
30.4.3 Programming the tool 
Assemble the toolstring and attach to the MCU etc. 
If an MIT is in the toolstring, then before programming the tool, the COMPRESSION MODE must be 
set. 
Enter Command mode in UW Memlog (toolbar option), once the Command window is loaded, using 
Warrior select the MIT Tool Configuration window and select the Sample Options button. 
The following options should selected and sent to the MIT. 
Compression Mode = Absolute (12 bit), although this is a user choice. 
Sample Type= On Demand 
Sample Rate = 20 or 50 ms (again a user choice). 
Send the command to the MIT, if the command is sent successfully the Command window will 
increment the command and response counters. 
NOTE: If testing in the shop it might be worth changing the Memory size to 2MB prior to programming 
the tool (Edit menu). This will save time, but REMEMBER TO CORRECT IT BEFORE GOING ON A 
JOB. 
Program the tool using the toolbar option. 
Monitoring the tool, or run the job 
To monitor the tool select the Monitor toolbar option (Warrior MUST be open with the correct service). 
The Monitor window outputs the MCU voltage, but the tool readings are sent directly to Warrior and 
can be view in Warrior in the View Outputs window. 
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As UW Memlog is transmitting the data directly to Warrior, the calibrations can be preformed if 
required. Use the standard Warrior calibration routines. 
Remember if you perform a new calibration it is recommended that you recreate the UW Memlog 
project files. 
 
30.4.4 Download the tool 
Download the tool using the toolbar option. It is recommended that all the errors are viewed and the 
user look at the UWstats text file. It will report any errors on each of the UW addresses and is a 
useful diagnostic tool. 
 
30.4.5 Visual Merge the depth and tool data 
Note: I have not gone into the DTR download and setup as this is identical to the old Memlog. 
Visual Merge is also pretty much the same as the previous version, although UW Memlog only uses 
raw memory data, so the plotted data is all raw values. 
The depth and tool data should be tied-in as usual and all passes picked and saved to file. 
 
30.4.6 Output passes 
UW Memlog now only outputs directly to Warrior. Select the passes to output to Warrior, and select 
the options for time based outputs (i.e. fast or slow sampling). 
Output the passes, you are prompted for a Warrior database name. Make sure you do not attempt to 
over write a previously created database. You can append to an existing database but the pass 
names must be different. 
 
30.4.7 Recalculating the raw UW Memlog data and creating the curves 
UW Memlog outputs a raw data dump into the Warrior database. To extract the curves and apply the 
calibrations Warrior Recalculation must be used. 
Open Warrior Recalculation and select the database you have just output from UW Memlog. Enter a 
name for the recalculated pass and select OK. 
At this point, if an MIT or CAT is in the tool string the user is prompted to use either current or 
embedded calibration files. I recommend using the current files (taken from the Warrior database). 
Next it is possible to configure the tools, i.e. for the MIT the user can select whether to centralize or 
temperature-compensate the data. The zoned variables can also be altered at this point. 
Now select the maximum speed option and the calibrated curve data is plotted and is ready to use. 
It is possible to recalculate the raw data as often as necessary should any changes need to be made. 
 
30.4.8 Extras 
There is a Calibration Pass option in UW Memlog; this can be found on the tool bar. This looks like 
the Visual Merge window and you select a calibration pass in the same way you would pick a log 
pass. Once a calibration pass is selected it can be sent to Warrior using the option in the File menu. 
If calibration data has been recorded to memory this is the way to pass it to Warrior. 
When the data is being passed to Warrior a cursor scrolls across the screen to show which data is 
being sent. In the Warrior Output Monitors the user can view the data, and the calibrations can be 
performed in the standard way. 
Remember after performing calibrations it is recommended the service information in the UW 
Memlog project be updated. 
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31 Noise Log 
31.1 Services - Noise Survey 
The Noise service is available on systems equipped with 330 digitizers and Model 250 and 5000 
DSP boards. The signals from the noise tool are conditioned by filters and amplifiers in the tool 
interface panel and routed to the adc or dsp boards in the computer. The signal is sampled by 
digitizing for a user selectable time period e.g. 1 second. This sample is digitally filtered in the 
computer and divided into the conventional frequency components. The frequency spectrum and raw 
and filtered signals may be monitored on the computer screen. A number of samples may be 
averaged to produce a station reading for a given depth. The averaged frequency spectrum may be 
monitored on the computer screen. 
Start the service from Services in the normal manner and power the downhole tool. A raw data 
monitor window is presented which has four signal displays corresponding to the conventional four 
peak to peak voltage ranges. 
 
 

 
FIG: 31.1 Range Signal 

The usual range of options associated with waveform monitors is available for this display. During 
operation the system automatically selects the most appropriate range for data collection. 
The system also displays a window displaying the processed waveforms and frequency spectra. 
 

Section
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FIG: 31.2 Noise Logging Control 

The survey is also controlled from this window. 
 
 

31.2 To run the survey 
Click on the Start Sampling button and signals should appear in the various windows. To record a 
station click on the Record Station button. With the parameters shown the system will take ten one 
second samples, average the results and record them as a depth station in a survey table.  
To view the survey table click on the Survey Manager button. As each depth station is recorded the 
results are entered into the survey table as shown. 
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FIG: 31.3 Survey Manager 

After all stations have been recorded the survey may be output as log curves and/or tabular results. If 
there are stations which need to be excluded from the final results this may be achieved by selecting 
the particular station in the survey table (by clicking anywhere in its line) and then clicking the 
Disabled box as shown below. 
 
 

 
FIG: 31.4 Edit Survey Station 

Clicking on the Generate button and Depth Log displays the window shown below. 
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FIG: 31.5 Depth Log Format 

The cryptic Dataset entry simply indicates what the resulting merged and interpolated log will be 
called. If a logarithmic display of the data is required then the Logarithmic Interpolation box must be 
checked. In this case the log presentation used must specify a logarithmic grid and a logarithmic 
curve. 
Note that other curves e.g. CCL, may be easily merged with the noise curves using the Auto Merge 
feature. Clicking the Add button displays a list of the other curves present in the current database. At 
present it is not possible to merge curves from other databases by this method. Aliasing may be used 
to achieve this if required. 
 

 
FIG: 31.6 Select Data set Auto merge 

Double click on the curve(s) to be merged with the noise data. To generate the merged presentation 
click on the OK button and the merged log will be displayed on the screen. With long log intervals this 
may take several seconds.  
Note that a merged presentation may be generated at any time in order to monitor the progress of 
the survey, e.g. after each depth station if required. 
For final presentation a tabular output of the survey table may be added to log grid presentation when 
assembling the final plot using the Plot Job Editor. 
 
 


